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This guide describes the system requirements for Google Earth Enterprise Server and Google
Earth Enterprise Fusion Pro and provides the preparation steps and installation instructions for
those two products.

Google Earth Enterprise software is available electronically for download or on DVD (additional
order). The GEE Fusion Pro and Server software are packaged individually for distribution.

The Google Earth Enterprise Fusion Pro software package contains:

Google Earth Enterprise Fusion software
Google Earth Enterprise Fusion tutorial files
Google Earth Enterprise documentation
Example data files
Configuration files

The Google Earth Enterprise Server software package contains:

Google Earth Enterprise Server software
Google Earth Enterprise documentation
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4.4.1 Documentation Introduction

Google Earth Enterprise (GEE) 4.4.1 is a network-based, rich 3D and 2D mapping solution that
makes vast amounts of data easily accessible from a desktop application. With GEE, you can
create a central geographic information system (GIS) database that can be distributed
simultaneously to thousands of users.

Documentation

For offline use, documentation is available on the server where you installed GEE. You can find it
in the directory /opt/google/share/doc/manual/(by default).

The GEE documentation provided with your software includes:

Installation Guide - Guides you through preparation for and installation of GEE.

Administration Guide - Covers configuration of Fusion, GEE Server software, and the GEE
tutorial work space. Also includes a command reference and a list of common error messages
and their resolutions.

Fusion Tutorial - Guides you through the basic steps of creating and publishing a Fusion
database from raw source data, and provides a series of advanced lessons for specific data
preparation tasks.

Reference Guide - Provides comprehensive reference material about Fusion and how you can
use it to create graphically-rich GIS databases for distribution to your in-house users.

Portable Globe and Server - Describes the portable globe and server: installation of the server,
cutting globes, serving and broadcasting, and command line tools.

Search Framework Developer's Guide - Explains how to use the Search Framework Java API
to write a plug-in application for Google Earth or Google Maps to search a custom data source.
The plug-in creates requests and responses in the framework's Common Search Format, a
generic format that can be adapted to deal with data from any data store.

Release Notes - Describes the latest feature enhancements and improvements for GEE.

Google Earth User Guide - Describes how users can view published databases in Google
Earth Client (EC), as well as common functions in the Earth Client.

Earth Enterprise Client and Earth Plugin Release Notes - Describes updates and known
issues in EC and the Earth Plugin.

Googe Maps API

Google Maps API Developer's Guide and Reference - The Google Maps API lets you
embed Google Maps in your own web pages with JavaScript. The API provides a number of
utilities for manipulating maps and adding content to the map through a variety of services,
allowing you to create robust maps applications on your website.

Google Maps API extensions for GEE - A special extension class called GFusionMap is
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needed to view 2D Maps hosted from a GEE Server. Additional information about building 2D
Maps is available in the Google Earth Enterprise Reference Guide.

Google Earth API

Google Earth API Developer's Guide and Reference - The Google Earth API allows you to
embed three-dimensional maps into web pages.

Google Earth API extensions for Google Earth Enterprise - Additional information about
connecting the Google Earth API to a local GEE Server.

Google Earth Enterprise Technical Support - Technical Support is available to all current
GEE customers from a dedicated, web-based Support Portal. An account is required to access
the portal. Please complete this form if you do not have an account yet.

Legal Notices and License Agreements

Requesting technical support

Back to top
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Hardware

Minimum requirements are:

Minimum 2 dual-core Intel or AMD CPUs.
Minimum 4GB RAM; 8 GB RAM per core recommended.
The amount of storage space needed to build and host customized 3D and 2D globes will
depend on how much source data is imported, scaling from several gigabytes to many
terabytes. The main driver for disk space is the amount of imagery that is added to the
globe. A simple proof of concept server can be installed on less than 10GB of storage space.
The recommended minimum for a production globe is 500GB of space.

The installed software itself requires 3.0GB total (1.5GB each for Server and Fusion).

DVD drive.
A graphics card with at least 64MB video RAM (NVIDIA GeForce4 or higher preferred - for
Google Earth Enterprise Fusion GUI only). You can install this graphics card in a different
workstation that accesses Google Earth Enterprise Fusion.

Operating System

Google Earth Enterprise is supported on the 64-bit versions of the following operating systems:

Red Hat Enterprise Linux versions 5.6 to 6.2, including the most recent security patches
Ubuntu 10.04 LTS

Customers with previous patch releases of these operating systems are advised to update to the
latest patches. Google will continue to test the Google Earth Enterprise software with the latest
patch releases as those releases become available. Please contact the Google Enterprise Support
team for the most current Linux distribution supported with your version of Google Earth Enterprise.

Note on virtual machines: Google Earth Enterprise Fusion can be both CPU and I/O intensive;
therefore we recommend that it be installed only on real (non-virtual) machines for optimal, stable
performance. On the other hand, Google Earth Enterprise Server may be run on a virtualized
platform provided the guest OS is one of our supported 64-bit distributions and sufficient resources
are allocated to the VM.

Software
Oracle (Sun) Java Runtime Environment (JRE) or Java Development Kit (JDK), current
version 1.6.0.x
Python (the latest version available for your platform)
X11 libraries, including Mesa (for disconnected production servers only)

Network

You must fully configure the hostname, DNS, and IP address of each destination server prior to
installing Google Earth Enterprise, and you must not change these settings. The hostname must
be the full DNS name of your destination server; for example, myserver.mydomainname.com. Ensure
that the DNS entry for your server matches its hostname exactly.

You can verify the hostname of your workstation by entering hostname at a shell prompt, and you
can verify the network connection by using the ping command to reach other hosts in the same
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network.

When you publish a searchable database to a virtual server with a relative URL (such as
/default_ge or /default_map), Google Earth Enterprise Fusion requests the hostname from the
server to which you are publishing and then writes that hostname out to the search section of
DBRoot. When Google Earth EC or Google Maps configures its search tabs, it uses the hostname
specified in the search section of DBRoot and constructs all search requests using that hostname.
If Google Earth EC or Google Maps is unable to resolve the fully qualified hostname for the search
server, the search fails.

Therefore, if you plan to publish searchable databases, you must use one of the following
configurations for your servers:

Create a name-based virtual server. (See Configuring Virtual Servers in the Administration
Guide for details.)
If you have a small number of Google Earth EC and Google Maps users accessing your
searchable database, you can add an entry to each user’s hosts file to resolve the
URL/hostname you provide to the IP address of the actual server.
Ensure that the DNS entry for your server matches its hostname exactly.

Supported Configurations

Google Earth Enterprise products are tested and developed per the hardware and software
requirements listed above. The products are intended to be installed according to the processes
described in this documentation.

When installing Google Earth Enterprise in an unsupported environment, there are risks that the
products may not operate as intended. If Technical Support assistance is required, reasonable
effort will be extended to troubleshoot the issue. If an unsupported environmental factor is
determined to be the cause, you may be asked to install the products in a supported environment
for further testing.

Some factors that could affect your installation and deployment are:

Installations on unsupported operating systems.
Improperly configured DNS.
3rd party or non-default permissions or security measures (no root access, sudo blockers,
etc.).
Complex proxy configurations that prevent the network communications from operating as
intended.

We encourage you to contact Support or a Google Partner if you have further questions regarding
your operating environment.

Important System Security Information

Google strongly recommends users who wish to host 3D and 2D globes online with Google Earth
Enterprise should follow industry standard security practices and review for their systems and
networks before enabling access. Although Google takes every precaution to secure the
information, there is always the risk of unauthorized access outside of a closed or protected
network.

For more information on setting up authentication, please refer to the Administration Guide.

Configuration for searchable databases
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Before you install Google Earth Enterprise (GEE), you must configure your hardware, network, and
GEE users. You should also carefully decide in advance where you want to store your Fusion data
and where you want to publish your Fusion databases. During installation, you'll be prompted for this
information. The following sections provide information about GEE requirements, considerations, and
best practices. Be sure to complete all of the tasks described in these sections before installing
GEE.

See the GEE License Agreement and your Ordering Document for information about the maximum
number of physical CPU cores allowed per machine. If you want to exceed the maximum, you'll need
to buy more Fusion or core licenses.

Configuring Your Host Volumes

The best practices for naming your host volumes are:

Network naming convention. You should use a network naming convention for any new
volume that hosts Fusion or source data, whether it is initially part of a network or not,
because you will almost certainly migrate to a network-based configuration eventually. Fusion
requires both a network path and local name to resolve the locations of source files and
related Fusion data, so changing the host volume name or path invalidates Fusion data. On a
single workstation setup, the local and network paths are identical, but on a network-based
configuration they are not.
/gevol. You should use /gevol as your volume naming convention because it's unlikely to
conflict with standard Linux volume definitions. Linux systems frequently use either /vol(*) or
/data(*) as the local volume definition on a new system, so using this convention for Fusion
can cause name conflicts if you later switch from a single workstation to a network-based
configuration. For example, if you initially define /vol1/assets as the network location for a
Fusion asset root, and you later add another workstation that has a local volume called /vol1,
that workstation cannot reference /vol1/assets through the network because of the name
conflict with its local volume definition. (See “Planning the Location of Your Asset Root” for
more information about the asset root.) You can avoid this conflict by using any unique
naming convention for all volumes on your network (such as /vol1... /voln), but /gevol is a
good choice because it's descriptive.

Configuring Multiple Storage Devices

GEE Server and the Fusion asset root, source volumes, and publish root require large amounts of
disk storage space. Fusion requires about three times as much storage space as GEE Server. The
storage space can be either in the form of internal disks, directly attached storage devices, network-
attached storage (NAS) devices, or storage area network (SAN) devices. Typically, these devices
are configured into redundant arrays of independent disks (RAIDs) and presented to the operating
system as volumes. Volumes can range in size, from several hundred gigabytes to tens of terabytes.

The difference between configuring a workstation with one, two, or three volumes is how you defne
the mount point for the source and asset volumes.

When configuring a Linux workstation, it is best practice to use the following mount point naming
conventions:

Single volume
Mount the single drive to slash (/). All data (/gevol/assets, /gevol/src, and
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/gevol/published_dbs) resides on that drive with the local path defined using the /gevol
naming convention.

Two volumes - a small system volume and a larger data volume
Mount the small system drive to slash (/). Mount the larger data drive to /gevol/. Source and
asset data volumes can then be defined as /gevol/assets and /gevol/src.

Three volumes - a small system volume and two larger data volumes
Mount the small system drive to slash (/). Mount the first large data drive to /gevol/assets.
Mount the second large data drive to /gevol/src.

More than three volumes
There are several strategies for storing very large data sets. Fusion can read from and write to
multiple volumes. If your requirements exceed the capacity of three volumes, consult your
GEE sales engineer to determine the best way to configure your storage needs,

It is also important to keep internal and external storage devices separated so that if your internal
server goes down, it does not affect your ability to serve published data to external clients. Likewise,
if your external server goes down, you can replace it and publish from the internal storage device.
Perhaps more importantly, keeping your internal and external storage devices separate reduces the
possibility of performance problems that could occur if you are building a large data set or if a client
requests a time-consuming search.

Planning the Location of Your Asset Root

During Fusion installation, you must specify a location for your asset root. The asset root is the
main location where all of the assets (resources, map layers, projects, and databases) are stored
that are created with Fusion. (Refer to the Reference Guide for more information about the asset
root.)

The asset root must be located on a single volume. It cannot be split across multiple volumes.
Therefore, it is important to think ahead and allocate as much storage space as possible for the
asset root.

Unless you have an established partitioning scheme for all of your storage devices, you should
accept the default partitioning scheme presented to you while installing Linux. That scheme gives
you a reasonable amount of space in /opt for GEE and other system software, a small amount of
space for /home, and the remaining space on your storage device for the asset root.

You should also accept the default volume designation for your asset root during installation
(/gevol/assets), unless that name conflicts with your established naming conventions.

Note: It is a good idea to dedicate a network-attached storage device (NAS) for your asset root.

Planning the Location of Your Publish Root

During GEE Server installation, you must specify a volume for the publish root. The publish root is
the directory in which all of your published databases are stored.

If you specify a different volume than the asset root:

Whenever you publish a database, Fusion registers the database on the specified volume and then
copies all of the database files to the designated volume.

For example, if you specify /gevol/assets for your asset root and /data1/published_dbs for your
publish root: whenever you publish a database, Fusion copies all of the database files from
/gevol/assets to /data1/published_dbs (unless you allow symbolic links during installation).
Copying takes more time as well as extra disk space.

If you specify the same volume as the asset root:

Whenever you publish a database, Fusion registers the database on the specified volume and sets



symbolic links to the database files.

For example, if you specify /gevol/assets for your asset root and /gevol/published_dbs for your
publish root: whenever you publish a database, Fusion registers the database on gevol and sets
hard links to the database files. No copying is necessary.

 

Setting Up GEE Users

The GEE installer automatically configures certain system users to perform background tasks at the
system level. If you accept the default user names and allow the installer to create those users on
your local workstation, you are implementing local authentication only. Local authentication is
designed for standalone workstations only.

If you are using GEE over a network with at least two workstations, storage devices, or servers, the
best practice is to use a centralized network authentication system such as LDAP, NIS, or one of the
many commercially available systems available.

If you use a centralized network authentication system, you must add the following users to your
authentication system’s user list:

gefusionuser
geapacheuser
getomcatuser
gepguser

The primary group for all of these users is gegroup.

The installer prompts you to assign a user ID (UID) for each of these users. You can accept the
installer-assigned UID or specify a unique UID for each user. If you are using a standalone
workstation, you can simply accept the installer-assigned UIDs. However, if you are in a multi-user
environment in which multiple workstations share a common asset root on a NAS/SAN, these users
must have the same UID on all devices, so you must assign them explicitly in both your
network authentication system and in GEE.

To determine the UIDs to assign, examine the UIDs that are already used on each device on which
you plan to install GEE software, and determine four UIDs that are available on all devices. Then,
when the installer prompts you for the UIDs, assign the same UIDs for these users in GEE as on all
network devices.

Note: You must assign these users on the NAS as well as the workstations and servers.

Be sure to configure each GEE workstation, storage device, and GEE Server to use your network
authentication system. For more information, see your network authentication system documentation.
For more configuration options, see Configuring Publishing Authentication in the Administration
Guide.

You can use customized user names, user IDs, and group names. During installation, you are asked
if you want to change the default user and group names. If you choose yes, you are prompted to
provide a user and group name of your choice.

Deciding Which Products To Install

You do not need to install all products on all devices. Follow the guidelines below.

Development machine:

Install both Fusion and GEE Server on the server machine that you want to use to import your
source GIS data and create flyable 3D and 2D databases. A system in this configuration is
typically called the "development machine" since its primary task is to build flyable databases

Customizing GEE User Names



and only a small number of users will view the flyable data for quality assurance testing.
Install the Fusion tutorial files on the "development machine" for users who are new to Fusion
or to this version of Fusion. You can also use the Fusion tutorial files to test publishing.
(See Configuring Tutorial Work Space in the Administration Guide for additional important
information about configuring the tutorial work space for users.)

Production machine:

Install only the GEE Server on the server machine that hosts flyable 3D and 2D databases. All
authorized end-users will connect to this system -- typically referred to as the "production
machine" -- to view the flyable databases. This machine must be accessible through the
network from the development machine in order to publish databases.
Users who will not have direct network access to their production machines, or users who plan
to update remote systems with external hard drives, must also install the "Disconnected
Publishing Add-on" for additional tools.  

The following diagram shows a sample system configuration.

In this example, there are two server-class machines assigned to data building and data hosting
tasks, plus one workstation for data management. A GIS specialist uses the workstation to remotely
log in to the development machine with Fusion installed to import source GIS data and output a
flyable globe to publish for end users. GEE Server software is also installed on the development
machine so the GIS specialist may perform quality assurance tests on the data before publishing to
the production machine. Only the GEE Server is installed on the production machine, which
authorized end-users in the network may access with Google Earth Enterprise Client (Earth EC) for
3D databases, or a compatible web browser for 2D databases.  

Back to top
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Overview

This section provides information about installing Google Earth Enterprise Fusion, Google Earth
Enterprise Server, the Google Earth Enterprise Fusion tutorial files, and the additional files and
features provided in the software package.

Both a graphical user interface (GUI) and a command-line installer are available for Google Earth
Enterprise Server and Fusion. A silent installation option is also available if you want to install on
multiple machines without user interaction. Use the command-line installer if you are installing on a
server without an X11 server.

The GUI installers are recommended for most Google Earth Enterprise Fusion and Server
installations. During installation, you are prompted and guided through the process automatically.

Before you Begin

The Google Earth Enterprise software is available in two formats: as a download from Google.com
servers, or on physical media in the form of DVDs. The instructions below are the same for both
formats, once the following setup has been completed:

Unpack the archived installer(s) to a temporary directory:

Insert the distribution DVD, and mount the DVD drive.

Installing Google Earth Enterprise Fusion
1. Open a terminal window on your Linux workstation.
2. Log in as root.
3. Stop the Google Earth Enterprise Fusion system manager and Google Earth Enterprise

Server, if you have a previous version installed and they are running:

Note: If you try to run the Google Earth Enterprise installer using a secure shell (ssh -XY
user@machine), you might get the following error:

If you do, set the following variable to point to the X11 authorization file:

tar -zxvf GEEFusion40.tar.gz -C /target/directory
tar -zxvf GEEServer40.tar.gz -C /target/directory

/etc/init.d/gefusion stop
/etc/init.d/geserver stop

X11 connection rejected because of wrong authentication.
X connection to localhost:10.0 broken (explicit kill or server shutdown)
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4. Navigate to your DVD directory, or the directory to which you extracted the Google Earth
Enterprise files, and run the Google Earth Fusion installer:

If your DVD automounted without exec privileges, you might need to run sh
./InstallGEFusionGUI.sh instead.

The installer starts and the following window appears:

5. Click Next to continue. You can click Cancel to exit the installation process or Previous to
return to the previous screen at any time. The License Agreement appears:

6. Accept the License Agreement and click Next. The Choose Products screen appears:

export XAUTHORITY=~/.Xauthority

cd /media/cdrom
./InstallGEFusionGUI.sh



7. Choose the installlation type or click Next to accept the default (Typical). If the installer
determines it needs to upgrade any product you are installing, it prompts you to confirm the
upgrade.

Typical installation includes Google Earth Enterprise Fusion and the Tutorial.
Minimal installation includes only Google Earth Enterprise Fusion.
Custom installation allows you to customize the components you install.

8. The installer displays the default location for the backup files: /var/opt/google/fusion-
backups/...
Click Next to continue.

9. You are prompted to create the user and group for Google Earth Enterprise Fusion. Click
Next to accept the default, or enter your customized names. The Pre-Installation Summary
appears:

10. Click Install to continue. The installer prompts you to designate your asset root and source
volumes. A source volume is a directory that contains your source data files.



11. Click Next to accept the default (/gevol/assets and /gevol/src), or enter the paths you
want to set for your asset root and source volume. (See Before you Install for more
information.)

12. Click Done.
13. Log out of the system, and log back in (not as root).
14. From the command line, launch Google Earth Enterprise Fusion:

Installing Google Earth Enterprise Server
1. Open a terminal window on your Linux workstation.
2. Log in as root.
3. Stop the Google Earth Enterprise Fusion system manager and Google Earth Enterprise

Server, if you have a previous version installed and they are running:

4. Navigate to your DVD directory, or the directory to which you extracted the Google Earth
Enterprise files, and run the Google Earth Server installer:

If your DVD automounted without exec privileges, you might need to run sh
./InstallGEServerGUI.sh instead.

The installation script starts running and the following window appears:

fusion

/etc/init.d/gefusion stop
/etc/init.d/geserver stop

./InstallGEServerGUI.sh



5. Click Next to continue. You can click Cancel to exit the installation process or Previous to
return to the previous screen at any time. The License Agreement appears:

6. Accept the License Agreement and click Next. The Choose products screens appears:



7. Choose the installlation type click Next to accept the default (Typical). If the installer
determines it needs to upgrade any product you are installing, it prompts you to confirm the
upgrade.

Typical installation includes Google Earth Enterprise Server and Google Earth Enterprise
Places Database.
Minimal installation includes only Google Earth Enterprise Server.
Custom installation allows you to customize the components you install.

8. The installer displays the default location for the backup files: /var/opt/google/fusion-
backups/...
Click Next to continue. The User and Group Names screen appears:

9. If you want to customize user or group names or IDs, select Customize. Otherwise, select
Default and click Next. The Publish Root Location screen appears:



10. The installer prompts you to designate your publish root. (See Before you Install for more
information.)

The Pre-Installation summary appears.

11. Click Install. When the installer is finished, you can choose to start the Google Earth Server
services.

12. Click Done to complete the installation.

Back to top
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Overview

You can install GEE Server and Fusion with either the command line installer or the graphical user
interface (GUI) installer. If you are installing on a server without X11, use the command-line
installer. During installation, you are prompted for replies and guided through the process
automatically.

If you want to install on multiple machines without user interaction, you can use the silent installer.

Before you Begin

Google Earth Enterprise is available in two formats: as a download from Google.com servers, or
on physical media in the form of DVDs. The instructions below are the same for both formats after
the following setup has been completed:

Unpack the archived installer(s) to a temporary directory:

Insert the distribution DVD, and mount the DVD drive.

Installing Fusion
1. Open a terminal window on your Linux workstation.
2. Log in as root.
3. Stop the Fusion system manager and GEE Server, if you have a previous version installed

and they are running:

4. Navigate to your DVD directory, or the directory to which you extracted the GEE files, and
run the Google Earth Fusion installer:

If your DVD automounted without exec privileges, you might need to run sh
./InstallGEFusion.sh instead.

The installation script starts running.

5. Press Enter to continue. You can type Quit to exit the installation process or Back to return
to the previous screen at any time.

tar -zxvf GEEFusion40.tar.gz -C /target/directory
tar -zxvf GEEServer40.tar.gz -C /target/directory

/etc/init.d/gefusion stop
/etc/init.d/geserver stop

./InstallGEFusion.sh
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6. Press Enter to scroll through the Google License Agreement. Press Y to accept the terms.
7. Enter the applicable number for Typical, Minimal, or Custom installation or press Enter to

accept the default (Typical). If the installer determines it needs to upgrade any product you
are installing, it prompts you to confirm the upgrade.

Typical installation includes Fusion and the Tutorial.
Minimal installation includes only Fusion.
Custom installation allows you to customize the components you install.

8. The installer displays the default location for the backup files: /var/opt/google/install-
backups/...
Press Enter to continue.

9. The installer prompts you to create the user and group for Fusion. Press Enter to accept the
default, or enter your customized names.

10. The Pre-Installation Summary appears. Press Enter to continue.
11. The installer prompts you to designate your asset root. (See Before you Install for more

information.) Press Enter to accept the default (/gevol/assets), or enter the path you want
to set for your asset root.

12. The installer prompts you to designate a source volume. A source volume is a directory that
contains your source data files (or subdirectories of your source data files). You can add
more source volumes later. (See also Configuring Your Data Locations and Configuring the
Tutorial Asset Root and Source Volume in the Administration Guide.) 

Press Enter to accept the default (/gevol/src), or enter the path you want to set for your
source volume. If the source volume does not exist, the installer asks if it should create it.

13. You can choose to start the Fusion Services. To start the services at a later time:

14. Press Enter to exit.
15. Log out of the system, and log back in (not as root).
16. Launch Fusion:

Installing GEE Server
1. Open a terminal window on your Linux workstation.
2. Log in as root.
3. Stop the Fusion system manager and GEE Server, if you have a previous version installed

and they are running:

4. Navigate to your DVD directory, or the directory to which you extracted the GEE files, and
run the Google Earth Server installer:

If your DVD automounted without exec privileges, enter sh ./InstallGEServer.sh instead.

The installation script starts running.

5. Press Enter to continue. You can type Quit to exit the installation process or Back to return
to the previous screen at any time.

6. Press Enter to scroll through the Google License Agreement. Type Y to accept the terms.
7. Enter the applicable number for Typical, Minimal, or Custom installation, or press Enter to

accept the default (Typical). If the installer determines it needs to upgrade any product you
are installing, it prompts you to confirm the upgrade.

Typical installation includes Fusion and the Tutorial.
Minimal installation includes only Fusion.

/etc/init.d/gefusion start

fusion

/etc/init.d/gefusion stop
/etc/init.d/geserver stop

./InstallGEServer.sh



Custom installation allows you to customize the components you install.
8. The installer prompts you to create the user and group for GEE Server. Press Enter to

accept the default or enter your customized names.
9. The installer prompts you to designate your publish root. Press Enter to accept the default

(/gevol/published_dbs/), or enter the path you want to set for your publish root.
10. The Pre-Installation Summary appears. Press Enter to continue.
11. You can choose to start the GEE Server services. To start them later, from the command

line:

Using the Silent Installer

You can use the silent installater to install Fusion and GEE Server while unattended. This allows
for automatic updates of the software as needed.

1. Log in as root.
2. Navigate to your DVD directory, or the directory to which you extracted the GEE files, and

run the Google Earth Fusion installer:

3. Locate the installer.properties file in the directory containing the installer files (for
example, GEEFusion-4.4.1/installer).

4. Move the installer.properties file to another location.
5. Run the Google Earth Server installer:

6. A new installer.properties file is created in the same location.
7. Run the Google Earth Fusion silent installer:

8. Run the Google Earth Server silent installer:

You can customize the following properties for the silent installation. Set value to 0 for the
default, or 1 to customize the value:

/etc/init.d/gefusion start
/etc/init.d/geserver start

./InstallGEFusion.sh

./InstallGEServer.sh

./InstallGEFusion.sh installer.properties

./InstallGEServer.sh installer.properties

#1.Creating gefusionuser user (0 for default, 1 for customizing users and 
group)

#--------------------------
GEFUSION_SERVER_CUSTOMIZE=0

#2.Set the Asset Root Location
#---------------------------
ASSET_ROOT=/gevol/asset

#3.Set the Source Volume Location
#------------------------------
SOURCE_VOLUME=/gevol/src

#4.Previous installation found 
#----------------------------
PROMPT_USER_CHOSEN_OPTION=0

#5.Google Earth Fusion is running 
#-------------------------------
PROMPT_USER_CHOSEN_OPTION=0

#6.Creating gefusionuser user(0 for default, 1 for #customizing users)
#--------------------------
GEFUSION_SERVER_CUSTOMIZE=1

#7.Get User Name for gefusionuser
#-------------
GEFUSION_USER_NAME=gefusionuser1
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Verifying That the System Manager Is Running

Because a properly running system manager is critical to using Google Earth Enterprise Fusion, as
well as for converting your source data to Google Earth Enterprise Fusion assets, verify that the
system manager is running after the initial installation of Google Earth Enterprise Fusion and
whenever you encounter problems building assets.

To verify that the system manager is running, enter the following command at a shell prompt:

A list of running processes appears. Two processes appear on the list:

gesystemmanager

This process is necessary to configure or build resources, projects, and databases with
Google Earth Enterprise Fusion. If this process appears on the list, Google Earth Enterprise
Fusion is running properly.

If you do not see this process on the list, follow the troubleshooting suggestions in the
Troubleshooting section to correct it.

geresourceprovider

This process manages the workstation resources on the behalf of the system manager. It
also monitors free disk space on the volumes for any connected workstations.

If you see a connection refused message, see the Troubleshooting section.

Troubleshooting a Failed System Manager

If the Google Earth Enterprise Fusion system manager fails to run, you can try stopping and
restarting the it, which resolves most minor problems.

1. Log in as root.
2. Stop the system manager:

3. Start the system manager:

If you are still having problems starting the system manager after stopping and restarting the
system manager, you can view the log file for the system manager to see what errors have been
reported. The log file is located in:

Any errors are listed after the Started notice, which appears in the log for each time you started
the system manager.

Note: If you see a Connection Refused message when running the getop command, but do not
see any error messages in the log file, ensure that the log directory is writable by Google Earth

getop

/etc/init.d/gefusion stop

/etc/init.d/gefusion start

/var/opt/google/log/gesystemmanager.log

Installation Guide

Verifying and Troubleshooting an Installation

Restarting the system manager



Enterprise Fusion users.

Likewise, if Google Earth Enterprise Server fails to run, you can try stopping and restarting it,
which resolves most problems.

1. Log in as root.
2. Stop and restart the server.

/etc/init.d/geserver restart

Restarting the server

Back to top
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This section provides instructions for uninstalling all or some of the software provided in the
Google Earth Enterprise 4.4 software package. For this procedure, you use the same installer you
used to install the software.

Note: As with installation, you can use either the command-line uninstaller or the graphical user
interface (GUI) uninstaller to remove the Google Earth Enterprise Fusion and Server products.

To uninstall all or part of the Google Earth Enterprise software:

1. Open a terminal window on your Linux workstation.
2. Log in as root.
3. Stop the Google Earth Enterprise Fusion system manager and Google Earth Enterprise

Server, if you have a previous version installed and they are running:

4. Navigate to the /opt/install/GoogleEarthFusion_Uninstaller or
/opt/install/GoogleEarthServer_Uninstaller/ directory.

To uninstall using the Fusion DVD, insert the DVD and mount the drive. The uninstallers
listed below are available at the top level of the DVD media.

5. To uninstall Fusion Pro:

6. To uninstall Server:

The uninstall script starts. Follow the on-screen instructions to remove the Google Earth
Enterprise Fusion or Server products.

/etc/init.d/gefusion stop
/etc/init.d/geserver stop

./Uninstall_Google_Earth_Enterprise_Fusion_GUI.sh // GUI uninstaller

./Uninstall_Google_Earth_Enterprise_Fusion.sh // Command line uninstaller

./Uninstall_Google_Earth_Enterprise_Server_GUI.sh // GUI uninstaller

./Uninstall_Google_Earth_Enterprise_Server.sh // Command line uninstaller

Installation Guide

Uninstalling the Google Earth Enterprise Software
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Overview

Before you use many of the Google Earth Enterprise Server configuration tools, you must stop the
Google Earth Enterprise Server and then start it after you change the configuration. To stop/start
the Google Earth Enterprise Server, enter:

In general, no additional configuration is required after you install the Google Earth Enterprise
Server. However, there are a number of ways in which you can customize your Google Earth
Enterprise Server configuration, if desired. This chapter provides information about those
configuration options. (See the Command Reference chapter for a complete list of commands
available to system administrators.)

The geserveradmin command handles many of the Google Earth Enterprise Server configuration
changes you might want to make. All of the options and uses for geserveradmin are described in
the geserveradmin section of the Command Reference doc.

Verifying That Google Earth Enterprise Server Is Running

Because Google Earth Enterprise Server is critical to many operations you perform with Google
Earth Enterprise Fusion, verify that it is running.

1. Open a web browser (either on the machine where the server is installed or any other
computer that has network access to that machine).

2. Enter the URL for the server host (such as http://www.example.com).

If Google Earth Enterprise Server is running, the browser displays the Google logo.

If Google Earth Enterprise Server is not running, the browser displays an error message
informing you that the page cannot be found. On the command line, enter:

If you again reach an error page, make sure that you have network access to the machine
on which the server is installed and that the DNS entry for that machine is up-to-date.

Configuring Virtual Servers

/etc/init.d/geserver [stop | start | restart]

/etc/init.d/geserver start

Administration Guide

Configuring Google Earth Enterprise Server



Before publishing to virtual servers other than the default virtual servers, please familiarize yourself
with the Apache Virtual Host documentation (http://httpd.apache.org/docs/2.2/vhosts/).

Caution: Publishing to virtual servers other than the default server is supported only in version
4.2 or later of Google Earth EC. If you are using version 4.0 or earlier, only databases that you
publish to the default server can be accessed by Google Earth EC.

To define a virtual server, use the geserveradmin command (see geserveradmin for more details):

Where:

name is the name of the virtual server
type is either ge (for 3D streaming) or map (for maps)
url is the location of the virtual server. This will usually look like /somename_ge; refer to
geserveradmin in the Command Reference chapter for more information on the required
format.

After defining a virtual server, create a configuration file that specifies required information for that
particular virtual server. To do so:

1. Log in to the server you want to configure.
2. Change to the directory where the sample configuration files are stored:

3. Copy a sample configuration file to /opt/google/gehttpd/conf.d/virtual_servers and
rename it. For example:

When choosing a configuration file to copy, use a file that:

contains _ge_ if you are creating a Google Earth Enterprise Fusion virtual server.
contains _map_ if you are creating a Google Maps virtual server.
starts with location_based if you are creating a location-based virtual server.
starts with name_based if you are creating a name/domain-based virtual server.
starts with port_based if you are creating a port-based virtual server.

You must maintain the .location or .vhost extension on the file name.

4. Edit the new file with the text editor of your choice, making the following changes:

In a location-based configuration file:

a. Change <LOCATION> to the vsurl value specified in the geserveradmin command you
used to register the virtual server.

Note: For a Google Maps virtual server, you must make this change in five places.

b. Change <VS_NAME> to the addvs name specified in the geserveradmin command you
used to register the virtual server.

In a name-based configuration file:

a. Change <HOST.DOMAIN> to the desired server name.
b. Change <VS_NAME> to the addvs name specified in the geserveradmin command you

used to register the virtual server.

In a port-based configuration file:

a. Change <IP_ADDRESS> to the IP address of the host.

geserveradmin --addvs name --vstype type --vsurl url

cd /opt/google/gehttpd/conf.d/examples

cp /opt/google/share/gehttpd/examples/port_based_ge_vs_example.vhost
  /opt/google/gehttpd/conf.d/virtual_servers/private_ge.vhost

Defining the virtual server

Creating the configuration file

http://httpd.apache.org/docs/2.2/vhosts/


b. Change <PORT> to the number of the port you want to use.
c. Change <VS_NAME> to the addvs name specified in the geserveradmin command you

used to register the virtual server.

Note: You can optionally create combinations of name-based or port-based and location-
based virtual servers. If you do, you must create an Apache configuration file with the
.vhost extension that references multiple virtual servers. Make sure you create the
corresponding virtual servers using the geserveradmin --addvs command. (See
geserveradmin for more information.)

5. Save the file.

Next, you must configure a server association for the new virtual server.

Configuring Server Associations

The Google Earth Enterprise Server consists of a stream server and a search server. You can
publish a Google Earth Enterprise Fusion database to stream and search virtual servers running
on your local workstation or on a remote server. Associated stream and search virtual servers can
be located on different physical servers or on the same server.

The Server Associations Manager allows you to specify server associations in preparation for
publishing your databases. You can specify any number of additional server associations in the
Server Associations Manager. Then you can select the desired server association in the Publish
Database dialog. (Refer to Publishing a Database in the Google Earth Enterprise Fusion
Reference Guide for more information.)

Caution: If you're working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, when one user closes the manager, that user’s changes overwrite all previous data for
that manager. So if you are working in a multi-user environment, be sure to coordinate with the
other users to be sure that only one user has this manager open at a time.

1. Select Tools > Server Associations Manager.

The Server Associations Manager window appears with two default server associations
listed--one for publishing to Google Earth and the other for publishing to Google Maps. The
default server associations assume that you have Google Earth Enterprise Server installed
on the same workstation as Google Earth Enterprise Fusion.

2. To add a server association, click the page icon . The Edit Server Association dialog
appears.

To specify server associations:



3. Enter a unique name for the server association in the Nickname field. (When you're ready
to publish a database, the nickname appears on the list of server associations to which you
can publish.)

4. For Type, select GE for Google Earth databases or MAP for Google Maps databases.
5. Enter the URL for the Stream Server (and a port number, if other than 80; for example,

http://www.example.com:9090).
6. Click Query to populate the Virtual Server drop-down list with all of the virtual servers

available at that URL (and port, if specified).
7. Repeat for the Search Server.
8. Click OK. The new server association appears on the list in the Server Associations

Manager.

Repeat the steps above for each server association you want to add. The server
associations appear on this list in the order in which you added them. They also appear on
the Server Associations drop-down list in the Publish Database dialog in the same order.
The first server association listed here is the default in the Publish Database dialog.

If you want to reorder the server associations on the list (particularly if you publish to a
certain server most of the time and want it to be the default in the Publish Database dialog),
select the server association that you want to move, and click the up or down arrows to
change that server association's position in the list.

9. When you have finished adding and sorting server associations, click OK. The server
associations are ready for you to select when you publish a database. (Refer to Publishing
a Database in the Google Earth Enterprise Fusion Reference Guide for more information.)

Configuring Secure Servers

You can configure your Google Earth Enterprise Server to use HTTPS connections by editing the
virtual server’s configuration file. Each time you restart Google Earth Enterprise Server, publish a
database ,or start Apache, Apache reads this file.

1. Enable the main Apache server to run HTTPS by activating the SSL engine. (If you need
assistance with this step, read the Apache HTTP server documentation at
http://httpd.apache.org/docs/2.2/.)

To configure a secure server:

http://httpd.apache.org/docs/2.2/


2. In a text editor, open the configuration file (gehttpd.conf) for the virtual server you want to
make secure.

The configuration file is stored in /opt/google/gehttpd/conf.d/virtual servers. (See
Configuring Virtual Servers for details.) The contents of the configuration file look like:

3. Add the two bold lines below to the LocationMatch directive exactly as they appear here:

4. Save and close the configuration file.
5. Restart the Apache service.

This procedure gets you to a point where you have “bare bones” security on your server. It
requires that users use the HTTPS protocol instead of HTTP when they specify a location.
However, if you want to add more security, you can do so by following the instructions provided in
the Apache 2.2 documentation at http://httpd.apache.org.

Configuring the Publish Root

When you install the Google Earth Enterprise Server, you specify a location for your publish root,
the directory in which all of your published databases are stored.

1. At the command line prompt, log in as root.
2. Stop the Google Earth Enterprise Server:

3. Specify the location of the new publish root:

When prompted, enter the path where you want to create the publish root. For example, if
you have designated a separate volume for publishing called /gepub, enter
/gepub/published_dbs.

4. When you see the success message, start your Google Earth Enterprise Server:

5. Log out as root.

When you create a new publish root, it is automatically selected. The next time you publish a
database, Google Earth Enterprise Fusion stores it in the selected publish root.

If you have multiple publish roots, you can go back and forth among them, using different publish
roots for different purposes.

Note: If you have multiple publish roots, be sure to select the corresponding asset root for the
intended publish root before you publish. Otherwise, it could end up with an incompletely
published database. (See geselectpublishroot in the Command Reference chapter for more
information.)

1. At the command line prompt, log in as root.
2. Stop the Google Earth Enterprise Server:

<LocationMatch "/private_ge/*">
        Include conf.d/virtual_servers/runtime/private_ge_runtime
</LocationMatch>

<LocationMatch "/private_ge/*">
        Include conf.d/virtual_servers/runtime/private_ge_runtime
        SSLRequireSSL
        SSLVerifyClient none
</LocationMatch>

/etc/init.d/geserver stop

geconfigurepublishroot

/etc/init.d/geserver start

To add a publish root:

To select a different publish root:

http://httpd.apache.org/


3. Select the desired publish root:

where path is the full path to the publish root, such as /gepub/published_dbs.

4. When you see the success message, start your Google Earth Enterprise Server:

5. Log out as root.

Configuring Authentication

Authentication is the process of verifying the identity of a user, a system, or a process. Controlled
access refers to any content or process that requires authentication. The following sections
describe how to configure:

Publishing authentication - To restrict the users allowed to publish databases
Client authentication - To restrict the users allowed to view published databases

By default, Google Earth Enterprise Server does not require authentication for publishing.
However, you can configure your server to control access for publishing using standard Apache
authentication methods. This section is primarily for system administrators who are unfamiliar with
configuring Apache authentication.

First, decide which authentication method you want to use.

HTTP Digest authentication (enable the mod_auth_digest Apache module)
HTTP Basic authentication (enable the mod_auth_basic Apache module)

Both methods are essentially the same, except that mod_auth_digest encrypts the users’
password, and mod_auth_basic does not. However, mod_auth_digest is not supported by all
browsers. See http://httpd.apache.org/docs/2.2/mod/mod_auth_digest.html and
http://httpd.apache.org/docs/2.2/mod/mod_auth_basic.html for complete details on these two
authentication methods.

Google strongly encourages you to use HTTP Digest authentication (mod_auth_digest) instead of
HTTP Basic authentication. The following procedure describes configuring publishing authentication
using HTTP Digest.

1. Create a password file by entering on the command line:

The first part is the path to the Apache utility you use to create the password file, htdigest.
The -c option indicates that you are creating a new file. The path_to_pwd_file is the location
where you want to store the password file and the name of that file; it can be any name and
location you choose. Publisher is the realm, and you must enter it exactly as it appears
above. The user_name is the first user name you want to add to the password file.

When you press Enter, the utility prompts you to enter a password for the specified user.

2. Enter the password, and retype it when prompted.

The htdigest utility creates the password file, which contains only that one user name, the
realm, and the encrypted password. For example, if you view the contents of the password
file, it might look like this:

/etc/init.d/geserver stop

geselectpublishroot path

/etc/init.d/geserver start

/opt/google/gehttpd/bin/htdigest -c path_to_pwd_file Publisher user_name

jsmith:Publisher:f9d3c803aeb515f35568b37ec2d65399

Configuring Publishing Authentication

To configure publishing authentication on your server:

http://httpd.apache.org/docs/2.2/mod/mod_auth_digest.html
http://httpd.apache.org/docs/2.2/mod/mod_auth_basic.html


3. Add each user name and password to the same password file by entering:

Use the same path_to_pwd_file as you used for the first user. Do not include the -c option,
since you are not creating a new file this time.

4. When you finish adding users to the password file, copy the publisher_digest_auth.conf file
from /opt/google/gehttpd/conf.d/examples to /opt/google/gehttpd/conf.d.

5. Open the copy (/opt/google/gehttpd/conf.d/publisher_digest_auth.conf) in an editor
and:

Uncomment the <Location> directive(s) for stream publisher and/or search publisher by
removing the # at the beginning of each line. (If you want to configure authentication for
one type of server only, uncomment only its directive. If you want to configure both the
search server and the stream server, uncomment both directives.)
Change <<PATH_TO_USER_FILE>> to the password file path (the value of path_to_pwd_file
in step 1).

6. Save and close the publisher_digest_auth.conf file.
7. Restart the server by entering:

When a server is configured for publishing authentication, Google Earth Enterprise Fusion users
who try to publish to that server must enter their user name and password. Refer to Publishing a
Database in the Google Earth Enterprise Fusion Reference Guide for more information.

Configuring client authentication is very similar to configuring publishing authentication, except that
client authentication is specific to each virtual server, whereas publishing authentication is not.

1. Create a password file by entering on the command line:

The first part is the path to the Apache utility you use to create the password file, htdigest.
The -c option indicates that you are creating a new file. The path_to_pwd_file is the location
where you want to store the password file and the name of that file; it can be any name and
location you choose. Client is the realm. You can use any realm you want; however, you
must use the same realm in step 4. The user_name is the first user name you want to add to
the password file.

Note: Set the umask to 0022 before using htdigest to create the htdigest_password_file
or change permissions to rw-r--r-- (644) after the htdigest_password_file is created.
Check the permissions for the htdigest_password_file and if the permissions are set to
rw-r-----, change the group ownership to gegroup.

2. Press Enter. The utility prompts you to enter a password for the specified user. Enter the
password, and retype it when prompted.

The htdigest utility creates the password file, which contains only that one user name, the
realm, and the encrypted password. For example, if you view the contents of the password
file, it might look like this:

3. Add each user name and password to the same password file by entering:

Use the same path_to_pwd_file as you used for the first user. Do not include the -c option,
since you are not creating a new file this time.

/opt/google/gehttpd/bin/htdigest path_to_pwd_file Publisher user_name

/etc/init.d/geserver restart

/opt/google/gehttpd/bin/htdigest -c path_to_pwd_file Client user_name

jsmith:Client:f9d3c803aeb515f35568b37ec2d65399

/opt/google/gehttpd/bin/htdigest path_to_pwd_file Client user_name

Configuring Client Authentication

To configure client authentication for a virtual server:



4. When you finish adding users to the password file, open the
/opt/google/gehttpd/conf.d/virtual_servers/config_file file (where config_file is the
configuration file for the virtual server you want to protect) in an editor, and add the following
lines at the beginning of the <Location> directive:

Where Client is the exact name of the realm and path_to_pwd_file is the same path you
used in the htdigest command in step 1.

If this is a _ge_ virtual server, add:

If this is a _map_ virtual server, add:

For more information about AuthDigestEnableQueryStringHack, refer to the Apache
documentation at http://httpd.apache.org/docs/2.2/mod/mod_auth_digest.html#msie.

The final <Location> directive looks like:

5. Save and close the virtual server configuration file.
6. Restart the server by entering:

 

If you use LDAP for user authentication on your network, you can configure LDAP authentication
for publishing with Google Earth Enterprise Fusion. Since Basic authentication is used for
password challenge, Google suggests that you publish through an SSH tunnel. (See Configuring
Secure Remote Publishing (Using an SSH Tunnel) for more information about configuring an SSH
tunnel.)

1. Copy the publisher_ldap_auth.conf file from /opt/google/gehttpd/conf.d/examples to
/opt/google/gehttpd/conf.d.

2. Open /opt/google/gehttpd/conf.d/publisher_ldap_auth.conf in an editor.
3. Uncomment the following lines to enable LDAP authentication on the stream server:

4. Change <<LDAP_SERVER_URL_and_LDAP_SEARCH_PARAMETERS>> to the actual path to your LDAP
server and any parameters you want to set, for example:

AuthType Digest
AuthName "Client"
AuthDigestProvider file
AuthUserFile path_to_pwd_file
Require valid-user

BrowserMatch "GoogleEarth" AuthDigestEnableQueryStringHack=On

BrowserMatch "MSIE" AuthDigestEnableQueryStringHack=On

<LocationMatch /default_ge/*>
        AuthType Digest
        AuthName "Client"
        AuthDigestProvider file
        AuthUserFile path_to_pwd_file
        Require valid-user
        Include conf.d/virtual_servers/runtime/default_ge_runtime
        BrowserMatch "GoogleEarth" AuthDigestEnableQueryStringHack=On
</LocationMatch>

/etc/init.d/geserver restart

<Location /StreamPublisher/>
        AuthType Basic
        AuthName "Publisher"
        AuthBasicProvider ldap
        AuthzLDAPAuthoritative off
        AuthLDAPURL "<<LDAP_SERVER_URL_and_LDAP_SEARCH_PARAMETERS>>"
        Require valid-user
</Location>

ldap://ent-test-ldap.mycompany.com/dc=mycompany,dc=com?uid?sub?(objectClass=*)

Configuring LDAP Authentication For Publishing

To securely configure LDAP authentication for publishing:

http://httpd.apache.org/docs/2.2/mod/mod_auth_digest.html#msie


5. Uncomment the following lines to enable LDAP authentication on the search server:

6. Change <<LDAP_SERVER_URL_and_LDAP_SEARCH_PARAMETERS>> to the actual path to your LDAP
server and any parameters you want to set.

7. Save the file.

If you use LDAP for user authentication on your network, you can configure LDAP authentication
for any virtual servers you configure. As with LDAP authentication for publishing, since the
AuthDigestProvider directive does not support LDAP and AuthBasicProvider does not encrypt
passwords, please contact Google technical support for help configuring secure LDAP
authentication for virtual servers.

If you publish a database that you want to keep private and allow access only to certain users,
configuring client authentication provides that security with regard to the stream server. However, if
you host a searchable private database on the same server with a publicly accessible database,
users who are able to log in to the public database can, theoretically, search the private database
on that server. Such a user would need to be very knowledgeable about Google Earth Enterprise
Fusion and would need to know the exact URL of the private database, so the likelihood of this
breach is small; however, it is possible.

Therefore, to ensure that a database is completely secure (that is, no unauthorized users can view
or search the data), you must publish that database on a separate search server host that requires
authentication and allows access to only approved users.

Note: If you are short of server space, you can publish the private database to a shared stream
server (that is, a mix of databases that do and do not require authentication) and just publish
the private database to a search server on a separate (authentication only) host.

Configuring Secure Remote Publishing (Using an SSH Tunnel)

When Google Earth Enterprise Fusion publishes a database, it does not encrypt the data. If you
want to encrypt the data during the publishing process to a remote server (or even on separate
remote stream and search servers), you can use an SSH tunnel.

1. Open an SSH tunnel by entering on the command line:

For example:

Note: You can use any port that is available, but Google recommends a high number.

2. Follow the instructions in Configuring Server Associations to configure a server association
using the local port number you designated in the ssh command, for example:

<Location /SearchPublisher/>
        AuthType Basic
        AuthName "Publisher"
        AuthBasicProvider ldap
        AuthzLDAPAuthoritative off
        AuthLDAPURL "<<LDAP_SERVER_URL_and_LDAP_SEARCH_PARAMETERS>>"
        Require valid-user
</Location>

ssh -L port_num:host_name:80 host_name

ssh -L 8010:remoteServer:80 remoteServer

Configuring LDAP Authentication For Virtual Servers

Securing Your Search Server

To publish securely to a remote server:



Note: If the remote server requires authentication, it prompts you to log in when you click
Query.

3. Publish the database to the server association you just created, for example:

4. Close the SSH tunnel by entering Ctrl-D or exit in the terminal window.

The next time you want to publish securely to that same remote server, you can skip step 2.

1. In one terminal window, open an SSH tunnel to the stream server by entering on the
command line:

For example:

Note: You can use any port that is available, but Google recommends a high number.

2. In a different terminal window, open an SSH tunnel to the search server by entering the
same command with a different port number, for example:

3. Follow the instructions in Configuring Server Associations to configure a server association:
Use the local port number you designated for the stream server in the Stream Server’s
URL field.
Use the local port number you designated for the search server in the Search Server’s
URL field.

4. Publish the database to the server association you just created.
5. Close both SSH tunnels by entering Ctrl-D or exit in the terminal windows.

The next time you want to publish securely to that same remote server association, you can skip
step 3.

Disconnected Publishing

ssh -L port_num:host_name:80 host_name

ssh -L 8010:remoteServer:80 remoteServer

ssh -L 8020:remoteServer:80 remoteServer

To publish securely to separate remote search and stream servers:



If you want to publish databases on a server that does not have a network connection to your
Google Earth Enterprise Fusion workstations, you can configure a server with the disconnected
server add-on.

New in Google Earth Enterprise 4.0 is the ability to combine disconnected publishing and
connected publishing together. Prior to 4.0, only one type was supported for a database. With this
change, for example, a large database can be copied to portable media and loaded onto the
server using disconnected publish, saving the time and bandwidth required to send terabytes of
data over the network. Later, deltas for the same databases can be sent over the wire.

Note: Disconnected production servers require X11 libraries, including Mesa. Google Earth
Enterprise Server does not require an X server to be running or installed, however. Only the
libraries are required.

To create the disconnected database, use gedisconnectedsend from the command line. In the
example below, the --report_size_only flag is turned on; the size of the database should be
compared to the free space on your removeable media.

Use --havepath or --havepathfile to create a delta database.

When publishing from machine_one to machine_two, for example:

On machine_two:

On machine_one:

Connect the portable media to the Server host and mount the drive. Then:

1. Add the database manifest to the Server:

2. Push the files to the Server:

3. Publish the database on the Server:

gedisconnectedsend --report_size_only --sendpath \
/gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/gedb

rm -rf /portable_media/new_dir
mkdir -p /portable_media/new_dir

gedisconnectedsend --output /portable_media/new_dir \
--sendpath /gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/gedb

geserveradmin --fusion_host machine_one --listdbs > /portable_media/dblist

gedisconnectedsend --output /portable_media/new_dir \
--havepathfile /portable_media/dblist \
--sendpath /gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/gedb

geserveradmin -stream_server_url http://your_stream_server \
--search_server_url http://your_search_server \
--adddb \
/portable_media/new_dir/gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/g
edb

geserveradmin --stream_server_url http://your_stream_server \
--search_server_url http://your_search_server \
--pushdb \
/portable_media/new_dir/gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/g
edb

geserveradmin --stream_server_url http://your_stream_server \
--search_server_url http://your_search_server \
--publishdb \

Prepare a disconnected database

Publish on the remote Server host

Making delta disconnected databases



4. Verify the database manifests:

5. Verify the integrity of files in the published database:

Note: The paths in the examples above were split onto two lines for documentation. They
should be entered on one line when completing your commands.

The steps to delete DBs at end of life, for disconnected servers, is same as what was described in
over the wire publishing section.

/portable_media/new_dir/gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/g
edb

geserveradmin --stream_server_url http://your_stream_server \
--search_server_url http://your_search_server \
--listdbs
 
geserveradmin --stream_server_url http://your_stream_server \
--search_server_url http://your_search_server \
--dbdetails \
/portable_media/new_dir/gevol/assets/Databases/igain.kdatabase/gedb.kda/ver001/g
edb

ssh your_server /opt/google/bin/geindexcheck --database \
/gevol/published_dbs/stream_space/your_server/gevol/assets/
  Databases/igain.kdatabase/gedb.kda/ver001/gedb

ssh your_server /opt/google/bin/geindexcheck --mode all --database \
/gevol/published_dbs/stream_space/your_server/gevol/assets/
  Databases/igain.kdatabase/gedb.kda/ver001/gedb

Back to top
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This document discusses the Google Earth Enterprise Fusion software application and how you
can use it to create graphically rich geographic information system (GIS) databases for distribution
to your in-house end users. With Google Earth Enterprise Fusion, you can integrate your own
geospatial data, publish it to the Google Earth Enterprise Server, and view it using Google Earth
Enterprise Client (EC).

Audience

This guide is intended for individuals who want to prepare source data for publishing and publish it
to a Google Earth Enterprise Server. If you are new to Google Earth Enterprise Fusion, the best
way to learn about it is to read through Chapters 1 and 2 of this guide and then complete the
lessons in the "Basic Tasks" section of the Google Earth Enterprise Fusion Tutorial. Then you can
use this guide as a reference and continue with the lessons in the "Advanced Tasks" section of
the Google Earth Enterprise Fusion Tutorial, as you need to learn them.

In This Guide

This guide includes the following chapters and appendices:

Introduction provides essential information that you should know before you begin working with
data in Google Earth Enterprise Fusion, including:

An overview of the Google Earth Enterprise solution
An introduction to Google Earth Enterprise Fusion
The structure of Google Earth Enterprise Fusion data
Best practices when preparing data using Google Earth Enterprise Fusion

Fundamentals explains how to launch Google Earth Enterprise Fusion and general information
about the Google Earth Enterprise Fusion graphical user interface (GUI), including global features
that are available throughout the GUI.

Setting Up Your Workspace offers complete information about how to set up certain options in
advance, so you can select them from lists as you prepare your data for publication.

Defining Resources provides everything you need to know about how to import your source data
into Google Earth Enterprise Fusion.

Defining Projects provides everything you need to know about defining Google Earth projects.

Defining and Publishing Databases provides everything you need to know about defining and
publishing Google Earth databases.

Building Assets explains how to build every type of asset in Google Earth Enterprise Fusion,
including resources, projects, and databases.

Preparing Data for Google Maps provides everything you need to know about preparing data for
Google Maps, including defining map layers, projects, and databases.

Command Line Reference explains all of the shell commands you can enter on the command line
for Google Earth Enterprise Fusion.

Creating Your Own Source Data, Icons, and Masks provides helpful information about creating and
importing your own data, icons, and masks.

Reference Guide

About This Guide

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/errors.html


HTML Tags Allowed provides a list of HTML mark-up tags allowed in labels, descriptions, layer
names, and so on.

Sample Plug-ins describes the sample plug-ins provided with the Google Earth Enterprise system.

Common Error Messages provides a list of possible error messages that you might encounter while
using Google Earth Enterprise Fusion, the meaning of each message, and suggestions for how to
resolve the error.

Glossary provides definitions of terms used in this document and in Google Earth Enterprise.

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/errors.html
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In order to accommodate users who are working through the tutorial at the same time other users
(or even those same users) are working on production data, Google recommends that you
configure a tutorial work space on each workstation where you install the tutorial data. That way,
you can keep the tutorial source volume and asset root separate from your production source
volume(s) and asset root.

In addition, for any user who plans to work through the tutorial lessons on search tabs and search
layers, you must register the search plug-in.

This chapter describes how to configure the tutorial work space and register the search plug-in. It
also provides instructions for users who need to switch back and forth between the tutorial asset
root and the production asset root, and instructions for cleaning up the tutorial files when they are
no longer needed.

Configuring the Tutorial Asset Root and Source Volume

When you install Google Earth Enterprise, you configure a source volume and asset root for your
production data. If you accepted the default values, they are /gevol/src and /gevol/assets,
respectively.

The installation script installs the tutorial files in /opt/google/share/tutorials/fusion, so you
must add that path as the source volume for the tutorial. In addition, Google recommends that you
add a tutorial asset root for users to store the data they create with Google Earth Enterprise
Fusion while working through the tutorial.

The following procedure describes how to configure an asset root and the tutorial source volume
for each tutorial user. You must configure them for each user on each workstation where you
install the Google Earth Enterprise Fusion tutorial files.

1. On the command line, log in as root.
2. Stop the system manager by entering:

3. Enter:

where username is the name of the user.

The username does not have to be the user’s official account name. It can be anything that
distinguishes that user from other users on that particular workstation, such as edaniels or
just Emily.

Note: Google recommends that you place the tutorial asset root on the same partition as
the publish root, so the publisher uses hard links instead of making copies of the tutorial
databases. (See Planning the Location of Your Publish Root for more information.)

If you place the tutorial asset root on the root partition, ensure that there is enough disk
space for the data created by each user working through the tutorial. If a user completes
all lessons in the tutorial, allow 1.5 GB of disk space.

The tool asks if you want to create a new source volume.

4. Enter Y, and press Enter.

/etc/init.d/gefusion stop

geconfigureassetroot --new --assetroot /username/assets

Administration Guide

Configuring the Tutorial Work Space

To configure a tutorial asset root and source volume:



You are prompted to enter a directory for the source volume.

5. Enter /opt/google/share/tutorials/fusion, and press Enter.

The tool asks if you want to add more volumes.

6. If you want to create tutorial work spaces for more users, enter Y, press Enter, and repeat
steps 3 through 5. If not, skip this step. Otherwise, enter N, and press Enter.

The tool displays the message “Configured /username/assets” and returns you to the
command line prompt.

7. Log out as root.
8. Start the system manager by entering:

Note: The new source volume and asset root are automatically selected for you. You do
not have to run the geselectassetroot command. (See the next section, Selecting the
Tutorial Asset Root, for more information about selecting different asset roots.)

Selecting the Tutorial Asset Root

There are two occasions when users must select a different asset root:

When multiple users share a single workstation, each user must select his or her own tutorial
asset root.
When a user switches from the tutorial data to real production data, he or she must select
the appropriate asset root.

This section explains how to select a different asset root.

Caution: Note that even though your source volumes and asset roots are separate for each
user or for the tutorial and production data, there is only one publish root on each virtual server
for Earth databases and one for Map databases.

When two users are sharing a single workstation, they are both publishing to the same publish
root. When one user publishes a database on that workstation, it overwrites any database that
might have been published previously by another user on that same workstation. Likewise, if a
user is switching back and forth between tutorial and production data on the same workstation, it is
possible to overwrite a production database with a tutorial database and vice versa. Of course, the
user can simply republish the desired database to make it available to Google Earth EC again.

1. On the command line, log in as root.
2. Stop the system manager by entering:

3. Enter:

where username is the name you used in step 3 of Configuring the Tutorial Asset Root and
Source Volume.

4. Log out as root.
5. Start the system manager by entering:

Registering the Search Plug-In

When you install the Google Earth Enterprise software, it installs a sample plug-in (called

/etc/init.d/gefusion start

/etc/init.d/gefusion stop

geselectassetroot --assetroot /username/assets

/etc/init.d/gefusion start

To select the tutorial asset root:



ExamplePlugin) in /opt/google/share/searchexample. Users are instructed to reference that plug-
in in the Defining Search Tabs lesson in the tutorial.

You must register the plug-in before users can reference it. (See Search Plug-in in the Command
Reference chapter for more information about the search plug-in commands for the
geserveradmin tool.)

To register the sample plug-in for tutorial users, on the command line, enter:

This command registers the plug-in and makes it available for users to reference on search tabs.

Cleaning Up the Tutorial Work Space

When a user completes the tutorial or no longer needs the tutorial data, you can clean up that
tutorial work space, if desired, by removing the tutorial source files, asset root, and published
databases. This section describes the best way to perform that clean-up.

Note: Google recommends that you keep the tutorial files intact, since they use very little space
and can come in handy for users to practice, even after they have quite a bit of experience with
Google Earth Enterprise Fusion.

1. At the command line prompt, log in as root.
2. Stop the system manager by entering:

3. Select the production asset root by entering:

Substitute the appropriate asset root path, if necessary.

4. Stop the Google Earth Enterprise Server:

Note: If you are upgrading from version 2.4 to 3.x for the first time, the command to stop
the server is /etc/init.d/khhttpd stop.

5. Insert the distribution DVD, and mount the DVD drive.
6. Run the installer from any directory.

Command-line installer:

GUI installer:

Substitute the designation for your DVD drive for cdrom, if necessary.

The installation script starts running, and the first prompt asks what product(s) you want to
install.

7. Enter 3 for the Google Earth Enterprise Fusion Tutorial.

The X next to Google Earth Enterprise Fusion Tutorial disappears. Removing the X causes
the installation script to remove the tutorial files.

8. Enter F to finish selecting products.

geserveradmin --addplugin ExamplePlugin --jar_path \
  /opt/google/search/plugins/ExamplePlugin.jar \
  --class com.google.earth.search.plugin.ExamplePlugin

/etc/init.d/gefusion stop

geselectassetroot --assetroot /gevol/assets

/etc/init.d/geserver stop

/media/cdrom/InstallGEFusion.sh

/media/cdrom/InstallGEFusionGUI.sh

To remove the tutorial source files, asset root, and databases:



9. Follow the rest of the prompts.

The installer removes the tutorial files but does not change any of your other installed
products. When it completes the installation, it returns you to the prompt.

10. Delete the user’s tutorial asset root by entering:

where username is the name of the user you specified when you configured the tutorial work
space.

Caution: Make sure you are removing the tutorial asset root, not the production root. If
you delete the production root, there is no way to recover it (other than from back-ups, if
available).

11. Start the Google Earth Enterprise Fusion system manager and Google Earth Enterprise
Server:

The order in which you start them does not matter.

12. List the databases on the current server by entering:

The tool displays a list of all databases ever published (except any deleted databases) on the
server. If the server type is omitted, the server type defaults to stream.

13. Select the database you want to remove by entering:

where db_name is the name of the database you want to delete.

Note: If you want to delete a currently published database, you can either publish a
different database to the same virtual server or disable the virtual server on which it is
published. Then you can delete the database.

This tool does not delete the actual files. It is similar to putting files in the trash on a
Windows or Macintosh desktop.

14. Permanently delete the selected databases by entering:

rm -Rf /username/assets

/etc/init.d/gefusion start
/etc/init.d/geserver start

geserveradmin --listdbs

geserveradmin --deletedb db_name...

geserveradmin --garbagecollect

Back to top
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Before You Begin

Before you use many of the Fusion configuration tools, you must stop the system manager and then start it after you
change the configuration. To stop/start the system manager, enter:

Configuring Your Data Locations

The Google Earth Enterprise installation script prompts you to enter information about your system and then properly
configures your primary asset root and source volume. After you install Fusion, use the geconfigureassetroot command
to:

Add asset roots.
If you use the Google Earth Enterprise Fusion Tutorial, Google recommends that you specify separate asset roots
for each user’s tutorial data and a completely different asset root for your real working data.

Identify source volumes.
You must identify each directory that contains your source data files (or subdirectories of your source data files).
Fusion is not able to read files located in other directories.

Modify the current volume.
You can modify volume definitions when migrating from a single- to a multiple-workstation configuration or when
modifying the local path of a network-mounted source volume (for example, when adding a larger drive for source
data).

For more information on these commands, see geconfigureassetroot in the Command Reference chapter.

Caution: Do not modify the volume definition after you save data to that volume. Because the local name and the
network path definitions are used by Fusion for resources, projects, and database definitions, any change to a volume
definition invalidates the data already processed on that volume.

If you add multiple asset roots, you can use the geselectassetroot to specify the volume in which you want to work and
to switch back and forth among the available asset roots, if desired. For more information on these commands, see
geselectassetroot in the Command Reference chapter.

Configuring Font Size in the GUI

If you want to customize certain aspects of the Fusion GUI (such as menus, button labels, tables, lists, and so on), you
can use a graphical configuration tool called Qt Configuration to customize the font size and other GUI features.

1. On the command line, enter qtconfig.

The Qt Configuration dialog appears.

/etc/init.d/gefusion [stop | start | restart]

Administration Guide

Configuring Google Earth Enterprise Fusion

To customize the appearance of the Fusion GUI:



2. Click the tabs at the top of the right side of the window to view the available options, and use the help text on the
left side for help with each tab.

Note: The Qt Configuration tool is not a Google product. For more information about Qt Configuration, select
either of the options on the Help menu.

Configuring Fonts For the Text Style Dialog

Fusion provides the Sans regular font for map vector labels. If you want to let users create labels in additional fonts, you
can define a "font list" file so that the Text Style dialog displays a list of the fonts you support. For example, you can
display international fonts such as Chinese, Japanese, or Hebrew character fonts. (For more information about the Text
Style dialog, see the Google Earth Enterprise Fusion Reference Guide.)

1. Create an ASCII text file and save it as /opt/google/share/fonts/fontlist.
2. For each font you want to support, enter one line in the file that contains the four following pieces of information:

Font name - the name of the font, which appears in the drop-down list of fonts available in the Text Style
dialog (for example, TimesRoman). No spaces are allowed in the font face name. Multiple variations of the font,
such as regular, bold, italic, are automatically grouped under the same name in the drop-down list.
File Path - the full path to the TrueType (.ttf) font file. No spaces are allowed in this path.
Bold - 1 if the font is bold; 0 if not.
Italic - 1 if the font is italic (or oblique); 0 if not.

3. Save the file.

For example, your font list file might contain:

Customizing Your Google Maps Landing Page

Google used the Google Maps API to create a sample web application that provides a very basic way to display your
Google Maps database output in a browser. The sample web application and the Google Maps API are automatically
installed with Fusion.

Google recommends that you use the sample application to display your Google Maps data at first. After you see how it
looks, you can create your own Google Maps web application that looks more your other web applications, using the
provided sample web application as a guide. Documentation for the Google Maps API is at
http://www.google.com/apis/maps/.

LucidaBrightDemi /usr/local/lib/fonts/LucidaBrightDemiBold.ttf 1 0
LucidaBrightDemi /usr/local/lib/fonts/LucidaBrightDemiItalic.ttf 0 1
LucidaBright /usr/local/lib/fonts/LucidaBrightItalic.ttf 0 1
LucidaBright /usr/local/lib/fonts/LucidaBrightRegular.ttf 0 0
LucidaSansDemi /usr/local/lib/fonts/LucidaSansDemiBold.ttf 1 0
LucidaSans /usr/local/lib/fonts/LucidaSansRegular.ttf 0 0
LucidaTypewriter /usr/local/lib/fonts/LucidaTypewriterBold.ttf 1 0
LucidaTypewriter /usr/local/lib/fonts/LucidaTypewriterRegular.ttf 0 0
LucidaTypewriter /usr/local/lib/oblique-fonts/LucidaTypewriterBoldOblique.ttf 1 1
LucidaSansDemi /usr/local/lib/oblique-fonts/LucidaSansDemiOblique.ttf 0 1
LucidaSans /usr/local/lib/oblique-fonts/LucidaSansOblique.ttf 0 1
LucidaTypewriter /usr/local/lib/oblique-fonts/LucidaTypewriterOblique.ttf 0 1

To create a font list file:

http://www.google.com/apis/maps/


To get started, make a copy of the sample application files (maps_local.html, maps_google.html, fusionmaps.js, and
fusionmaps.css). Then configure a virtual server on which you can experiment, and move the copied files to that virtual
server. (See Configuring Virtual Servers for help, if you need it.) When you create the Apache configuration file for the
new virtual server, change “/maps/maps_google.html” or "/maps/maps_local.html" in the following line to point to your
copy of the example files on the new virtual server:

or

You can edit the rest of the sample application in whatever ways you like, adding your own logo, branding, and so on.

Google Maps supports only specific browser/operating system combinations. Even if you are using a supported browser,
there are some features in Fusion that are not supported by some browsers on certain operating systems. (See Google
Maps Browser Support and Incompatibilities in the Google Earth Enterprise Fusion Reference Guide.)

As long as you are connected to the Internet and have a license key for the Google Maps API, there is no problem
(regardless of your platform), since your server contacts Google’s servers for functions that are not supported in the
browser.

Note: The following procedure assumes that you have received an email from Google that contains your license key
for the Google Maps API.

1. Open /opt/google/gehttpd/htdocs/maps/maps_google.html.
2. Locate the following line in the script:

3. Replace the key placeholder ('abcdefg ') with your Google Maps API license key. Your key is contained in an email
sent from Google.

4. Save the maps_google.html file.
5. Restart the Google Earth Enterprise Server (as root):

Using the dbRoot Snippet Manager

The dbRoot is a file that contains information that Fusion passes to Google Earth EC when you publish a database. The
dbRoot Snippet Manager allows you to add your preferences to the dbRoot. Many of these preferences (or snippets)
apply to display characteristics, such as showing or hiding the Google logo in Google Earth EC. The snippets you specify
in the dbRoot Snippet Manager apply to all databases you publish from Fusion.

Caution: If you are working with multiple Fusion users on multiple workstations, it is important to remember that all
managers on the Tools menu can be accessed by all users at the same time. If multiple users are working with the
same manager at the same time, when one user closes the manager, that user’s changes overwrite all previous data
for that manager. So if you are working in a multi-user environment, be sure to coordinate with the other users to be
sure that only one user has this manager open at a time.

1. Select Tools > dbRoot Snippet Manager. The dbRoot Snippet Manager appears.

2. Click the page icon . The Add New Snippet dialog appears.
3. Enter a name for the new snippet, and click OK. The snippet appears on the list in the dbRoot Snippet Manager.

RewriteRule ^/default_map/+$ /maps/maps_google.html [PT]

RewriteRule ^/default_map/+$ /maps/maps_local.html [PT]

<script src="http://maps.google.com/maps?file=api&v=2&key=abcdefg"type="text/javascript"></script>

sudo /etc/init.d/geserver restart

Configuring the Google Maps API License Key

To configure your Google Maps API license key:

To add a snippet:



4. Click in the Snippet Text column to enter the appropriate snippet text. The next section contains a list of allowable
snippets. Snippet text syntax is as follows: [snippetName] value

5. If you want to specify different snippet text for each supported locale, right-click the name of the snippet, and select
a locale.

6. When finished, click OK.

The following table lists the syntax for all of the possible dbRoot snippets.

Snippet Name Purpose Syntax - Default Value Notes

userGuideURL Help menu >
User Guide

../userguide/v4/userGuideURL Defaults to local PDF
file for Google Earth
EC. Can be set to an
internal IP or
hostname address.

supportCenterURL Help menu >
Support
Center

../userguide/v4/support Hidden in Google
Earth EC if dbRoot
setting does not
exist. Can be set to
an internal IP or
hostname address.

tutorialGuideURL Help menu >
Tutorial

../userguide/v4/tutorials/index.htm Can be set to an
internal IP or
hostname address.

keyboardShortcutURL Help menu >
Keyboard
shortcuts link

../userguide/v4/ug_keyboard.html Can be set to an
internal IP or
hostname address.

defaultWebPageURL Tools menu >
Web browser
home page

http://www.google.com Can be set to an
internal IP or
hostname address.

useGELogo Shows/hides
Google Earth
logo in lower
right corner of
display

boolean Default is true.

bbsServer.host Host name string bbs.keyhole.com

bbsServer.port Port int 80

bbsServer.
  fileSubmitPath

URL to post
KMZ content
to

string /ubb/postbouncer.php

bbsServer.
  postWizardPath

URL where
posting wizard
is located

string /ubb/postcatcher.php

bbsServer.timeout Timeout in
seconds

double 15.0

bbsServer.retries Number of
retries before
failing

int 2

bbsServer.secureSS true = use
HTTPS
connection to

boolean Default is false.

dbRoot Snippet Syntax



hostfalse =
use HTTP
connection

cobrandInfo Custom co-
branded logo

[export.cobrandInfo] {
<etCobrandInfo> [top-center] {
"http://your_server.com/your_logo.png"
0.5 0.95 true true top-center 0.25
}

earthIntlURL Localize
international
URL for
Google Earth

http://earth.google.com/intl/%1/

supportAnswerIntlURL Localize
international
URL for
support
answers

http://earth.google.com/support/
bin/answer.py?answer=%4&hl=%1

supportTopicIntlURL Localize
international
URL for
support topics

http://earth.google.com/support/
bin/topic.py?topic=%4&hl=%1

supportRequestIntlURL Localize
international
URL for
support
requests

http://earth.google.com/support/
bin/request.py?hl=%1

startupTipsURL Localize
international
URL for
startup tips

http://earth.google.com/
intl/%1/tips/v4/

userGuideIntlURL Localize
international
URL for
documentation

http://earth.google.com/intl/%1/
userguide/v4/

supportCenterIntlURL Localize
international
URL for the
support center

http://earth.google.com/support/?hl=%1

businessListingIntlURL Localize
international
URL for
business
listings

http://www.google.com/local/
add/login?hl=%3&gl=%2

defaultWebPageIntlURL Localize
international
URL for the
default web
page

http://www.google.com (English)

http://www.google.com/intl/pt-BR
(Portuguese)
http://www.google.com/intl/%1 (all other
languages)

numStartupTips Set the
number of
startup tips
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hideUserData true =
Suppress user
name and
license key
information in
the Help ->
About
windowfalse =
Display user
name and
license key

boolean Default is false.



information

export.options.
  disableDiskCache

true = Disable
disk caching,
so databases
can ask
Google Earth
EC not to use
disk cache at
all.false =
Enable disk
caching.

boolean Default is false.

reverseGeocodingServer... Defines the
reverse
geocoding
server.

The default uses Google's geocoding
server:

To use your own geocoding server:

Note: Advanced users of previous versions of Fusion were able to hand edit the dbRoot preamble. That is no longer
possible. Most of the hand edits that users made in the past are now features built in to Fusion (such as the Search
Tab Manager), and other changes are possible using the dbRoot Snippet Manager. However, there are some edits that
advanced users made in dbRoot in previous versions of the software that are no longer allowed at all, including:

Manually editing streamed layers combined for hybrid service.
Appending a KML file to dbRoot.
Manually adding a nested layer.

If you have any questions about these functions, please contact Google Earth Enterprise Fusion technical support.

1. If you want to change the location of the snippet in dbRoot, click in the Snippet Location field for the snippet you
want to move.

This field toggles between the values End and Beginning to move the snippet to the end or beginning of the
dbRoot. This setting is useful when you want to change the order in which the layers appear in Google Earth EC by
reordering them in dbRoot.

2. If you want to change the snippet text, click in the Snippet Text field for the snippet you want to modify, and edit the
text.

Note: If you modify a dbRoot snippet, it does not force you to rebuild project affected by that change. If that
dbRoot snippet affects a project that has already been built, when you publish a database that includes that
project, the previous dbRoot snippet remains in effect. If something else in that project subsequently triggers a
build, the modified dbRoot snippet will take effect in the resulting version.

1. Select the snippet you want to delete, and click .

A message prompts you to confirm that you want to delete the selected snippet.

2. Click OK.

The snippet disappears from the dbRoot Snippet Manager.

Monitoring System Processes

You can watch all active Fusion system tasks and processes using the getop command. This command is similar to the
Unix command top, but is specific to Fusion processing. It is the command line equivalent to the System Manager in the

[googleMFEReverseGeocoder] 
 http://maps.google.com/
 maps/api/earth/
 GeocodeService.Search
[reverseGeocodingServerVersion] 3
[reverseGeocodingServer.host] 
 geo.keyhole.com
[reverseGeocodingServer.path] /maps

[reverseGeocodingServerVersion] 2
[reverseGeocodingServer.host] 
 your_geocoding_server
[reverseGeocodingServer.path] 
 /path_for_queries

To modify a snippet:

To delete a snippet:



Fusion GUI. See getop in the Command Line Reference chapter for more information.

The getop command outputs the following data for the workstation to the console:

Version of Fusion running
Host name of the master
Currently selected asset root
The active process and maximum number of jobs allowed (max = n)
List of processes waiting to run
Process IDs, running time, and names of all Fusion processes running

For example, the output might look something like this:

Backing Up Your Data

Generally, the important Google Earth Enterprise Server data is all within the /var directory. If you perform regular back-
ups of /var, that covers most of the server data. Google recommends that you also back up the following directories:

With regard to Fusion data, Google strongly recommends that you back up all of your original source data (vector and
raster). In addition, Google encourages you to back up all of the .xml files within your asset root(s). In theory, if you have
the source data and the asset root .xml files, everything else can be reconstructed. Google Earth Enterprise does not
include any tools for doing such a reconstruction, but the data is there and it could be done, if necessary.

You do not need to back up your publish root(s), since there is nothing there that cannot be reproduced. If you have the
space and want to back them up, however, recovery will be faster, but it is not necessary.

Many Google Earth Enterprise users also back up their product files. These are the low-level files that result from building
resources (for example, .kip, .ktp, .kmp, .kvp). That way, if you do need to reconstruct, you can import the product files
(rather than raw source files) to recreate the resources. This will save you some build time.

Running Fusion on a Machine with Multiple CPU Cores

Fusion can be configured to use a maximum number of CPU cores on a machine with the command:

/etc
/opt/google/gehttpd/conf
/opt/google/gehttpd/conf.d
/opt/google/getomcat/conf
/opt/google/gehttpd/htdocs



This number will show up as the maxjobs entry within getop output and corresponds to how many concurrent jobs Fusion
may spawn at any one time. Note that the value for --numcpus should be equal to, or less than, the total number of CPUs
permitted by your Fusion license; it should never exceed the number of physical CPU cores on the machine.

Each task within Fusion is configured to use 1 CPU by default. Changing the maximum number of CPUs using the above
command will not affect the number of CPUs assigned to each individual task. Some tasks in Fusion are capable of
multithreaded support including:

gepackgen (imagery and terrain projects)
gemaptilegen (2D vector-based map tiles)
gecombineterrain (3D databases)

These tasks may be multithreaded by enabling 'Taskrules' within Fusion. Implementation of Taskrules is described in:
/opt/google/share/taskrules/README.

The PacketLevel.taskrule, MapLayerLevel.taskrule, and CombinedTerrain.taskrule taskrules will enable multiple
CPUs to work on each individual task. For example, configuring a minNumCPUs and maxNumCPUs of 2 for gepacken means
that up to 4 gepackgen processes may run on Fusion, with 2 CPUs assigned each, when 8 CPU cores are allocated.

As a best practice, PacketLevel.taskrule and MapLayerLevel.taskrule should be configured such that multiple
gepackgen and gemaptilegen processes can run concurrently. Since gecombineterrain is CPU-intensive and can be an
operational bottleneck, more CPUs should be assigned to that task to expedite processing.

So on a machine with 8 CPU cores available for Fusion processing:

1. Set --numcpus=7. It's recommended to set the maximum number of CPUs allocated to Fusion to (N-1), such that
one CPU core is reserved for system operations

2. Set minNumCPU=2 and maxNumCPU=2 in PacketLevel.taskrule for imagery projects (3 concurrent gepackgen jobs
possible)**

3. Set minNumCPU=3 and maxNumCPU=4 in PacketLevel.taskrule for terrain projects (2 concurrent gepackgen jobs
possible)**

4. Set minNumCPU=3 and maxNumCPU=4 in MapLayerLevel.taskrule (2 concurrent gemaptilegen jobs possible)
5. Set minNumCPU=7 and maxNumCPU=7 in CombinedTerrain.taskrule (1 gecombineterrain job)

**Note: Fusion will use up to 200% CPU processing for imagery projects per gepackgen process, and up to 600% CPU
processing for terrain projects. There is fundamentally a balance between assigning sufficient numbers of CPUs to
each individual process for gepackgen while still enabling multiple concurrent gepackgen processes for parallel
processing.

All other tasks in Fusion will continue to operate with min/max 1 CPU.

/opt/google/bin/geselectassetroot --assetroot /my/assetroot --numcpus X

Back to top



4.4.1 Documentation

Administration Guide

Home

Configuring GEE Server

Configuring Fusion

Configuring Tutorial Work
Space

Command Reference

Common Server Error
Messages

Multiple Database Support

Legal Notices

This document discusses system administration for the Google Earth Enterprise (GEE) system.
This includes hardware and network preparation steps, as well as installation, configuration, and
maintenance for all system components:

Fusion
GEE Server
Fusion Tutorial

Audience

This guide is intended for individuals who are responsible for installing, configuring, and
maintaining any part or all of the Google Earth Enterprise (GEE) system.

In This Guide

This guide includes the following chapters:

Configuring Google Earth Enterprise Server explains how to configure GEE Server.
Configuring Google Earth Enterprise Fusion explains how to configure Fusion.
Configuring Tutorial Work Space explains how to set up a separate work space for each user
to work on the Fusion Tutorial, as well as how to remove the tutorial data when each user is
finished.
Command Reference provides a list of all of the system administration commands you can
use to configure the GEE system.
Common Server Error Messages provides a list of common error messages that you might
encounter when you install and configure the GEE system.
Multiple Database Support describes the feature in Google Earth Client (EC) 6.0 that
supports simultaneous connection to multiple databases.

Administration Guide

About This Guide
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Configuring GEE Server

Configuring Fusion

Configuring Tutorial Work
Space

Command Reference

Common Server Error
Messages

Multiple Database Support

Legal Notices

This appendix describes all of the command line tools for system administrations in alphabetical
order. If you prefer, you can find each tool’s syntax by entering the name of the tool with the --
help option, for example:

This appendix uses the following typographic conventions:

Italic Information that the user must supply

Bold   Text that the user must type exactly as
shown

Ellipsis ... Argument that can be repeated several
times in a command

Square brackets [ ] Optional commands or arguments

Curly braces { } with options separated by pipes
|; for example: {even | odd}

Lists a set of choices from which the
user can select only one

Parentheses ( ) Grouped items that function together

Courier font Code or program output

geconfigureassetroot

To add volume definitions or edit existing volume definitions.

Note: You must stop the system manager before using this command and then start it
again after you are done. You must also run this command as root.

Optional. Specify the path to the new asset root.

Note: If you omit all options, the system creates /gevol/assets.

geconfigureassetroot --help

geconfigureassetroot {--new --assetroot path | --repair | --editvolumes | --
fixmasterhost | --noprompt} [--srcvol path]

geconfigureassetroot --new --assetroot /gevol/assets
geconfigureassetroot --new --assetroot /gevol/assets --srcvol /data1/src
geconfigureassetroot --repair
geconfigureassetroot --editvolumes

--new --assetroot path

--repair

Administration Guide

Command Reference

Purpose

Example

Commands



Optional. Repairs various inconsistencies in the asset root (such as permissions,
ownership, missing ID files, and so on). When you run this command, the tool auto-detects
the problems that need to be repaired and fixes them.

Note: Do not use this command unless you see a system message instructing you to do
so.

Optional. Follow the prompts to add a volume to the selected asset root or, modify the
localpath definition for an existing volume, or to add a volume definition.

Optional. Change the assetroot host entry to match the current host name. (This command
corrects cases where a host name is changed after installing and configuring Fusion.)

Optional. Perform the command without prompting the user for any input. This option
requires that some commands have arguments specified on the command line.

Optional. Specify the path to the source volume.

geconfigurepublishroot

To specify the path where you want to publish databases for the current GEE Server. Follow
the prompts.

Note: You must run this command as root.

Optional. The path to the publish root. Default value is /gevol/published_dbs.

Optional. Configures the publisher to accept symbolic links. Useful when the publish root is
on a separate logical volume from the asset root. Default is no.

Optional. Perform the command without prompting the user for any input. This option
requires that some commands have arguments specified on the command line. If the
arguments are insufficient or the configuration fails, the program will return -1 (0 is returned
on success).

--editvolumes

--fixmasterhost

--noprompt

--srcvol path

geconfigurepublishroot [--path=path] [--allow_symlinks] [--noprompt]

geconfigurepublishroot --path /gevol/published_dbs --allow_symlinks

--path=path

--allow_symlinks

--noprompt

Purpose

Example

Commands



Caution: Do not create more than one publish root for a single asset root. That
configuration produces unpredictable or undesirable results, including the inability to
publish at all from that asset root.

gedisconnectedclean

To clean a disconnected database from a disconnected mock asset root.

Required. Specify the database path to clean. This must be a low-level path to a database
directory (one of the entries in the assetroot/dbpaths.list file). See --list command option
to find databases stored within the mock asset root.

Optional. List all dbpaths currently in disconnected asset root

gedisconnectedpublish

To publish a database on a disconnected server.

Optional. Since db_name is the “low-level” name of the database, db_alias allows you to
enter a name that is easier to remember, for example, Databases/SF Highways.kdabase?ver=1.

Required. The full, “low-level” name of the database you want to publish.

gedisconnectedreceive

Deprecated in version 4.0
gedisconnectedreceive is required only when the disconnected database was sent with an
older (pre 4.0) version of Fusion.

gedisconnectedclean [--dbpath dbpath] [--list assetroot]

gedisconnectedclean --dbpath /gevol/assets/Databases/MyPOIs.kdatabase

--dbpath dbpath

--list assetroot

gedisconnectedpublish [db_alias] db_name

gedisconnectedpublish MyPOIs

db_alias

db_name 

gedisconnectedreceive --input dirname

Purpose

Example
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To copy a disconnected database from either detachable media or local storage into the
mock asset root.

For detachable media:

For local storage:

Required. Specify the directory that contains the files to be copied. This is typically the
mount point of a hard drive.

Notes:
The gedisconnectedreceive command will create an asset tree that mirrors the asset tree
of the Fusion system that built the database.

The gedisconnectedreceive command will copy data to the mock asset root if the input
folder is on a separate volume than the mock asset root.  Links to the input folder to the
mock asset root will be created if both the input and mock asset root folders on the
same volume.

gedisconnectedsend

To gather all the files from a Fusion asset root necessary for a disconnected publish, for
either publishing new databases or publishing "delta" updates.

Optional. Specify an extra file to package. This is typically used to repair broken files.

Optional. Specify which database path already exists on the target server. This must be a
low-level path to a database directory and may be specified more than once.

Optional. Specify the file that contains the list of existing database paths (copy of

gedisconnectedreceive --input /mnt/usbdrive/SFHighways_3dDatabase_v20

gedisconnectedreceive --input
   /gevol/src/disconnected_databases/SFHighways_3dDatabase_v20

--input dirname

gedisconnectedsend [--extra filename] [--havepath dbpath] [--havepathfile file]
   --output dirname [--sendpath dbpath] [--sendver dbver]

gedisconnectedsend --sendver Databases/SFHighways.kdatabase?version=2
   --output /gevol/src/disconnected_databases/SFHighways_3dDatabase_v2

--extra filename

--havepath dbpath

--havepathfile file 

Purpose
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assetroot/dbpaths.list from the remote server).

Required. Specify where to gather the files. The directory must already exists and be empty.
This is typically the mount point of a hard drive.

Optional. Specify which database path to send. This must be a low-level path to a database
directory. You can determine this path by entering gequery --outfiles dbver on the source
server.

Optional. Specify which database version to send. Use the ?version=... syntax. Available
database versions may be found with the gequery --versions command.

Note: The gedisconnectedpublish command may be used for publishing new databases to
a remote server, or for "delta" publishes (which include only changes between versions)
to a remote server.

geindexcheck

To diagnose problems with Fusion databases. You can run geindexcheck on either the
unified index or intermediate indexes. The most common errors geindexcheck detects are
CRC errors and missing files. For missing files, it reports the full file path. For CRC errors,
it reports the full file path and the position within the file where the error occurred. After
reporting an error, geindexcheck stops searching. This is because searching a corrupt
index usually generates large numbers of redundant or irrelevant error messages caused by
the initial error.

Optional. Search the index only (default) or specify "all" to search both the index and packet
files (in index order).

Optional. Specify the level of error reporting from 0 (fatal error) to 7 (all messages). The
default is 3. This overrides KH_NFY_LEVEL.

Optional. Request progress messages every n index locations. The default is 100000. To
disable, set to 0.

--output dirname

--sendpath dbpath

--sendver dbver 

geindexcheck [--mode= {index | all}] [--verbose= n] [--progress n]

   [--help] { --index=index_path | --database=database_name }

geindexcheck --mode all --database 
/gevol/published_dbs/stream_space/your_server/gevol/assets/Databases/igain.kdatabase/
gedb.kda/ver001/gedb

--mode= {index | all}

--verbose= n

--progress n

Purpose
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Note: If enabled, this requires a verbose level of 3 or greater.

Optional. Print the error message.

Required. Specify either the index or the database parameter, but not both. For index,
specify the path to the index to search. The index can be of any type. For database, specify
the path from the asset root to the database. The unified index for the database is searched.
Defaults to the latest version. To override the default, append "?version=n", where "n" is
the version number.

gepublishdatabase

Deprecated in version 4.0
You can now publish databases using either the geserveradmin tool or the Fusion GUI.

To publish a database.

Delete a registered database from the server.

Optional. Use a specific server URL, such as http://private.company.com.

List all databases registered on the server.

Optional. Use a specific server URL, such as http://private.company.com.

Specify the location and name of the database that you want to publish relative to the asset
root, for example, Databases/databaseA.

Optional. Specify the nickname of the server association to which you want to publish. If
you omit the server specification,  Fusion publishes to the default server. (Consult your

--help

--index=index_path | --database=database_name

gepublishdatabase [--delete db_name [--serverurl url]][--listdbs [--serverurl 
url]][--publish dbname [--server nickname]][--publisheddbs [--serverurl url]]

gepublishdatabase --publish msDelta
gepublishdatabase --publish msDelta --server mainServer
gepublishdatabase --listdbs --serverurl http://private.company.com

--delete db_name

--serverurl url

--listdbs

--serverurl url

--publish dbname

--server nickname

Purpose
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administrator or refer to the Google Earth Enterprise Administration Guide for information
about setting up server associations.)

List all of the published databases on the server.

Optional. Use a specific server URL, such as http://private.company.com.

geselectassetroot

To perform a variety of operations related to existing asset roots on the current machine.

Note: You must stop the system manager before using this command and then start it
again after you are done. You must also run this command as root.

Optional. Disables the ability to select a different asset root on this machine.

Optional. Perform the command without prompting the user for any input. This option
requires that some commands have arguments specified on the command line.

Optional. Enables the ability to select a different asset root on this machine. (Use only if --
lock is enabled.)

Optional. Specify the path to the asset root for this machine.

Optional. Specify this machine's role in the asset root (master or slave). The default role is
master. This command is available only in combination with --assetroot.

Optional. Specify the number of CPUs on this machine to use for processing. The default
will be the maximum number of CPUs detected on the machine during installation. This
command is available only in combination with --assetroot.

--publisheddbs

--serverurl url

geselectassetroot [--lock] [--noprompt] [--unlock]
   ( [--assetroot path [--role {master | slave}] [--numcpus num]] )

geselectassetroot --lock
geselectassetroot --unlock
geselectassetroot --assetroot /gevol/assets
geselectassetroot --assetroot /gevol/assets --role slave --numcpus 3

--lock

--noprompt

--unlock

--assetroot path

--role {master | slave}

--numcpus num

Purpose
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geselectpublishroot

To specify a different publish root. The specified path must exist. If you want to create a
publish root, see geconfigurepublishroot.

path

Required. Specify the path to the desired publish root.

Optional. Perform the command without prompting the user for any input. This option
requires that some commands have arguments specified on the command line.

geserveradmin

To configure your GEE Server. This section breaks down the geserveradmin commands into
the following categories:

Database
Virtual server
Search plug-in
Admin
Miscellaneous

All of the commands of each type are described below. At least one command is required.

Optional. Specify a stream server other than the default. The default is the current server.

geselectpublishroot path [--noprompt]

geselectpublishroot /gevol/published_dbs

--noprompt

geserveradmin [options] commands

geserveradmin --listdbs
geserveradmin --listplugins
geserveradmin --server_type map --dbdetails 
/gevol/assets/Databases/USCounties.kdatabase/gedb.kda/ver001/gedb
geserveradmin --server_type map --dbdetails “/gevol/assets/Databases/SF 
Neighborhoods.kdatabase/gedb.kda/ver001/gedb”
geserveradmin --addvs private --vstype ge
geserveradmin --disablevs private
geserveradmin --addplugin ExamplePlugin --jar_path /your_path/ExamplePlugin.jar--
class com.google.earth.search.plugin.ExamplePlugin

--stream_server_url url

--search_server_url url

Purpose
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Optional. Specify a search server other than the default. The default is the current server.

Optional. Specify whether the servers in question are stream or search servers. The default
is stream. If you want to reference a search server, this option is required with the listdbs,
dbdetails, listvss, vsdetails, addvs, deletevs, disablevs, and garbagecollect commands.

Each of the database commands is listed below, along with its syntax and description. If the
name of the database contains one or more spaces, double quote the entire path. (See the
examples above.)

Register a new database with the specified name.

Optional. Specifies a user-friendly name for the database.

Provides a list of all of the files required by the specified database. If omitted, the server
type defaults to stream.

Deletes the specified database entry from the server. Does not delete the actual files. (This
command is similar to putting files in the trash on a Windows or Macintosh desktop. See
also --garbagecollect.)

Note: If you want to delete a currently published database, you can either publish a
different database to the same virtual server or disable the virtual server on which it is
published. Then you can delete the database. (See also --disablevs.)

Lists all databases ever published (except any deleted databases) on the server. If the
server type is omitted, the server type defaults to stream.

Lists all plug-ins used on the server.

Publish one or more databases on the specified virtual server. If the virtual server name is
omitted, it publishes to the default server.

Optional. Push the specified database to the virtual server.

--server_type {stream | search}

--adddb db_name [--dbalias alias]

--dbalias alias

--dbdetails db_name

--deletedb db_name

--listdbs

--listplugins

--publishdb db_name [--push] [--streamvs vs_name] [--searchvs vs_name]

--push

--streamvs vs_name

Commands
Database



Optional. Specify the name of the stream server.

Optional. Specify the name of the search server.

Lists the databases currently published on the server. If the server type is omitted, the
server type defaults to stream.

Push one or more databases to the server.

Each of the virtual server commands is listed below, along with its syntax and description.

Caution: Publishing to virtual servers other than the default server is supported only in
version 4.2 or later of Google EC. If you are using version 4.0 or earlier, only databases
that you publish to the default server can be accessed by Google EC.

Registers a new virtual server with the specified name. Spaces are not allowed in the virtual
server name. If the server type is omitted, the server type defaults to stream.

Optional for stream servers. Specify the type of databases to be published to the new
virtual server. If omitted, the virtual server type defaults to ge.

Required. The vsurl specifies the location of the virtual server. It must match the
corresponding server-side virtual server configuration. There are three ways to specify the
vsurl:

Location-based URL, such as /private_ge. For example, if the entire URL is
http://www.company.com/private_ge, you enter /private_ge.

Note: Google recommends that you use the _ge and _map naming convention to
make it easier to distinguish between virtual server types.

Port-based URL, such as:

The entire URL, including protocol, server name, path (if applicable), and port are
required.

Name-based URL, such as:

For this type of specification, you must modify your DNS appropriately for the virtual
server.

After you use this command, you must create a configuration file for the new virtual server.
(See Configuring Virtual Servers for details.)

--searchvs vs_name

--publisheddbs

--pushdb db_name...

--addvs vs_name [--vstype {ge | map}] --vsurl url [--vscachelevel num]

--vstype {ge | map}

--vsurl url

http://www.company.com:1234

http://corp.company.com

Virtual Server



Optional. Specify a cache level (1, 2, or 3) for the virtual server. The default is 2.

This cache is different than the client cache. This option caches only the index nodes at
display levels 4, 8, and 12 (not data packets). If you increase this setting,  Fusion caches
more of the index in RAM, thereby decreasing server latency at the cost of server RAM.
Level 3 uses approximately 1 GB of RAM. Level 2 uses approximately 4 MB of RAM. Level 1
uses approximately 16 KB of RAM. Each additional cache level consumes 256 times the
RAM as the previous level and saves one disk read per packet served.

The server makes no checks that the RAM needed for caching does not exceed the total
RAM on the machine. For example, if you have three virtual servers set to cache at level 3
on a machine that has only2 GB of RAM, the machine will thrash memory. The default is
Level 2, so you should be able to create as many virtual servers as you want at the default
cache level without worrying about running out of RAM.

Typically, users increase only a small number of virtual servers to cache level 3 on
production servers and leave the rest of them at level 2. On servers that share a machine
with  Fusion, do not increase the level to 3. Google Earth Enterprise Fusion needs more
RAM than the server does.

Permanently delete the specified virtual server. If the server type is omitted, the server type
defaults to stream.

Temporarily disable the specified virtual server, primarily to prevent Google EC users from
connecting to that server temporarily. If the server type is omitted, the server type defaults
to stream.

Note: To re-enable a disabled virtual server, simply publish a database to it.

Provides a list of all virtual servers configured for the current machine. If the server type is
omitted, the server type defaults to stream.

Displays the name and URL of the specified virtual server. If the server type is omitted, the
server type defaults to stream.

Each of the search plug-in commands is listed below, along with its syntax and description.

Note: These commands are available on search servers only.

Registers a new search plug-in.

Required. Specify the path to the .jar file for the plug-in.

--vscachelevel num

--deletevs vs_name

--disablevs vs_name

--listvss

--vsdetails vs_name

--addplugin plugin_name --jar_path path --class class_name

--jar_path path

--class class_name

Search Plug-in



Required. Specify a fully qualified class name for the plug-in.

Deletes the specified search plug-in.

Lists all registered plugins.

Each of the admin commands is listed below, along with its syntax and description.

Permanently deletes the files for databases that have been selected for deletion. Generally,
you run this command nightly to remove the files for databases that users have deleted to
free up space on the storage device. (This command is similar to emptying the trash on a
Windows or Macintosh desktop. See also --deletedb.)

Note: Deletes only those files that are not used by other databases on that server.

Each of the miscellaneous commands is listed below, along with its syntax and description.

Enables cutting of portable globes. For more information about portable globes, please refer
to the Portable Globe and Server guide.

Disables cutting of portable globes.

getop

To display a list of what  Fusion is currently working on and whether gesystemmanager and
geresourceprovider are currently running.

Enter Ctrl-C to exit and return to the prompt.

Optional. Specify the number of seconds delay between refreshes. For example, if you
specify 30, getop runs every 30 seconds. If you do not specify the delay, it does not refresh.

geupgradeassetroot

--deleteplugin plugin_name

--listplugins

--garbagecollect

--enable_cutter

--disable_cutter

getop --delay seconds

getop --delay 30

--delay seconds

Admin
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To upgrade an existing asset root after installing a later version of the software.

Note: You must stop the system manager before using this command and then start it
again after you are done. You must also run this command as root.

Required. Specify the path to the asset root. If omitted, the asset root defaults to
/gevol/assets.

Optional. Perform the upgrade without prompting the user for any input. This option
requires that some commands have arguments specified on the command line.

geupgradeassetroot --assetroot path [--noprompt]

geupgradeassetroot --assetroot /data1/assets

--assetroot path

--noprompt

Back to top
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Server error messages appear mainly when:

The server (or part of it) is not running.
The network connection to the server is down.

To determine whether the server is running, enter the server’s URL or IP address in a browser
window. If it is running, the browser displays the Google Earth logo. If it is not running, the browser
displays a Page Not Found error message. To start the server, if necessary, enter:
/etc/init.d/geserver start

The remainder of this appendix provides additional information about the most common error
messages you might see in Google Earth Enterprise Server, including:

Authentication required
Database is currently published. Please disable the stream virtual server first.
Either the virtual server vs_name does not exist or is already disabled.
Incorrect cache level
Invalid database
Plugin already exists.
Plugin plug-in_name is not registered.
Search server push failed
Stream server push failed
Unable to contact server
Unable to contact search server
Unable to contact stream server
Upload failed
Virtual server already exists
Virtual server URL missing

If you encounter any errors that include the text “internal error”, contact Google technical support.

Authentication required

When you try to publish a database on a server that requires authentication.

You entered an invalid user name or password three times.

Check with your system administrator to be sure you have permission to publish a database and
have a valid user name and password. Then try entering the user name and password.

Note: Be sure that CapsLock is not on.

Database is currently published. Please disable the stream virtual server
first.

When you try to delete a published database with geserveradmin --deletedb db_name. (See

Administration Guide
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geserveradmin.)

You cannot delete a published database.

Either publish a different database, or disable the virtual stream server, and then try deleting the
database again.

Either the virtual server vs_name does not exist or is already disabled.

When you are trying to publish to a virtual server.

Either the virtual server has been disabled, or you made a typographical error when you entered
the command.

Use geserveradmin --listdbs to list all databases registered on the server. (See geserveradmin.)

Incorrect cache level

When you add a virtual server.

You set the cache level to a number other than 1, 2, or 3.

Set the cache level to 1, 2, or 3. (See “geserveradmin” on page A-11 for details.)

Invalid database

When you try to publish a database using the geserveradmin --publishdb command. (See
geserveradmin .)

The database path is incorrect, the database has not yet been built, or the database has been
corrupted.

Enter the correct path or build/rebuild the database.

Plugin already exists.

When you are trying to register a plug-in.

The plug-in is already registered.

No action is required.

Why the Error Occurred
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Plugin plug-in_name is not registered.

When trying to create a search tab.

You tried to create a search tab with a plug-in that is not registered with the server.

Register the plug-in using geserveradmin. (See “geserveradmin” on page A-11.)

Search server push failed
Stream server push failed

When you try to publish a database.

The network connection to the server is down, or permissions are set incorrectly where the
publisher is attempting to write data.

Check your network connections and ensure that the targeted server is running and accessible.
Check the access permissions in the publish root directory.

Unable to contact server
Unable to contact search server
Unable to contact stream server

When you try to publish a database.

The specified server is not running, or a service that it requires is not running.

Enter the following command as root to restart the server:

Upload failed

When you try to publish a database.

The network connection to the server is down, or permissions are set incorrectly where the
publisher is attempting to write data.

Check your network connections and ensure that the targeted server is running and accessible.
Check the access permissions in the publish root directory.

/etc/init.d/geserver restart
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Virtual server already exists

When you are creating a virtual server with geserveradmin --addvs. (See “geserveradmin” on
page A-11.)

You tried to use a virtual server name that has already been used for another server.

Always use a unique name for a new virtual server.

Virtual server URL missing

When you add a virtual server.

You did not provide a URL for the virtual server you are trying to add.

Include a URL in the command. (See “geserveradmin” on page A-11 for details.)

Additional Support

For the most up-to-date information about Google Earth Enterprise, please email the Google
Enterprise Support team at enterprise-support@google.com.

Back to top
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Google Earth EC 4.0+ supports simultaneous connections to multiple databases. This feature
allows users to view extra data and imagery layers drawn on top of each other.

The first database the user connects to is identified as the primary database. After logging in, the
user can connect to other databases (which are identified as secondary databases) with the Add
Database option from the File menu.

There is no hard limit to the number of databases that a user can connect to simultaneously.
However the disk cache system supports a maximum number of eight databases. For all practical
purposes, that means that a user should connect to a maximum of seven secondary databases in
addition to the primary database.

Layers

The layers of each database are grouped in the Layers panel under the name of the database.

Google Earth EC draws the imagery of the primary database first. It draws other imagery layers
from secondary databases (if present) on top.

Users can make these additional imagery layers partially or totally transparent using the
transparency slider that appears at the bottom of the Layers panel when a secondary database is
selected. The transparency slider may not appear if the selected database does not contain any
imagery layers. This feature facilitates comparison of imagery layers.

Google Earth EC draws vector layers independently of each other. Users can enable any number
of vector layers from any connected databases (primary or secondary).

Search Tabs

Custom search tabs can be configured for secondary databases, as well as for the primary
database. The customization takes effect only after Google Earth EC connects to that database by
either logging in to it as the primary database, or by adding it as a secondary database. (See the
Google Earth Enterprise Fusion Reference Guide for instructions for configuring search tabs and
adding them to a database.)

If you log in to a primary database for which custom search tabs are configured, those search tabs
appear in Google Earth EC. If you add a secondary database that also has search tabs configured
for it, the secondary database's search tabs do NOT appear in Google Earth EC; only the primary
database's search tabs appear. The search tabs configured for the secondary database appear in
Google Earth EC only if the primary database has no custom search tabs configured for it.

Authentication Considerations

The prevailing authentication mode in any Google Earth EC session (that is, while logged in) is the
mode used by the primary databases. For instance, if the primary database has authentication
turned off, it is not possible to successfully download data from a database such as
kh.google.com, because it requires session cookie authentication (khauth). However, Google Earth
EC does not report any errors while trying to connect to that database; it just fails to download the
imagery data.

Administration Guide
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The following list includes all possible authentication modes and the modes with which each is
compatible:

Mode Description Compatible Modes

khauth Regular authentication used by kh.google.com and
other Google Earth servers

khauth, LDAP,
LDAP+SSL, noauth

LDAP HTTP 1.1 authentication with user name/password LDAP, LDAP+SSL,
noauth

LDAP +
SSL

HTTPS authentication with user name/password LDAP, LDAP+SSL,
noauth

noauth Servers that do not require any authentication LDAP, LDAP+SSL,
noauth

A user wants to connect to the following databases:

kh.google.com (khauth authentication mode)
publicDB, which requires no authentication (noauth authentication mode)
internalDB, which uses LDAP authentication (LDAP authentication mode)

The user connects to kh.google.com as the primary database, and then adds publicDB and
internalDB as secondary databases.

First, Google Earth EC authenticates itself with kh.google.com. Then, when it downloads the first
packet from internalDB, it prompts the user to enter credentials on that server (the
username/password combination configured by the administrator of that database). The primary
authentication mode in this case is khauth, which is compatible with both noauth and LDAP.

Connecting to publicDB first then to kh.google.com as secondary database fails. Google Earth EC
downloads no imagery from kh.google.com (although it reports no error), because noauth, as
noted in the table above, is not compatible with khauth.

The same holds true if internalDB is the primary database and the user adds kh.google.com as a
secondary database. In that case, the primary database uses LDAP authentication, which is not
compatible with khauth.

Another unsupported mode is connecting to a khauth primary database and a miniauth secondary
database. In that case, the user cannot successfully log in to the secondary database (although,
as with the first scenario, it reports no error).

Authentication Modes

Back to top
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The Google Earth Enterprise solution is a network-based, rich 3D and 2D mapping system that
makes vast amounts of data easily accessible from a desktop application. With the Google Earth
Enterprise solution, you can create a central geographic information system (GIS) database that can
simultaneously be distributed to thousands of users.

Overview of the Google Earth Enterprise Solution

The Google Earth Enterprise solution consists of three basic products:

Google Earth Enterprise Client (EC)
Google Earth EC is the client software that creates an interactive 3D globe by connecting to
geospatial databases created with Google Earth Enterprise Fusion. A Google Earth Enterprise
Fusion database consists of imagery, terrain, and vector data. Unlike some traditional GIS
software, Google Earth EC is easy to use and allows users to view any location on the globe
in seconds without specialized training. Google Earth EC supports common security protocols
for user access control and includes powerful features for experts and non-experts alike,
including:

Simultaneous access to multiple Google Earth Enterprise Servers
Geographic data display in the form of KML
3D buildings with textures
Import of data in common GIS file formats
Movie-making capability
Large-format printing

Google Earth Enterprise Fusion
Google Earth Enterprise Fusion is the integration component of the Google Earth Enterprise
solution and is designed for businesses that want to create their own GIS and imagery data.
With Google Earth Enterprise Fusion, businesses can create a standalone GIS database, as
explained in “Google Earth Enterprise Fusion Products” on page 1-2.

Google Earth Enterprise Server
The Google Earth Enterprise Server is the distribution component of the Google Earth
Enterprise solution. It allows your organization to serve its own data from your own servers
using your standalone database. In addition, you can use the secure server login feature of
the Google Earth Enterprise Server to deliver sensitive data in a secure environment.

Reference Guide
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Google Maps
The Google Maps API enables you to create 2D views of your Google Earth Enterprise Fusion
database in any web page that can be displayed in a browser. The Google Maps API utilizes
Asynchronous JavaScript XML (AJAX) technology to deliver a high performance, easy to use,
interactive user experience similar to Google Maps on the World Wide Web
(http://maps.google.com). The Google Maps API also allows you to integrate additional
datasets as overlays using XML, allowing you to utilize the power of web services to create
mashups inside your own organization.

Combined with the features of Google Earth Enterprise, the Google Maps API allows you to:

View published databases in an easy to navigate AJAX-based application that allows
users to zoom, pan, and search their data without refreshing the entire page.
Turn on and off tile overlay sets created from Google Earth Enterprise Fusion-built
vectors.
Search against city- and street-level geocoders as well as all plug-ins registered as part
of the search framework.

The Google Maps API resides within an HTML page which you control as the
administrator. Google Earth Enterprise Fusion generates a simple web page with
appropriately configured Google Maps API JavaScript code when a user publishes a map
database. From that point forward, the user interface is fully yours to determine. (See
http://www.google.com/apis/maps for complete Google Maps API documentation.)

Google Earth Enterprise Fusion Products

With Google Earth Enterprise Fusion PRO, you can create a standalone GIS database that includes
imagery, terrain, and vector data, and then serve it using the Google Earth Enterprise Server.

Structure of Google Earth Enterprise Fusion Data

When you look at the graphical representation of data in Google Earth EC, it appears to be one
cohesive set of data. In reality, it is a much more complex collection of different types of data that
you build in stages. You use Google Earth Enterprise Fusion to prepare the different types of data to
display smoothly together and to provide the types of information you want to display for your
viewers.

Source data is the most basic information you start with when working in Google Earth Enterprise
Fusion. The source data that you import into Google Earth Enterprise Fusion falls into two broad
categories:

Vector Data (line, polygon, and point data)
Vector data consists of geographic features which are either geographic coordinates (points),
sequences of connected geographic coordinates (lines), or closed sequences of connected
geographic coordinates (polygons). Each feature typically has attribute fields, such as name,
street address, or web site URL.

Google Earth Enterprise Fusion supports common vector and point data file formats. For a
listing of specific formats, see the Supported Source File Formats section of the Defining

http://maps.google.com/


Resources chapter.

Imagery and Terrain Data (raster data)
You can use Google Earth Enterprise Fusion PRO to import your own imagery and terrain
data in order to integrate it with your vector data.

Raster data is a grid of cells covering an area of interest. Each pixel, the smallest unit of
information in the grid, displays a unique attribute. There are two types of raster data in
Google Earth Enterprise Fusion:

Imagery data consists of satellite and overhead photographs.
Terrain data provides topographical information about a geographic area.

In Google Earth EC, the imagery data is draped over the terrain data, giving the imagery
a topographical appearance.

Google Earth Enterprise Fusion PRO supports common imagery and terrain data formats.
For a listing of specific formats, see the Supported Source File Formats section of the
Defining Resources chapter.

After you import source data and begin working with it to create your own GIS data, it becomes part
of three fundamental components of Google Earth Enterprise Fusion:

Resources
Projects
Databases

The relationship among these three components is well defined. Resources comprise projects, and
projects comprise databases. A given resource can be used in more than one project, and a given
project can be used in more than one database.

When you prepare map data, there are four components:

Resources (vector and imagery)
Map Layer (flat projection and mercator maps supported)
Map Projects (map and imagery)
Map Database

You can use the same vector and imagery resources for both Google Earth EC and Google Maps.
However, you have the additional step of creating map layers for Google Maps. (See Preparing Data
for Google Maps for complete details.)

The Google Earth Enterprise Fusion workflow is based on four general steps (with an additional step
if you are creating Google Maps databases): the steps described in the previous section plus a
publishing step. Generally, you perform these steps in the following order:

1. Create and build resources from source data by type (imagery, terrain, or vector).
2. Create and build a map layer (for Google Maps only).
3. Create and build projects from your resources by type (imagery, terrain, vector, or map layers).
4. Create and build a database from your projects.
5. Publish your database.

The following diagram illustrates this process:

Google Earth Enterprise Fusion Workflow



Each step consists of a definition stage and a building stage. You define the asset (that is, specify
the properties of that asset), and then you build the asset. When the building process is complete,
Google Earth Enterprise Fusion stores a new version of the asset in its file system. When you define
projects and databases, you select each asset you want to include. When you publish a database,
you can select the version of the database you want to publish.

As you define your data, you specify:

Which source data comprises each resource
Which resource(s) comprise each project
Which project(s) comprise each database

If you are working with map data, you also specify:

Which resource(s) comprise each map layer
Which map layer(s) comprise each Maps vector project
Which Maps vector project and imagery project comprise each Maps database

You can define and build assets either by using the Google Earth Enterprise Fusion graphical user
interface (GUI) or by entering shell commands on the command line. The main chapters of this guide
provide information about performing these steps using the GUI. For information about the shell
commands, see the Command Line Reference chapter.

You can build each resource as soon as you finish defining it, or you can wait and build several
resources at the same time. You must build a resource, however, before you add it to a project. It is
up to you to determine your own work style based on the type of data you are working with, the
number of changes you are making, and so on.

If you build a resource while you are defining other resources, the build process takes place in the
background. By the time you finish defining the second resource, the build process for the first
resource might be complete. Likewise, if you build all of your projects as you go, by the time you get
ready to build your database, it takes relatively little time. With this work style, building each
resource as soon as you finish defining it saves you time. The disadvantage of this work style is that
building large amounts of data (particularly imagery data) uses much of your system resources, so
working on something else while building large assets could create performance issues for you.

If you wait to build your projects and databases at the same time, the build process takes more time
and CPU cycles. The advantage of this work style, however, is that if you time it right, you can start
a build just before you go to a meeting, lunch, or home for the night, and the build process can have
your workstation all to itself.



Tip: Since builds occur in the background and Google Earth Enterprise Fusion is always running,
you can close the Google Earth Enterprise Fusion GUI after you start a build, if you do not need
to use it for anything else. In fact, this is a good practice, because it frees up RAM and CPU
cycles on the workstation, which can improve build performance.

Best Practices

This section contains general information about best practices to follow as you become familiar with
Google Earth Enterprise Fusion. This information is helpful to know and can sometimes save you
time.

Google Earth Enterprise Fusion employs the concept of an asset root as the root of the directory
tree where all Google Earth Enterprise Fusion assets (resources, projects, and databases) are
stored. You can (and should) create a hierarchy of subfolders within the asset root to organize your
assets, so you and other users can find them easily.

Since Google Earth Enterprise Fusion currently does not allow you to delete or rename subfolders
after they are created, Google strongly recommends that you plan out your subfolder hierarchy and
create all of the subfolders you can anticipate needing before you begin working with your data. You
can always add more subfolders later, but a little preplanning in this area goes a long way.

There are several ways to organize your subfolders. Google recommends the following general
structure:

Note that spaces or other non-alpha characters are not recommended in folder or asset names.

It is unnecessary to further organize your database folder, because you will have only a handful of
databases at most (possibly only one or two). Subdividing your projects by data type is useful, but it
is not necessary to go into any greater detail for projects.

For Resources, however, depending on the type of data you work with, you can further organize your
subfolders by:

Provider (such as USGS, NOAA, and so on)
Region (such as Europe, which includes France, Germany, and so on; North America, which
includes Canada, United States, Mexico)
Type (roads, borders, streams, and so on)

Starting with the basic structure recommended above, your full folder structure might look something
like this:

Databases/
MapLayers/
Projects/
     Imagery
     Terrain
     Vector
Resources/
     Imagery
     Terrain
     Vector

Databases 
MapLayers 
Projects/ 
   Imagery 
   Terrain 
   Vector 
Resources/ 
   Imagery/ 
      NoAmer/ 
         USA/ 
            California 
            NewMexico 
            Texas 
         Canada/ 
            Ontario 
   Terrain/ 
      NoAmer/ 

Organizing Your Google Earth Enterprise Fusion Subfolders



Since Google Earth Enterprise Fusion currently does not allow you to delete or rename assets,
Google recommends that you plan out your databases and projects, as much as possible, before
you begin working with your data.

Most organizations publish only one database for a particular purpose. If you have multiple purposes
(such as commercial property for sale and residential property for sale), you must create a separate
database for each purpose or project.

Note: Google Earth Enterprise Fusion does not allow you to associate multiple projects of the
same type (such as two vector projects) with a database at the same time. You can associate
one vector, one imagery, and one terrain project with each database.

After you define a database (that is, define the projects that comprise that database), that database
definition should not change. You might update the underlying source data and rebuild the
database; however, the association of the projects to the database and the resources to the projects
should not change.

For example, you might define one database that contains the current real estate listings for your
area and another database that contains the current week’s new listings. You can update the source
data for each database as often as you like and then rebuild the databases and publish the new
versions, but you never need to change the projects associated with each database. The main
reason for this convention is so your users can always connect to a particular server (or virtual
server) to get the most up-to-date listings.

Using the example described in the previous paragraph, you can publish each database to a virtual
server:

www.example.com/allcurrent
www.example.com/thisweek

To save time and work efficiently, a good strategy is to create one main project and one evaluation
project. The main project contains all of the resources you want to publish. You keep the evaluation
project small, working only on new or changing layers. Because you are working on a small amount
of data at a time, the evaluation project does not take long to build, so you can iteratively tweak it
and view the results very quickly. When you finish working on a layer in the evaluation project, you
can export that layer and import it into your main project. The next time you build and publish the
database, the new layer is included.

When you acquire the source data that you intend to import into Google Earth Enterprise Fusion, it
is a good idea to store it in /gevol/src1. After you organize the subfolders in that location and copy
your source data into those folders, you must set the file access permissions so that Google Earth
Enterprise Fusion can open the source files. This is because Google Earth Enterprise Fusion has a
special user name and is part of a special group, so you must set your file access permissions to
allow all users and groups to read and execute the source data files.

1. Enter the following command:

         USA/ 
            California 
            NewMexico 
            Texas 
         Canada/ 
            Ontario 
   Vector/ 
      NoAmer/ 
         USA/ 
            California 
            NewMexico 
            Texas 
         Canada/ 
            Ontario

Determining How Many Databases and Projects To Create

Setting File Access Permissions

To set file permissions for your source data:



Each time you add source files to /gevol/src directories, you must ensure that the permissions for
the new files are set correctly by running this command.

Note: If you specify a different volume, substitute your volume name for gevol.

chmod a+r /gevol/src

Back to top
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Before using Google Earth Enterprise Fusion, review the content of this chapter, which explains
concepts and components fundamental to the software.

Launching Fusion
Using the Fusion GUI
Previewing Data
Using the Asset Manager
Using the Asset Editors

Launching Fusion

To launch the Google Earth Enterprise Fusion GUI, open a terminal window, and enter fusion at
the prompt. When the applications starts, the Google Earth Enterprise Fusion GUI appears.

Using the Fusion GUI

Google Earth Enterprise Fusion integrates the Google Earth patent-pending software with your
source data--imagery, terrain, vector, even your own comma-separated (.csv) data. Using the
Google Earth Enterprise Fusion GUI, you can import source data, configure the display of data,
and publish your work to a Google Earth server.

If you prefer, you can perform many of these steps from the command line. For complete
information about how to perform these steps from the command line, see the Command Line
Reference chapter.

The Google Earth Enterprise Fusion GUI provides a multi-paned workspace that allows you to
manage assets and the process of building a publishable database. You can also use the GUI to
view the internal data fields for vector files and additional data that you enter for your assets.

The Google Earth Enterprise Fusion GUI provides three data preview panes:

Reference Guide
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Preview pane: List of data sources and assets that are displayed in the Preview pane
Preview List pane: Preview of vector and imagery data
Attribute Table: The selected data in the displayed vector file in row and column format

You can show or hide the Preview List and Attribute Table panes individually.

You can also dock the Preview List and Attribute Table panes to any side of the main window or
position them on your desktop as independent windows. To move a pane, grab the docking handle
on the top or left side of the pane with your mouse and drag it to its new location.

Use the close boxes (X) at the top of the Preview List or Attribute Tables to hide them. The
remaining panes fill the GUI.

To show the Attribute Table when it is hidden, select View > Attribute Table.
To show the Preview List pane when it is hidden, select View > Preview List.

When each pane is redisplayed, it appears in the same position it was in when it was hidden.

You can customize these panes to suit your preferences and make the best use of available
screen space. If you exit Google Earth Enterprise Fusion and later restart it, the GUI configuration
is the same as it was when you exited.

When working with the Preview pane, it is common to close the Attribute Table to allow more
space for the imagery display. However, when working with vector data, you can set a preference
to automatically display the Attribute Table when vector features are selected. To do so, select
Auto-Show Selected Data in the Attribute Table section of the Preferences dialog.

See Setting Your Preferences in the Setting Up Your Workspace chapter for more information.

The menu bar provides options from six menus. The menus and their options are:

File Menu
Open - Open an asset in the Preview pane. See the Previewing Data section of this
chapter for more information about the Preview pane.
Exit - Close the Google Earth Enterprise Fusion GUI.

Edit Menu
Enable All Layers - Check all check boxes in the Preview List pane.
Disable All Layers - Uncheck all check boxes in the Preview List pane.
Expand All Layers - Show the display rules for all layers listed in the Preview List
pane. When the layers are expanded, you can right-click the name of a display rule for
a layer and select Configure Display Rules to display the Display Rules dialog for that
rule.

See the Configuring Display Rules section of the Defining Projects chapter for more
information.

Collapse All Layers - Hide the display rules for all layers listed in the Preview List
pane.
Preferences - Open the Preferences dialog to set your preferences. These are
described in the Setting Your Preferences section of the chapter on Setting Up Your
Workspace.

Tools Menu
Asset Manager - See the section on Using the Asset Manager in this chapter for
details on managing your assets.

The Menu Bar

Customizing the Preview Panes

Controlling Automatic Display of the Attribute Table



DB Snippet Manager - Manage your preferences to the DBRoot. Many of these
preferences (or snippets) apply to display characteristics, such as showing or hiding the
Google logo in Google Earth EC. Please refer to the Administration Guide for more
information.
Favorites Manager - Manage your list of favorites in Google Earth Enterprise Fusion.
More on Adding and Managing Favorites can be found later in this chapter.
Icon Manager - Create, import, and manage custom icons. See the Managing Icons
section of the Setting Up Your Workspace chapter.
Label Manager - Specify custom labels for layers in vector projects. See Managing
Labels in the Setting Up Your Workspace chapter.
Locale Manager - Set up and manage the locales you intend to support in your
databases. See Managing Locales.
Provider Manager - Set up and manage the list of providers from whom you receive
source data. See Managing Data Providers for more information.
Search Tab Manager - Add and pre-configure the search tabs that you can add to your
databases later. Refer to Managing Search Tabs.
Server Associations Manager - Specify server associations in preparation for
publishing your databases. Refer to the Administration Guide for more information.
System Manager - Track the progress of various processes in the Google Earth
Enterprise Fusion system. Please read the section on Monitoring Current and Recent
Activity in the Building Assets chapter.

Navigation Menu
Add Favorite - Add the current location to your Favorites list, so you can find it again
quickly in Google Earth Enterprise Fusion. See Adding and Managing Favorites.
Reset View - Reset the Preview pane to the default view.

View Menu
Preview List - Display or hide the Preview List pane. See Previewing Data.
Attribute Table - Display or hide the Attribute Table, which lists the attribute data for
the features selected in the Preview pane.
Toggle Textures - Display or hide the imagery in the Preview pane. Use this option
when you have a vector layer that you want to examine without underlying imagery. This
can be helpful when the color of the data does not contrast enough with the underlying
texture, and you want to see the lines more clearly.
Toggle Base Texture - Display or hide the base texture (the default imagery) in the
Preview pane. Use this feature when you have an imagery inset positioned over a base
texture, and you want to see the inset separately from the base texture.
Cycle Mask Textures - Cycle through four ways to view the mask for an imagery inset.

Render the imagery with the transparent portion of the mask showing through to
the base texture. This view is most representative of how the imagery will look in
Google Earth EC (default view).
Render the imagery as red with the transparent portion of the mask showing
through to the base texture. This is a good way to view the cropped coverage of
the imagery with the mask when the original imagery is very close in color to the
background.
Render the imagery as red and the transparent portion of the mask as blue. This is
a good way to visualize the effect of the current feathering setting.
Render the original imagery with no masking. This is good way to look at the
original data to help debug masking problems.

Snap to Level - Lock zooming to integral zoom levels (such as 1, 2, 3, 4, and so on) to
allow you to preview map tiles, which are not scalable in your web browser.

Help Menu
Contents - Display the table of contents for the Google Earth Enterprise Fusion online
help system.
About - Display version and other configuration information about the current installation
of Google Earth Enterprise Fusion.



The toolbar provides quick access to the most common Google Earth Enterprise Fusion actions.
The toolbar buttons and their actions are:

Open File - Open a source file in the Preview pane.Click this icon, navigate to
and select the source you want to view, and click Open. The source appears in
the Preview List pane. See the Supported Source File Formats section of the
Defining Resources chapter for details.

Select - Select a region of the image in the Preview pane. Select the resource
in the preview list pane, and select this icon; then click and drag the mouse to
highlight a region in the Preview pane. The Preview pane highlights everything
you touch in the selected resource (even if you only touch a corner of it) and
displays the data for the highlighted features in the Attribute Table. If you are
previewing multiple resources, you can select a region in each resource, and
then toggle between them to compare their data in the Attribute Table.

Zoom Box - Outline the zoom area of the imagery displayed in the Preview
pane to select precisely the region you want to view. Select (highlight) an item in
the Preview List pane, select this icon, and then click and drag a rectangle
around the region you want to view. The contents of the selected region
replaces the previous view. Press Ctrl+r to return to the default view.

Zoom Drag - Zoom in or out on the Preview pane.Select this icon and then:
Hold down the left mouse button and push the mouse away from you to
zoom out.
Hold down the left mouse button and pull the mouse toward you to zoom
in.

Press Ctrl+r to return to the default view.

Pan - Move the imagery around in the Preview pane.Select this icon and then
click and drag the view to pan in any direction. Press Ctrl+r to return to the
default view.

Toggle Tile Grid - Toggle between showing and hiding the tile grid.Select this
icon to turn on the grid; unselect it to turn it off.

Display Level - The current display level; also referred to as LOD - level of
detail. The general display level for:

the world is about 2.5.
a continent is about 4.5.
a country the size of the United States is about 5.
a city is about 10.

Display Level Offset - Set the value added to or subtracted from the display
level set in the data to a whole number between -5 and +5. See Adjusting
Vector Data Display Levels for details.

Select the value and enter a new one, or use the up and down arrow keys to
change the value. Press Ctrl+r to return to the default view.

Favorites Menu - Quickly return to a saved location. See
the next section, Adding and Managing Favorites for
details.

The Toolbar



Preview Projection - choose between preview of
Mercator and Flat projections

In addition, you can:

Click the middle button (or wheel) on your mouse and drag the view to pan in any direction.
Scroll the wheel on your mouse to zoom in and out.

After you find a favorite location, you can add it to the Favorites menu, so you can find that location
again quickly.

1. Navigate to the desired location in the Preview pane.
2. Select Navigate > Add Favorite. The New Favorite dialog appears.
3. Enter a name for the favorite that will help you recognize it later, and click OK. Google Earth

Enterprise Fusion adds the new favorite name to the Favorites drop-down list.

Note: The Favorites menu in Google Earth Enterprise Fusion is unrelated to placemarks
in Google Earth EC.

After you add some locations to the Favorites menu, you can use the Favorites Manager to
rename, remove, or reorder the list.

1. Select Tools > Favorites Manager. The Favorites Manager displays all of your favorites in
the order in which you added them.

2. Use the Favorites Manager to perform any of the following tasks:

Create a new favorite: Click . The Edit Favorite dialog appears. Enter the data for
a favorite and click OK. (Unless you know the exact latitude and longitude of a location,
it is often easier to find the location in the Preview pane and then select Add Favorite
from the Navigation menu to create a new favorite.)

Change the name or position of an existing favorite: Double-click the name of a
favorite. The Edit Favorite dialog appears. Change the name or the latitude, longitude,
or display level of the favorite.

Adding and Managing Favorites

To add a favorite:

To manage your favorites:



Delete a favorite: Select a favorite and click .

Change the favorite order: Select a favorite and click  or  to move it up or
down.

Previewing Data

You can use the preview panes to inspect imagery, vector, or terrain data in either source data or
resource form. You can also open different types of data files at the same time using the preview
panes. For example, you might preview an imagery resource along with vector source data to
confirm that the vector data aligns properly with the imagery data. Previewing data is a great
“litmus test” of how the data will look in Google Earth EC.

Note: Although you can preview source files anytime, you must build resources before you can
preview them.

Some applications for the preview panes are:

Determine the correct encoding to use for vector source data before converting the source to
a resource.
Determine which layers of a multi-layer vector source file to use in a resource.
Test simple display rule settings before defining a vector resource in a project.
Determine whether the Auto Mask feature sets the mask properties for an imagery resource
appropriately before using it in a project.
Inspect transitions between adjacent source imagery files.

Although certain limitations apply to viewing your original raw data source files in the preview
panes, you have full access to all of the preview functionality when you preview built resources. If
you preview raw imagery source files, only a bounding box appears in the Preview pane. If you
preview built imagery resources, the actual imagery appears in the Preview pane. The following
limitations apply to previewing data:

The following display rule settings are ignored:
Simplification method
Suppress duplicates
Elevation/height
Highlight style
Road label
Road shield

Lines and polygons are drawn as lines only (not filled), so use Line Color or Outline Color, if
you want to see the colors of lines or polygons in the Preview pane.
Labels appear in the assigned color, but scaling and centering are ignored for labels.
Icons do appear in the Preview pane, but any style settings (color, scale) are ignored.
Icons are not selectable, and their pop-up text is not displayed.

1. Click . The Open dialog appears.

To preview a source file:



2. Navigate to the location that contains the desired file.

You can set the File type selector to display only files of a particular format, such as ESRI
Shape files, or you can display all files in each folder.

3. Select the file to preview.
4. Select the appropriate encoding type for the selected data, if you know it (optional).

Notes: Encoding applies only to vector data. For example, the geonames-
cities500000.csv vector source file provided with your Google Earth Enterprise Fusion
tutorial installation uses UTF-8 character encoding. To see the data from specially-
encoded files such as this, specify the correct encoding. 

If you do not specify the correct encoding type for such files, special characters might not
display properly. For example, with default character encoding specified, é appears as .

5. Click Open. The file appears as a layer in the Preview List pane with its check box
unchecked by default.

6. Select the check box next to a layer in the Preview List pane.

This action displays the data in the Preview pane; however, you might not see it, if your
current display level is too high or too low.

7. Right-click the layer, and select Zoom to Layer from the context menu.



This action resets the view to encompass the entire area of the data layer.

Note: If the data in the layer extends off of one side of the picture of the Earth and onto
the other side, sometimes using the Zoom to Layer feature does not look like it zoomed in
at all. That is because the preview must include both sides of the picture of the Earth.

1. Select Tools > Asset Manager. The Asset Manager appears.
2. Navigate to the folder that contains the resource you want to preview.
3. Drag and drop the resource onto the Preview List pane.

Note: You must build resources before you can preview them.

After you open a layer in the Preview List pane, you can right-click its name, and select any of the
following options from the context menu:

Zoom to Layer
Allows you to reset the Preview pane to the entire selected layer. For example, if the Preview
pane is displaying a portion of the layer, selecting Zoom to Layer causes the Preview pane
to zoom out to display the entire layer. Likewise, if the Preview pane is displaying an area
larger than the data in the selected layer, selecting Zoom to Layer causes the Preview pane
to zoom in to display the area covered in the selected layer.

Configure Display Rules
Allows you to specify the display properties for vector source data and resources. See
Configuring Display Rules in the Defining Projects chapter for details.

Note: This option applies to vector source data and resources only, since the display
rules for imagery or terrain data are set when you import the source data as a resource.
Although you can actually set display rules for imagery and terrain source data, the
preview of that data appears as an outline. Any display rule configurations applied to
imagery or terrain data in the Preview pane affect only the outline of the image. See the
next section, Previewing Imagery and Terrain Source Data for more information.

Import / Export Configuration as Template
Allows you to save display rules as template files and reapply them to other layers. See the
sections on Exporting Display Rules and Importing Display Rules in the Defining Projects
chapter for more information.

Remove Layer / Remove All Layers
Allows you to remove individual layers or all layers from the preview panes.

Using Preview Options

To preview a resource:



Note: Removing layers from the preview panes does not delete the data source files or
the resource. It simply removes them from the preview.

When you preview terrain or imagery source data, you view only the boundaries of the data, not
the imagery itself, in the Preview pane. In order to see the full imagery or terrain data in the
Preview pane, you must create a resource from the source data and build the resource.

Note: Google Earth Enterprise supports preview of both Mercator and Flat Projection imagery.
When previewing imported imagery resources, make sure the desired Preview Projection is
selected in the toolbar.

When you open imagery or terrain source data in the Preview pane, Google Earth Enterprise
Fusion draws a bounding box for the imagery. The bounding box is the outermost region of the
image data.

When you open imagery or terrain resources in the Preview pane, the full imagery is displayed
within the bounding box.

Previewing Imagery and Terrain Source Data

Viewing Imagery Tiles



You can use the tile grid toggle button  to turn on the tile grid, so you can examine the tiling of
imagery data, as well as the resolution levels and geospatial boundaries of imagery insets.

Although it is easy to visually determine at which display level a vector resource appears or
changes, it is not always apparent with imagery insets. When you click the tile grid toggle button, a
grid in a contrasting color overlays the current view. As you zoom in or out of this view and move
through various levels, the grid updates its size and changes color to provide information about the
imagery.

Google Earth Enterprise Fusion provides 24 display levels. When you turn on the grid, at level 0,
there is only one tile, or grid square (256 pixels x 256 pixels) for the entire Earth. The number of
tiles displayed quadruples at each display level.

When you use the Zoom to Layer feature, all of the grid squares are the same color. This is the
lowest display level number (the highest elevation) at which you can view the full extents of the
inset. In the following examples, consider Zoom To Layer the starting point.

If you zoom out from the starting point, the grid squares change color, indicating areas of different
resolution in the imagery. In the following example, the blue grid squares indicate high-resolution
imagery, and the pink squares indicate lower-resolution imagery.

Note: The blue grid squares do not indicate the boundaries of the high-resolution imagery. Any
grid square that touches any part of the high-resolution imagery appears in blue. The bounding
box indicates the actual boundaries of the high-resolution imagery.

If you zoom in from the starting point, the grid squares are all the same color, are larger, and there
are fewer of them in the Preview pane until you get to the next level. Then they appear smaller and
are more numerous again.

How many imagery tiles are present at a particular display level?



Note: All references to the grid refer to the semi-transparent lines, not the thin solid lines that
designate the borders of the grid squares.

You can use the texture viewing features on the View menu to control the display of imagery and
terrain data when you want to debug data in the Preview pane. Using these features, you can:

Toggle Textures
Turn off all textures in the Preview pane.

Toggle Base Texture
Turn on or off only the base texture in the Preview pane.

Cycle Mask Textures
Cycle through four ways to view the mask for an imagery inset.

(See The Menu Bar for more information about these features.)

You can preview vector source data and resources to explore preliminary display settings,
properties, and groupings for resources you are considering using in a project. Keep in mind that
you cannot save the display settings you create in the Preview pane, so it is recommended that

Previewing Vector Data

Showing and Hiding Imagery



you set only the most basic display rules in Preview pane.

Tip: If you create display rules for vector data in the Preview pane, you can select Export
Configuration as Template from the context menu to save and re-use those settings for an
actual layer in a project. See Exporting Display Rules in the Defining Projects chapter.

You can view the internal data fields of vector resources that you can see in the Preview pane.
After you select vector fields for display, you can manipulate the display of that view and see even
more detailed information about specific entries.

1. Select the layer whose data you want to view.

2. Select , if it is not already selected.
3. Drag a region box around some of the data features you want to view.

The internal data for each selected element appears as a row in the Attribute Table.

While using the interactive zoom features, you might notice that vector features appear and
disappear, depending on your viewing elevation. When this happens, note the number that appears

To select and view vector data fields:

Adjusting Vector Data Display Levels



in the Display Level indicator, which increases as the view gets closer to the Earth.

The value shown in the Display Level indicator corresponds to your viewing elevation in the
Preview pane. Data that you import into projects can be configured to appear at a specific level--a
number that you provide in the display rules for vector data. (See Configuring Display Rules in the
Defining Projects chapter for details.)

You can use the Display Level indicator as an analysis tool to determine the appropriate display
levels for resources. By setting the correct display level for vector data, you can prevent
informational clutter in Google Earth EC.

To the right of the Display Level indicator is the Display Level Offset. You can adjust this selection
to whole number values between -5 and +5. Google Earth Enterprise Fusion adds or subtracts the
value in this window to the display level set in the data. You can use this feature to quickly adjust
the level at which vector features are displayed in the Preview pane without having to reset the
value in the display rule. When you find the optimal display level, you can reset the value in the
project’s display rule.

For example, if you define a feature to be drawn at level 10, it does not appear in the Preview
pane at level 9.2. However, if you set the Display Level Offset to 1, you can see the feature at level
9.2. Google Earth Enterprise Fusion adds 1 (the offset) to 9.2 (your current display level) to adjust
your viewing elevation to 10.2.

The following illustration shows two examples of how you can adjust viewing elevation to display
the data at a higher or lower elevation perspective.

When vector data is displayed in the Attribute Table, Google Earth Enterprise Fusion provides
several options on a context menu to help you work with that data. To access the options, right-
click the data in a cell in the Attribute Table, and select one of the following options from the
context menu (where Column is the name of the selected column):

Sort by Column Ascending
Reorders all data in the Attribute Table in ascending order based on the selected column.
For example, for a numeric column, it reorders the data in that column from the smallest to
the largest number. For a text column, it reorders the data in that column from A to Z.

Sort by Column Descending
Reorders all data in the Attribute Table in descending order based on the selected column.
For example, for a numeric column, it reorders the data in that column from the largest to the
smallest number. For a text column, it reorders the data in that column from Z to A.

Export Column Column

Manipulating Data in the Attribute Table



Exports the values of the entire column to a comma-separated value (CSV) text file using
this option.

Export All Columns
Exports all of the data in the Attribute Table to a CSV text file.

Feature Details
Displays detailed information about the selected feature in the Feature Detail dialog,
including all of the column attributes of the selected row, the number of vertices making up
the vector feature, and the latitude and longitude of each vertex or part.

Zoom to Feature
Zooms to the selected feature.

Copy Cell Contents
Copies the contents of the cell to the window manager’s clipboard. Then you can paste the
contents of the cell into Google Earth Enterprise Fusion or another application.

Tip: For example, when you are filtering data with international characters, and you do not
know how to enter those characters from your English keyboard, you can use this option
to copy the string from the actual data and paste it into the filter expression.

Using the Asset Manager

The Asset Manager is the main tool you use in Google Earth Enterprise Fusion. You use it to
import and build all of your assets in preparation for publishing your Google Earth and Google
Maps databases, so it is important for you to become very familiar with it.

Caution: If you are working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, whoever saves an object last overwrites any previous versions of that object. So if you are
working in a multi-user environment, be sure to coordinate with the other users to be sure you
do not clobber each other’s work.

If it is likely that several people will be working in the Asset Manager at the same time, it is
particularly important to ensure that no two users are working on the same asset at the same time.



To access the Asset Manager, select Asset Manager from the Tools menu.

The title bar of the Asset Manager identifies the name of the host on which you started the Google
Earth Enterprise Fusion GUI.

The Asset Manager’s menu bar provides two menus with the following options:

File
New Asset - Displays the New Asset dialog (See the chapter on Defining Resources for
more information about the New Asset dialog.

Window
Close All - Closes all open asset editors
Cascade - Rearranges all open asset editors in a cascading pattern

Below the File and Window menus, a selection box provides access to three groups of toolbar
buttons. The available selections are:

Earth Tools (3D): for Google Earth databases
Mercator Map Tools (2D): for Mercator Projection Maps databases
Flat Projection Map Tools (2D): for Flat Projection Maps databases

The Asset Manager’s toolbar provides the following icons so you can create new resources,
projects, and databases. You will see only a subset of these icons at any time, depending on your
Tools selection above.

 Vector Resource  Vector Project

 Imagery Resource  Imagery Project

 Mercator Imagery
Resource

 Mercator Imagery
Project

 Terrain Resource  Terrain Project

 Map Layer  Map Project



 Database  Map Database

 Mercator Map
Database

 

Click the icon for the type of asset you want to create. The appropriate type of new asset window
appears. Refer to the appropriate chapter of this Reference Guide for information on adding
specific types of assets.

Note: Mercator imagery resources are different than Flat Projection imagery resources. If you
wish to use the same imagery for both an Earth database and a Mercator Maps database, you
must import and store two copies of the imagery resources. Using google.com map base layers
requires a Mercator Map database.

You can, however, share imagery resources between an Earth database and a Flat Projection
Maps database.

The Location field at the top of the Asset Manager window displays the asset root. The asset root
is the main location where you store all of your Google Earth Enterprise Fusion data. Depending
on how you set your preferences, the location displays as either ASSET_ROOT or as the full path to
the asset root (such as /gevol/assets/).

See Setting Your Preferences in the chapter on Setting Up Your Workspace for more information
about setting this preference.

Note: You cannot edit the Location field.

The asset navigation tree appears on the left side of the Asset Manager. When you first start using
Google Earth Enterprise Fusion, only the asset root appears. As you add subfolders to the asset
root, they appear hierarchically in the asset navigation tree. (See Organizing Assets for more
information.) All of the data you create with Google Earth Enterprise Fusion is stored in subfolders
of the asset root.

As you navigate through the folders in the asset navigation tree, the Location field displays the
full path of the selected folder.

The right side of the window contains two tabs:

List
Thumbnail

The contents of these tabs are described in the following sections.

The List tab displays the list of assets in the folder that is selected in the navigation tree on the
left.

List Tab



You can double-click the name of any asset on the list to display its properties in an editor, so you
can modify the asset. You can double-click an asset’s current version or current state to display
the Version Properties dialog for that asset. (See Debugging Asset Builds in the Building Assets
chapter for more information about this dialog.)

You can click the Refresh button to the right of the Location field at any time to refresh the status
of the assets displayed on the List tab.

Above the asset list are two filters:

Type - If you select Vector, Imagery, Terrain, or Map from the Type drop-down list, only
the selected type of assets appear on the list. If you select All, all of the assets in the
selected folder appear on the list.
Category - If you select Resource, Layer, Project, or Database from the Category drop-
down list, only the selected category of assets appear on the list. If you select All, all of the
assets in the selected folder appear on the list.

In addition, you can display hidden assets by checking the box next to Show hidden assets.
Hidden assets are those assets that you do not need to display regularly, such as assets that are
incorrectly named. See Using the Asset Editors for information on how to designate assets as
hidden.)

The Thumbnail tab displays a thumbnail image of each asset in the folder that is selected in the
navigation tree on the left.

Note: The Thumbnail tab is useful for raster (imagery and terrain) data only.

In addition to the Type and Category filters and the Show hidden assets check box, which are
available for this tab as well, this tab provides a zoom bar. You can drag the zoom bar down to
enlarge the thumbnail images.

Thumbnail Tab



To close the Asset Manager, click the close box (X) in the top corner.

Using the Asset Editors

You use the asset editors (such as the Resource Editor, the Project Editor, and the Database
Editor) to define and build your assets. When you finish using any of the asset editors (such as the
Imagery Resource Editor used in this exercise), you can either leave it open and move it to the
side or close it. Generally, if you know you have more work to do on a given asset, you leave the
editor open. If you know you are done with an asset for now, you can close it and get it out of the
way.

Caution: It is important to remember that you cannot delete assets after you save them. You
can clean them, so they are no longer available to use in Google Earth Enterprise Fusion;
however, you can never really eliminate them. See Cleaning Asset Versions in the Building
Assets chapter for more information.

All of the asset editors provide menu options that allow you to perform specific tasks on the assets
you are editing.

The menu options are:

File:

Save - Saves the asset. The first time you save an asset, you can specify its name and
location. After that, Google Earth Enterprise Fusion saves the asset with the same name and
location.
Save As - Saves a copy of the asset with a new name and location that you specify.
Build - Builds the asset. If you have made changes to the asset that are not saved, Google
Earth Enterprise Fusion prompts you to save it before it builds it.
Close - Closes the asset editor. If you have made changes to the asset, a message prompts
you to save it.

Edit:
Notes - Displays a dialog that allows you to enter notes about the asset. Simply enter the
text of your note. To insert the current date and time, click Insert Timestamp.

When you finish composing your note, click OK.

Note: The notes appear in Google Earth Enterprise Fusion only.

Hidden - Toggles the Hidden setting on and off for the asset.

You can check this option to hide assets that you do not need to display regularly, such as
assets that are incorrectly named. Check it again to allow the asset to show.



Note: You can display hidden assets by checking the box next to Show hidden assets on
the List Tab in the Asset Manager. See the List Tab section for more information.

Back to top
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Overview

Before you begin importing your source data, it is important to:

Set your preferences.
Set up the subfolders in which you will store your Google Earth Enterprise Fusion data.
Pre-configure various list options that you need to select later.

If you want to add more subfolders or list options later, you can do so at any time. However, it is
more efficient for one person to configure them in advance, resulting in more consistent data in
Google Earth EC.

Note: Preference settings are stored for each user. Subfolders and list options are shared by all
users of a Google Earth Enterprise Fusion on a particular workstation.

Setting Your Preferences

Google Earth Enterprise Fusion allows you to set certain preferences to customize the GUI to your
own needs. When you make changes to your preferences, those changes do not affect other
users.

1. Select Preferences from the Edit menu.
2. Specify your preferences on the General and Asset Manager tabs, as described in the

following sections.
3. Click OK.

Reference Guide

Setting Up Your Workspace

General Tab

To set preferences for Google Earth Enterprise Fusion:
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On the General tab, you can set the following preferences:

Background Imagery
Google Earth Enterprise Fusion is initially configured to refer to the NASA Blue Marble
imagery as the default background imagery of the Earth. If you have higher-resolution
imagery that you prefer to use as your default background imagery, select an option from the
drop-down list (a Google Earth Enterprise Fusion imagery project). If you select Stream
Server (HTTP), enter the URL of the desired database.

Note: You cannot add a stream server that requires authentication, including
kh.google.com.

Background Imagery for Mercator Projection Preview
If you want to use the Mercator imagery, you can select either the raster or a Mercator
imagery project. If you choose a Mercator mimagery project, enter the location of the desired
database.

Internationalization
If most of your vector data has a particular character encoding, you can specify that as the
default character encoding to avoid having to set the encoding every time. For example, if
the majority of your vector data fields have character encoding of type ISO8859-1, select
ISO8859-1 from the drop-down list. The default character encoding for vector files is ASCII
(plain text) (<none> on the drop-down list).

Note: Google Earth Enterprise Fusion supports bi-directional character encoding.
However, right-to-left character encoding and multi-byte character sets are not supported
in map layers.

Attribute Table
The settings in the Attribute Table section affect the behavior of the Attribute Table.

Show Feature ID - Select this option to display the feature IDs for the selected data in
the first column of the Attribute Table. Uncheck it if you do not want to display the ID
column.

The feature ID is an internal, unique ID applied to all vector data converted to Google
Earth Enterprise Fusion resource format. The IDs are assigned sequentially in the order
the features are imported.

Auto-Show Selected Data - Select this option to automatically display the Attribute
Table when vector features are selected in the Preview List pane.

Selection Tool
You can specify your preference for the outline color, outline width, and fill color of the
selection tool. Generally, you set these options based on the overall coloring of your imagery



data to make sure the selection tool is visible.

Outline Color - Click the button next to Color, and select a color. See Draw Style in
the Defining Projects chapter for more information.
Outline Width - The default outline width is 1. To change the outline width, enter the
desired value. The larger the number, the thicker the outline.
Fill Color - Click the button next to Color, and select a color. See Draw Style in the
Defining Projects chapter for more information.

On the Asset Manager tab, you can set the following preferences:

Show Full Asset Root Path
If you prefer to view the full path name of the Google Earth Enterprise Fusion asset root
(such as /gevol/assets/) in the Location field of the Asset Manager, check this option. If
you do not check this option, the Location field at the top of the Asset Manager shows the
path starting with ASSET_ROOT/.

Resource Editor Default Paths
You can specify the default path for each type of source data (vector, imagery, and terrain),
if desired. Whenever you add a source file to a resource, the Open dialog opens to the
specified folder. If you do not specify a default path here, the Open dialog opens to the
folder from which you launched Google Earth Enterprise Fusion.

Note: Initially, these paths are set to the appropriate paths for the Google Earth Enterprise
Fusion Tutorial, if you installed the tutorial files. You do not need to change these paths
until you start working with your own data. Then change each path to the top-most
directory where each type of data is stored.

1. Click  next to Vector. The Select Folder dialog appears.
2. Navigate to the folder you want to set as the default folder to open for vector source files,

and click OK.
3. Repeat for Imagery and Terrain. The specified paths appear next to each type of source file.

Asset Manager Tab

To specify the default paths:



4. Click OK.

Organizing Assets

When you have a plan in place for your folder structure and naming conventions, you can start
adding subfolders to the asset root. See Organizing Your Google Earth Enterprise Fusion
Subfolders in the Introduction chapter for details about planning and organizing your subfolders.

Caution: Folders and subfolders can not be deleted after they've been created in your asset
root. This makes it especially important for you to plan out and organize your subfolders before
you or anyone else begins working with data in Google Earth Enterprise Fusion.

1. Right-click the folder in which you want to add the new subfolder (in this case,
ASSET_ROOT), and select New Subfolder from the context menu.

A dialog prompts you to enter the name of the folder.

2. Enter a unique name that helps identify the contents of the folder, and click OK.

Tip: Consider using subfolder names that correspond to the type of resource that you are
creating. For instance, you might first create a subfolder named vector to indicate the type
of source data. Under the vector folder, you could create additional subfolders to further
distinguish the source by provider, if desired, or by some other category. See Organizing
Your Google Earth Enterprise Fusion Subfolders in the Introduction chapter for more
information.

The new subfolder appears in the asset navigation tree.

3. Repeat the previous steps to add more subfolders.
4. When you're finished, click OK.

Managing Locales

Note: If you do not intend to translate your layer names or supply different data for different
languages, you can skip this section. You do not need to create a locale in the Locale Manager
for your primary locale.

The Locale Manager allows you to set up language support for your users’ locales. If you specify
locales here, you can enter layer names in multiple languages. Google Earth EC and Google Maps
use the locale setting of the computer to select which language-specific content to display. If you
do not specify any locales, all labels in Google Earth EC and Google Maps appear in your native
language.

To add a subfolder:



Caution: If you are working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, when one user closes the manager, that user’s changes overwrite all previous data for
that manager. So if you are working in a multi-user environment, be sure to coordinate with the
other users to be sure that only one user has this manager open at a time.

After you add all of the locales you want to support using the Locale Manager, you can select the
locales you want to support for each layer in your project using the Layer Properties dialog. See
Configuring Layer Properties in the Defining Projects chapter for more information.

1. Select Tools > Locale Manager. The Locale Manager appears.

2. Click . The Support New Locale dialog appears.

3. Enter the name of the new locale using standard ISO locale language abbreviations (such as
fr, de, it, or fr_CA). If you need to distinguish among regions, you can use regional
designations as well (such as fr_FR, fr_CA, en_UK, and so on).

4. Click OK. The locale appears in the Locale Manager.

5. Repeat steps 2 through 4 for each new locale.
6. Click OK when you've finished adding locales.

Managing Labels

Note: The Label panel has been removed from the Google Earth Enterprise Client as of version
5.0. The Label Manager feature of Google Earth Enterprise Fusion is no longer applicable, and
will be removed in a future version.

Managing Data Providers

The Provider Manager allows you to create a list of organizations that provide the data you use in

To create a new locale:



Google Earth. For each provider, you specify a lookup key (any unique abbreviation you choose)
and copyright information. When you create a resource, you associate a data provider with it, so
that when the resource is displayed in Google Earth EC, it displays the appropriate copyright
information.

Caution: If you are working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, when one user closes the manager, that user’s changes overwrite all previous data for
that manager. So if you are working in a multi-user environment, be sure to coordinate with the
other users to be sure that only one user has this manager open at a time.

1. Select Tools > Provider Manager. The Provider Manager window appears.

2. Click  to open the Edit Provider dialog.
3. Enter the following information:

Name: Full name of the resource provider.
Key: An abbreviation of your choice that is unique to this provider.
Copyright Text: This string appears at the bottom of the viewer in Google Earth EC
when the corresponding imagery, map, road, or terrain data is displayed. Enter any free-
form text string, including white spaces.

4. Click OK. The new provider appears at the end of the list of providers.

5. Repeat steps 2 through 4 to add more providers.
6. When you finish adding providers, click OK.

1. Double-click the name of the provider you want to change.
2. Modify the information as desired, and click OK. The updated information appears in the

Provider Manager.

Note 1: Changing the copyright text for a provider does not force a rebuild of the affected
resources. The old copyright text will be displayed until the resources are rebuilt.

Note 2: If you change a provider’s key, the copyright information associated with that provider can
no longer be displayed for associated resources in Google Earth EC.

To create a provider:

To modify a provider:

To delete a provider:



1. Select the provider to delete, and click . You are prompted to confirm the deletion.
2. Click OK to permanently delete the provider.

Caution: If you delete a provider, the copyright information associated with that provider can no
longer be displayed for associated resources in Google Earth EC.

Managing Icons

In addition to the standard icons that are supplied with your installation of Google Earth Enterprise
Fusion, you can create, import, and manage your own collection of icons that you can apply to
vector data. See Creating Custom Icons in the chapter on Creating Your Own Source Data,
Icons, and Masks for details.

Caution: If you are working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, when one user closes the manager, that user’s changes overwrite all previous data for
that manager. So if you are working in a multi-user environment, be sure to coordinate with the
other users to be sure that only one user has this manager open at a time.

1. Select Tools > Icon Manager. The Icon Manager appears.

Note: The Icon Manager is empty if you have not yet imported any custom icons. The
standard icons provided with Google Earth Enterprise Fusion do not appear in this dialog.
You cannot add to or delete from the standard collection.

2. Click .
3. Select the desired image file and click Open. The new icon appears in the Icon Manager.
4. Repeat these steps to add more icons.
5. When finished, click OK.

After you add an icon to your collection, you can use it as a road shield or other marker for vector
data, as described in Road Labels and Shields in the Defining Projects chapter.

1. Select the icon to delete and click . A message prompts you to confirm the deletion.
2. Click OK. The icon no longer appears in the Icon Manager.

Note: If you delete an icon from the Icon Manager, it does not force you to rebuild projects that
reference that icon. If that icon was previously referenced in a project that has already been
built, when you publish a database that includes that project, the old icon appears. If something
else in that project subsequently triggers a build, the new icon will appear in the resulting
version. 

If you delete an icon from the Icon Manager that is referenced in a saved but unbuilt project,
that project’s build fails. If the Project Editor is open when you delete the icon from the Icon
Manager, when you close and then reopen the project editor and look at the Display Rules
dialog for the affected layer, a large red box appears instead of the deleted icon. 

To add a custom icon:

To delete a custom icon:



 

If you see this red box, you must select a different icon for the affected layer. 

If the deleted icon is referenced in a template (that is, you referenced it, saved the template,
and then deleted the icon from the Icon Manager), the next time you import that template and
try to build the project, the build fails. As in the first case, the next time you open the project
and look at the Display Rules dialog for the affected layer, a large red box appears instead of
the deleted icon, and you must select a different icon for the affected layer. In addition, it would
be a good idea to save a new version of that template that includes an icon in the Icon
Manager.

Managing Search Tabs

Search tabs allow Google Earth EC or Google Maps users to:

Replace the standard search tabs in Google Earth EC.
Search Google Earth EC or Google Maps databases created with Google Earth Enterprise
Fusion.
Access other databases not related to Google Earth Enterprise Fusion (such as geocoders,
Google Search appliance, and so on).
Access external search servers (such as a real estate search).

For example, if you have a database of property locations that contains specific information that
your users need, you can create a search tab called “Property Search” and configure it to search
for locations in your property database, even if that database is stored on another server.

The Search Tab Manager allows you to pre-configure the search tabs to be used for any database
you create with Google Earth Enterprise Fusion. You define all of the search tabs you need using
the Search Tab Manager, and then you can select up to three of those search tabs for a specific
database using the Database Editor. See Adding Search Tabs to a Database in the Defining and
Publishing Databases chapter for details.

Caution: If you are working with multiple Google Earth Enterprise Fusion users on multiple
workstations, it is important to remember that all managers on the Tools menu can be accessed
by all users at the same time. If multiple users are working with the same manager at the same
time, when one user closes the manager, that user’s changes overwrite all previous data for
that manager. So if you are working in a multi-user environment, be sure to coordinate with the
other users to be sure that only one user has this manager open at a time.

1. Select Tools > Search Tab Manager. The Search Tab Manager window appears.

To define a new search tab:



2. Click  to open the New Search Tab window.
3. Enter a unique name for the search tab, and click OK. The search tab name appears on the

list on the left and is selected.
4. Enter Label and Key values for each field you want to display on the search tab. You can

enter Label and Key values for one or two fields.

Basic HTML tags are supported in the Label text. See the HTML Tags Allowed chapter for
details.

The Label value appears above the search field in Google Earth EC. In the example below,
the Label value is:

What <font color="#999999>e.g., Computer repair</font>.

The Key value is the name of a search key in your search application. The value the user
enters in the corresponding field in Google Earth EC is paired with the key in the search
expression that Google Earth EC passes back to your search server in its query URL. For
example, in the screen shown above, the key for the first field might be what, and the key for
the second field might be where. You must know, however, the exact names of the search
keys in your search application.

5. Select URL or Plug-in Name from the drop-down list.
Select URL if you want to specify the URL of the non-Google server. Enter the URL in
the text field.
Select Plug-in Name if you want to reference a plug-in for the search tab. Enter the
name of the plug-in. The following plug-ins are installed with Google Earth Enterprise
Fusion and are located in the /opt/google/search/tabs directory:

Coordinates.gestd

Example_Plugin.gestd

GeocodingFederated.gestd

GSA_Plugin.gestd

Places.gestd

After you create the search tab, you need to make sure the plug-in is registered. Use
the following command to see the registered plug-ins:

See the Search Framework Developer’s Guide for more information about creating
your own plug-ins for search tabs. To get you started, Google provides eight sample
plug-ins that are ready to use in the Sample Plug-ins chapter.

geserveradmin --listplugins



To register a plug-in that is not regisitered by default, issue the following command:

You can specify the plug-ins the GeocodingFederated plug-in uses in the
GeocodingFederatedPlugin.properties file:

You can add the plug-in names in the comma separated list for plugins. The plug-in
must be registered or GeocodingFederatedPlugin will fail to initialize. If you want to add
MyPlugin to the GeocodingFederatedPlugin, for example:

To unregister GeocodingFederatedPlugin:

6. If you want to add query parameters that are hidden from Google Earth EC, such as the way
the results will be sorted or the number of results displayed at a time, enter them in the
Additional Query Parameters field.

The syntax is key1=value1&key2=value2. For example, sortby=name&numresults=10 sorts
by the name field and displays 10 results at a time. Your search application must be able to
understand and respond to these key/value pairs, so you must be very familiar with your
search application to use this field.

Caution: Any web service, servlet, or web application you configure the search tabs to
query must return valid KML to Google Earth EC. For Google Maps, it must return valid
JavaScript in the specified structure.

7. If you are licensed to use Google-hosted services, you can enter additional configuration
parameters in the Additional Configuration Parameters field. For more information, refer to
the Google Earth Enterprise support web site. Log in at https://support.google.com then point
your browser to https://support.google.com/enterprise/Earth.

8. Repeat steps 2 through 7 to add all of the search tabs that you and other Google Earth
Enterprise Fusion users plan to use in your databases.

As you add each search tab, it appears on the list. You can view or modify the properties for
any search tab by selecting (highlighting) it on the list.

Note: The number of search tabs you add in the Search Tab Manager is unlimited.
However, you cannot add more than three search tabs to any particular database.

9. When you finish configuring search tabs, click OK. The search tabs are ready for you to add

/opt/google/geserveradmin --addplugin Plugin_name --jar_path
/opt/google/search/plugins/Plugin_name.jar
  --class com.google.earth.search.plugin.Plugin_name

plugins=GEPlacesPlugin,CoordinatePlugin

plugins=GEPlacesPlugin,CoordinatePlugin,MyPlugin

/opt/google/bin/geserveradmin --deleteplugin GeocodingFederatedPlugin
                      
/opt/google/bin/geserveradmin --addplugin MyPlugin
  --jar_path /opt/google/search/plugins /MyPlugin.jar
  --class com.google.earth.search.plugin.MyPlugin
                      
/opt/google/bin/geserveradmin
  --addplugin GeocodingFederatedPlugin
  --jar_path /opt/google/search/plugins /GeocodingFederatedPlugin.jar
  --class com.google.earth.search.plugin.GeocodingFederatedPlugin

https://support.google.com/
https://support.google.com/enterprise/Earth


to your databases. See Adding Search Tabs to a Database in the Defining and Publishing
Databases chapter.

1. Select Tools > Search Tab Manager. The Search Tab Manager appears.

2. Click . The Import Search Tab Definition dialog appears with Google Earth Search
Tab Definition selected as the file type.

3. Navigate to and select the desired search tab definition file, and click Open. The imported
search tab appears in the Search Tab Manager.

4. Click OK to close the Search Tab Manager.

1. Select Tools > Search Tab Manager. The Search Tab Manager appears.

2. Select the desired search tab, and click . The Export Search Tab Definition dialog
appears with Google Earth Search Tab Definition selected as the file type.

3. Navigate to the folder where you want to save the exported search tab definition file, enter a
name for the file, and click Save.

Google Earth Enterprise Fusion saves the file with the .gestd extension. Now you can copy
or move that file wherever you want and import the search tab definitions elsewhere.

4. Click OK to close the Search Tab Manager.

1. Select Tools > Search Tab Manager. The Search Tab Manager appears.

2. Select search tab to delete and click . You are prompted to confirm the deletion.

Caution: When you delete a search tab definition from the Search Tab Manager, Google
Earth Enterprise Fusion does not check to see if any databases are currently using that
search tab definition. If you delete a search tab definition that is used in a database that
has already been built and published, there is not problem if you delete it. However, if you
delete a search tab definition that has been used in a database that has not yet been
built, when you try to build that database, Google Earth Enterprise Fusion displays a
message informing you that it is unable to find the deleted search tab. You must remove
that search tab from the database before you can build it.

3. Click OK.

Back to top

To import a search tab from a plug-in:

To export a search tab:

To delete a search tab definition:
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Overview

This chapter describes key concepts related to importing imagery, terrain, and vector source data
to define resources in Google Earth Enterprise Fusion. It describes all of the tasks related to
creating, modifying, organizing, and managing resources. For information about building resources
and other assets, see the chapter titled Building Assets.

You first import your source data into Google Earth Enterprise Fusion as a resource. There is a
one-to-one correspondence between the type of source file and the type of resource that is
created from it:

Vector resources are created from vector data.
Imagery resources are created from imagery data.
Terrain resources are created from terrain data.

You can create a single resource from a single source file, or you can create a single resource
from many different source files. See Defining Resources for more information.

Providers often split large source files into several smaller source files to make them more
acceptable to download. The main purpose of grouping multiple source files into a single resource
in Google Earth Enterprise Fusion is to return source files that were split up for artificial reasons
(such as file size) to their original state as a single entity. For example, you might acquire four
source files that together comprise a large single data set, such as an image of the state of Texas.
You combine all four source files into a single resource to put the original data back together.

When you combine source files in a single resource, the source files must be of the same type
(imagery, terrain, or vector). In addition, they must be similar in other ways.

For raster (imagery and terrain) resources, the source files must be of the same resolution
and geographic proximity.
For vector resources, the source files must contain the same columns of data.

An important difference between vector resources and raster (imagery and terrain) resources is
that the display rules for vector data can differ between projects. You can use different colors,
icons, and filters for the same resource in different projects. With raster resources, however, most
of the display settings are specified when you first import the imagery or terrain resource. These
settings “stick” with the resource, regardless of which project is using it.

Supported Source File Formats

The following tables list the raster data (imagery and terrain) file formats and the vector file formats
that are supported by Google Earth Enterprise Fusion.

All raster (imagery and terrain) data must have geographic coordinates and projection information

Reference Guide
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included in the file headers or contained in external text-based world files and projection files. All
imagery data must be in 8-bit format with either one band for panchromatic or three bands for
color. All terrain data can be in 16-bit or 32-bit format with a single band.

File
Format

Notes

DTED

Erdas
Imagine
(IMG)

GeoTIFF

GIF Geographic coordinates and projection
information must be accompanied by
external world and projection files.

JPEG Geographic coordinates and projection
information must be accompanied by
external world and projection files.

JPEG2000

Microstation
(DGN)

Microstation DGN files from prior to
version 8 are supported. Versions 8
and later are not supported.

MrSID  

NITF

PNG Geographic coordinates and projection
information must be accompanied by
external world and projection files.

TAB

TIF Geographic coordinates and projection
information must be accompanied by
external world and projection files.

USGS
ASCII DEM

USGS
SDTS DEM

Note: Google Earth Enterprise Fusion does not allow you to import imagery resources larger
than 80GB in raw size. (Raw size = number of pixels width * number of pixels height * 3.)

File
Format

Notes

ESRI
Shape
File
(.shp)

For each ESRI shape file you import into
Google Earth Enterprise Fusion, one
DBF and one SHX configuration file,
each with the same name as the original

Supported Imagery and Terrain Formats

Supported Vector Formats



and the appropriate extension (.dbf and
.shx) must be located in the same
folder. In addition, if there is any
projection in the image, a PRJ file with
the same name as the original file and
the appropriate extension (.prj) must be
located in the same folder. Other
associated files you can include with
each SHP file are SBN, SBX, CPG, and
LYR.

Generic
ASCII

Point data only in comma-separated
values or tab-delimited text format.

KML/KMZ

MapInfo
File
(.tab)

US
Census
Tiger
Line Files

Supported Data Projections

All raster data imported into Google Earth Enterprise Fusion must include geographic coordinates
as well as information about the projection used to create the data. The supported data projections
are:

Albers Equal-
Area Conic

Lambert Azimuthal Equal
Area

Polar Stereographic

Azimuthal
Equidistant

Lambert Conic Conformal
(1SP)

Polyconic

Cassini-Soldner Lambert Conic Conformal
(2SP)

Robinson

Cylindrical
Equal Area

Lambert Conic Conformal
(2SP Belgium)

Rosenmund Oblique
Mercator

Eckert IV Lambert Cylindrical Equal
Area

Sinusoidal

Eckert VI Mercator (1SP) Stereographic

Equidistant
Conic

Mercator (2SP) Swiss Oblique
Cylindrical

Equi-
rectangular

Miller Cylindrical Swiss Oblique Mercator

Gall
Stereographic

Mollweide Transverse Mercator

Gauss-Kruger New Zealand Map Grid Transverse Mercator
(Modified Alaska)

Gnomonic Oblique Mercator Transverse Mercator
(South Oriented)



Hotine Oblique
Mercator

Oblique Stereographic Tunisia Mining Grid

Laborde
Oblique
Mercator

Orthographic Van der Grinten

The GIS tool you use to create your source data generally embeds projection and geotransform
information in your source data file. Sometimes, however, the GIS tool improperly encodes this
information or leaves it out altogether. The result is that Google Earth Enterprise Fusion cannot
properly locate your source data on the globe.

When the projection and geotransform information is missing or inaccurate, you can provide the
required data in the form of auxiliary files to ensure that Google Earth Enterprise Fusion properly
converts your data. The auxiliary files must have the same file name as the source file, be located
in the same folder, and have the appropriate extension, such as:

.prj - Provides projection information

.tfw - Provides geo-transform information

In addition to the standard PRJ format (OpenGIS well known text), Google Earth Enterprise Fusion
supports two other file formats for projection data:

EPSG:x where x is a valid EPSG projection number
PROJ.4 projection specification, such as:+proj=latlong +ellps=GRS80 +towgs84=-
199.87,74.79,246.62

Defining Resources

Defining Vector Resources
Defining Imagery Resources
Defining Terrain Resources

The first step in preparing your GIS data for use in Google Earth Enterprise Fusion involves
importing it into the Asset Manager. When you import source data using the Asset Manager,
Google Earth Enterprise Fusion creates a resource that you can add into your projects. The Asset
Manager is available both with shell commands entered at the command line and as part the
Google Earth Enterprise Fusion GUI. For information on importing large batches of source data,
see the Command Line Reference.

As you import more data into the Asset Manager, you create a collection of resources that can be
used in different projects. When you create resources for use in Google Earth Enterprise Fusion
projects, keep in mind the following:

Configuration settings differ depending on the type of source data.
In general, when you create a resource from vector data, you are setting metadata for that
resource, such as the source date, provider, and character encoding. On the other hand,
when you create a resource from imagery and terrain data, your settings also affect the
display of the data itself, such as mask, fill values, and mosaic options. Settings that affect
the display of vector data are defined in the project that contains the vector resource.

You create a single resource at a time, whether you use a single source or multiple
sources.
Each new resource creation command creates a single resource. If you select multiple
source data files, you are creating a single resource that is a composite of multiple sources.
The source imagery must have identical resolution.

On the other hand, if you want to import several source files where each one is created as a
single resource, you must issue a separate New command for each source file you want to
import. Refer to the Command Line Reference for information on how to use batch

Special Cases



commands for adding source data.

Composite resources require similar source data.
Typically, vector resources are created from multiple sources when you have contiguous data
of the same type. For example, you can create a single resource that displays all of the zip
code boundaries for a state by importing several vector files that each contain the zip code
boundaries for a specific county. When combining vector source files in this manner, the
data itself must have the same projection, and the attribute headers must match in order for
the import to be successful.

For imagery data, large images are frequently cut in to smaller pieces, so each piece fits on
a single CD. When you use data in this format, you must add all of the imagery source files
to a single resource, rather than creating a separate resource for each source file.

Note: Recombining multiple imagery source files that were created by artificially splitting a
large image is the only intended use for this process. It is not a general purpose, multi-
resolution mosaic tool.

New resources must have unique names.
You can create a new resource only if a resource of that name/type does not already exist in
the target folder. However, because imagery, terrain, and vector resources have different file
extensions, you can use the same file name once for each type of resource.

Note: Because resources can be flagged as hidden so that they don’t appear in the Asset
Manager, be aware that a name for a resource you create might be used by a hidden
resource. Select the Show hidden resources check box before creating new resources if
you have many hidden resources in your tree.

Each resource is a separate entity from the source file or files. If you want to specify a
different (or updated) source file for an existing resource, you use a different command. See
Modifying Resources for more information.

Note: Certain characters in Fusion asset names caused problems with the Publisher and
Server. Fusion prevents the creation and use of assets with invalid characters in their
names. The following characters are no longer allowed in Fusion asset names: 

& % ' \ " * = + ~ ` ? < > : ; and the space character

If any assets have a name containing any of the characters mentioned previously, rename
the asset (and path) to a valid name that does not include and of those characters. This
requires you to rebuild the assets, as well as the projects and databases that contain
them. 

The Fusion installer checks the current asset root (if any) to detect, and subsequently
warn, if invalid asset names exists before installation will continue. In cases where
creating new copies of the assets requires too much effort or expensive rebuilding of
resources, a script is available from Google Earth Enterprise Support that will rename the
assets automatically. This script requires using great care, and that is why it is not run
automatically.

You can update an existing resource with new source data.
When you acquire updated source data for a resource that is already included in a Google
Earth Enterprise Fusion database, you can easily replace the old source data with the new
source data. If the new source file has the same name as the old source file and you are not
changing anything else, simply replace the old source file with the new source file on disk,
and rebuild the database. The next time you publish the database, everything else remains
the same except for the new source data.

The Vector Resource Editor
Define Vector Properties

Defining Vector Resources

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/x


Adding a Source File to a Resource
Adding KML/KMZ Source Files to a Resource

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Vector Resource Editor appears.
3. Define the properties of the vector resource as described in the next section, Define Vector

Properties.
4. When you finish defining the properties for the resource, select Save from the File menu.

The first time you save a new resource, the Save dialog appears. Navigate to the folder
where you want to save the resource, provide a unique name for it, and click Save.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

When you finish defining each resource, you can build it individually or build several resources at
the same time; however, you must build a vector resource before you can include it in a project.
See the Building Assets chapter for complete details.

You use the Vector Resource Editor to define the following properties:

Acquisition Date
The acquisition date appears in year-month-day format.

Note: You can decide whether to use the date you acquire the data, the date you import it
into Google Earth Enterprise Fusion, or the actual date of the source image. Regardless
of which method you use, it is best to adopt a consistent policy for all your resources to
avoid confusion.

Click each section of the date and enter the values. Alternatively, you can use the right and
left arrow keys to move among the three parts of the date.

Provider
Select the source provider from the Provider drop-down list. The provider identifies the
source of the data and its copyright information in Google Earth EC.

Note: If you specify the same provider for multiple resources that end up appearing
together in Google Earth EC, Google Earth EC is smart enough to display the provider’s
name and copyright information only once.

The providers that appear on the list are defined in the Provider Manager. See the section
on Managing Data Providers in the Setting Up Your Workspace chapter for more
information.

Encoding
If the field data in your vector resource has a particular encoding for characters, such as
ISO8859-1, select the appropriate option, so your data is displayed correctly in Google Earth
EC. If you do not select an encoding option, the character encoding defaults to ASCII (plain
text).

Layer
Use this option if your source data contains multiple layers and you want to extract a specific
layer from the data for your resource. If you leave this option set to 0 and your source data
contains more than one layer, Google Earth Enterprise Fusion extracts the first layer of the
source file to create the resource.

Note: In most cases, source vector data has only one layer; however, Tiger vector data

The Vector Resource Editor
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can contain multiple layers. Because there is a one-to-one correspondence between a
vector resource and a single vector source layer, resource creation from multi-layer
source data must specify a layer. 

If you are unsure which layer to indicate when creating a resource from multi-layer source
data, you can open the vector source file in Preview pane to display all of the layers in the
source data. Examine each layer, and select the appropriate layer to import.

Elevation Units
Google Earth Enterprise Fusion interprets elevation in meters, so the default selection for
this option is Meters.

If the unit of measure for elevation in your source data is feet, select either Feet
(International) or Feet (US Survey), whichever applies. Google Earth Enterprise Fusion
converts the feet data to its metric equivalent.
If you select Other, the Custom Unit Conversion Factor dialog appears.

Enter the multiplier for Google Earth Enterprise Fusion to use to convert the data to
meters. For example, if the elevation is in yards, enter 0.9144. When you click OK, the
number you enter here appears as the Elevation Units value.

Feature Type Converting
Google Earth Enterprise Fusion imports polygon features as they are classified in the data
set, so the default selection for this option is None. But if for some reason polygon features
in the data set are classified incorrectly, you can apply force conversion.

force 2D
Select force 2D to force conversion of 2.5D polygon features to 2D polygon features.

force 2.5D
Select force 2.5D to force conversion of 2D polygon features to 2.5D polygon features.

Note: The 2.5D polygonal features are mainly used in “buildings” data sets. Fusion does
an analysis of area of features during the vector resource import and based on the result
of this analysis it can propose force converting to 2D for source data set originally
classified as 2.5D polygonal resource. Information is reported in resource import log:
“Found number of very large features classified as Polygon25D. Possibly the source data
is classified incorrectly. Consider importing with --force2D".

Ignore Bad Features
By default, if there are bad features in a source file, Google Earth Enterprise Fusion fails to
build the resource. The error log states that there are bad features. If you check the box next
to Ignore Bad Features, Google Earth Enterprise Fusion ignores the bad features and builds
the resource anyway.

Don't Fix Invalid Geometries
By default, if there are invalid geometries in a source file Google Earth Enterprise Fusion
detects and tries to fix them. It removes zero length edges and "spikes" in polygonal
geometry. As a result of removing invalid geometries polygonal features may become
degenerate (zero area polygon). The resource import log states that there are degenerate
features and they are skipped. If you check the box next to Don't Fix Invalid Geometries,
Google Earth Enterprise Fusion does not clean up invalid geometries and builds the resource
anyway.

Source Files
The Source Files list displays the names of the source files selected for this resource. Click



Add to add a source file. See the next section, Adding a Source File to a Resource, for
more information.

To delete a file on the Source Files list and no longer associate it with this resource, select
the file and click Delete. A message prompts you to confirm the deletion. Click OK. The file
no longer appears on the list.

Note: You can select one or more source files to create a single resource, such as an
imagery mosaic or a vector composite. If you use more than one source data file for a
single resource, all of the raster data must have the same projection and attribute values,
and all of the vector data must be of the same type (lines, points, or polygons).

Each resource must contain at least one data source file. Perform the following procedure for each
source file you want to add.

1. In the Vector Resource Editor, click Add. The Open Source dialog appears.
2. Navigate to the folder containing the source data file(s) you want to add.
3. Select the desired source data file(s), and click Open. The new source data file(s) appear on

the Source File(s) list.

You can import KML or KMZ files created in Google Earth as resources in Google Earth Enterprise
Fusion. There are a few limitations on the type of KML files that Google Earth Enterprise Fusion
can import:

You can import the name, description, LookAt, and geometry only, not style information or
custom icons.
You can import point and line geometry in 2D only; however, you can import polygons in 2D
or 2.5D.
You cannot import networked KML or super-overlay KML.

To import KML/KMZ files:

1. In the Vector Resource Editor, click Add. The Open Source dialog appears.
2. Select Keyhole Markup Language (or All Files) for the file type to display.
3. Navigate to the folder containing the KML or KMZ file you want to add.
4. Select the desired KML or KMZ file, and click Open. The new source data file appears on

the Source File(s) list.

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Imagery Resource Editor appears. 

Defining Imagery Resources
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3. Define the properties of the imagery resource as described in the next section, Define
Imagery Properties.

4. When you finish defining the properties for the resource, click Save.

The first time you save a new resource, the Save dialog appears. Navigate to the folder
where you want to save the resource, provide a unique name for it, and click Save.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

When you finish defining each resource, you can build it individually or build several resources at
the same time. See the Building Assets chapter for complete details.

Use the Imagery Resource Editor to define the following properties:

Acquisition Date
The acquisition date appears in year-month-day format. This is required for historical
imagery projects.

The date you set for the Imagery Acquisition Date is visible in the Google Earth Client when
hovering the cursor over a tile. This requires that the imagery resource has acquisition dates
recorded with it and requires a rebuild of the imagery project (since for this feature the date
needs to be encoded in the JPEG tiles). Imagery and Vector Resource dialogs now support
an improved acquistion date format: unspecified days and months are now supported, for
example:

2008-01-00 indicates January 2008
2008-00-00 indicates 2008
0000-00-00 indicates undefined. Leading 0's are not necessary in specifying dates.

Google Earth Enterprise supports the creation and displaying of historical imagery that works
just as the historical imagery in the Google Earth client.

Note: You can decide whether to use the date you acquire the data, the date you import it
into Google Earth Enterprise Fusion, or the actual date of the source image. Regardless
of which method you use, it is best to adopt a consistent policy for all your resources to
avoid confusion.

Click each section of the date and enter the values. Alternatively, you can use the right and
left arrow keys to move among the three parts of the date.

Provider
Select the source provider from the Provider drop-down list. The provider identifies the
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source of the data and its copyright information in Google Earth EC.

Note: If you specify the same provider for multiple resources that end up appearing
together in Google Earth EC, Google Earth EC will display the provider’s name and
copyright information only once.

The providers that appear on the list are defined in the Provider Manager. See Managing
Data Providers in the Setting Up Your Workspace chapter for more information.

Tip: If you create a single resource from multiple source files that you received from
multiple providers, you can create a special entry in the Provider Manager that gives credit
to all providers who contributed to that resource. For example, if you combine source files
from USGS and i3 into one resource, you can use the Provider Manager to create a
special provider called USGS/i3. In the copyright field, you can enter Imagery © USGS
2005 and i3 2006. When you define the resource, select USGS/i3.

Mask Options
When image data is captured, certain areas contain unusable data. This unusable data is
called fill, since it exists simply to fill out the rest of the tile or tiles. Fill data is usually true
black (0,0,0), true white (255,255,255), or a value close to one of those two values.

Since the fill data contains no useful information, Google Earth Enterprise Fusion needs to
mask the fill areas, allowing the underlying image layers (with usable data) to show through.
You can create a mask for a given area yourself, or you can allow Google Earth Enterprise
Fusion to create a mask for the fill area automatically. The Auto Mask feature is sufficient in
most cases.

If you create a mask yourself, it must either be of the same file format as the original image
file, or it must be a TIFF file. See Creating Custom Masks for more information.

If you select Auto Mask for an image, you can set some options to adjust the mask you
create. The values you can adjust are described in the following sections.

Select the mask type from the Mask Type drop-down list.

Auto Mask (the default)

In most situations, particularly when you are creating a mosaic from contiguous source
imagery, the Auto Mask setting is the best choice. For example, if you have four square
contiguous pieces of imagery that are bounded by land on all sides, you would likely
select Auto Mask. The Auto Mask function automatically uses a fill value based on the
colors in the four corners of the source imagery to create the mask.

If you select Auto Mask, you can set the following options:

Feather
The feathering value allows you to provide a smooth transition between the image
(usable) data and the fill (unusable) data. You use the feathering option to define a
blending region between the actual image and the transparent mask.

At the edge of the feather area closest to the image, 100 percent of the image
area is visible. From this point to the edge of the mask, the transparency of the
image increases and its opacity decreases. At the same time, the opacity of the
mask increases and its transparency decreases. At the edge of the feather area
closest to the mask, the image value is 100 percent transparent, and the
underlying imagery shows through completely.



The default feather value is 100 pixels. If the default feather value results in
masking out too much data, you can specify a lower value (that is, a narrower
band of blending) and experiment with the results. However, if you specify a value
that is too low, you could create sharp edges between insets, possibly even
leaving black lines between insets. See Defining Terrain Resources for more
information. See also the Tutorial for an example.

Band
Use this option to indicate which channel to use when generating the mask (Red,
Green, or Blue). Typically, green provides the best contrast between Earth data
and no data and is, consequently, the default. However, some data works best
when the blue channel is used for mask selection.

Tolerance
Tolerance specifies the color range for mask selection. The default tolerance is 0,
which is adequate for many fill colors that are pure black or pure white. However,
when data is compressed and uncompressed, it is sometimes modified slightly.
Although these modifications are imperceptible to the human eye, a computer can
detect them. A fill pixel with an original value of (0,0,0), for example, might
decompress to a value of (0,1,0).

If you want to ignore slight variations in fill color values, you can specify a
tolerance value, which represents the amount of variation from true black or true
white that Google Earth Enterprise Fusion ignores when it creates the Auto Mask.
Typically, a setting of 1 or 2 is adequate.

Hole Size
Use this option if you have fill regions inside the boundaries of your imagery data.
The default setting for hole size is 0, which is off.

The hole size indicates the number of contiguous pixels Google Earth Enterprise
Fusion uses when matching any color region inside your imagery with the same
value specified as your fill. For example, if you set the Hole Size value to 100 and
the imagery has a block of pixels that is 100 or more pixels in width or height with
the same color as one of the corners (fill value), Google Earth Enterprise Fusion
treats that area as a hole in the data and applies the mask to it. The end result is
that whatever data is under the masked data shows through.

Be aware that if you use the hole-checking feature, there are trade-offs that can
dramatically increase the time it takes to generate a mask, including:

Images photographed late in the day often contain shadows that look like
holes.
If the specified hole size is too small, it could slow performance.
If the specified hole size is too large, medium-sized holes could be
overlooked.

Specifying an appropriate hole size involves some familiarity with the actual
data.

Fill White
Fill data is usually indicated by areas of black pixels, so the default fill color is
black (0,0,0). If you know that the vendor has used white (255,255,255) as well as
black as a fill color, be sure to check the Fill White box when you import the
imagery. Checking this box allows both black and white to be considered as fill



data when the Auto Mask is created. The following image is an example of source
imagery with both black and white fill data.

No Data
Use this option to specify the pixel value for NoData in the terrain data (the pixel values
to include in the mask). Multiple values may be specified in this field, including ranges
(two numbers separated by a colon ":") and individual values. For example, -99999:0 is
the default which will mask any pixel value from -99999 through 0, inclusive. The values
-99999 and 0 alone, can be masked by using -99999, 0 instead of -99999:0.
Alternatively, ‘-99999:-32768, 32768:999999’ means mask pixel values -99999 through
-32768 and 32768 through 999999.

Have Mask
Select Have Mask if you have a corresponding alpha mask or file for your source. (See
Creating Custom Masks for details about creating your own custom masks.) Google
Earth Enterprise Fusion automatically applies the mask file to the source file. The mask
for your input must be located in the same folder as the source file, and the file name
must match the name of the source file with -mask appended. For example, if your
source file is called NewYork.tif, its mask file must be named NewYork-mask.tif.

You might select the Have Mask option in a situation where your source file imagery is
bounded by water, and a significant portion of the image is water. In that case, you
would likely create a mask by hand in order to preserve the high-resolution detail
around your shoreline while masking the water imagery.

If you are creating a resource from multiple imagery source files, you cannot select
Have Mask as the mask setting value.

No Mask
Select No Mask only for base map imagery that extends to the entire database, such
as the NASA Blue Marble imagery.

Mosaic Options
The simplest way to import source data is to create one resource from each data file. In
some cases, though, it is actually necessary or just more efficient to import multiple source
images into a single resource, called a mosaic. To create a mosaic, the source images must
meet the following requirements:

Source images must be in the same projection and use the same coordinate system.
Source images must have the same resolution.
Source images must have geographic proximity to each other.
There should be no gaps between the individual source images.



Use the Mosaic Options area for setting the tile fill values and fill tolerance for fill areas of
overlapping imagery tiles. These options are available only when you import more than one
imagery file.

Note: This process of recombining images that were artificially split is the only intended
use for combining multiple imagery source files into a single resource. It is not a general
purpose, multi-resolution mosaic tool.

Tile Fill
When there is an overlap between the tiles, the pixels in the top tile obscure the pixels
in lower tiles. To expose the pixel beneath the top tile, you specify the color to make
transparent.

Note: The Tile Fill setting makes the specified pixels transparent. Masking blocks the
specified pixels. Both methods, however, define the pixels to be maintained and the
pixels that show through.

For example:

If the top pixel is black and you want to expose the pixels beneath it (on a lower
tile in the stack), select Black to make transparent.
If the top pixel is white and you want to expose the pixels beneath it, select White
to make transparent.
If the top pixel is a color other than black or white and you want to expose the
pixels beneath it, select Other. The Select Color dialog appears, and you can
select the desired color to make transparent.
If you select None, Google Earth Enterprise Fusion applies no tile fill to the
adjacent imagery. That is, any overlapping pixels in the top tile obscure the pixels
in the tile beneath it.

Note: Google Earth Enterprise Fusion applies the Tile Fill setting and other mosaic-
related settings to the imagery to create a single larger image before it applies the
mask. Any fill value you set here has no impact on the mask you use for the entire
image.

Fill Tolerance
The tolerance setting functions just as it does for fill values on the Auto Mask. See
Tolerance under the Auto Mask bullet above.

Source Files
The Source Files list displays the names of the source files selected for this resource. Click
Add to add a source file. See Adding a Source File to a Resource for more information.

Note: You can select one or more source files to create a single resource, such as an
imagery mosaic or a vector composite. If you use more than one source data file for a single
resource, all of the source data must have the same projection and attribute values. 

Google Earth Enterprise Fusion does not allow you to import raw imagery source files larger
than 80 GB. (Raw size = number of pixels width * number of pixels height * 3.) Therefore, if
you have an imagery source file that is larger than 80GB, you can create two or more
source files using the gesplitkhvr command. (See gesplitkhvr in the Command Line
Reference chapter for details.)

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Terrain Resource Editor appears.
3. Define the properties of the imagery resource as described in the next section, Define

Terrain Properties.
4. When you finish defining the properties for the resource, select Save from the File menu.

The first time you save a new resource, the Save dialog appears. Navigate to the folder

Defining Terrain Resources



where you want to save the resource, provide a unique name for it, and click Save.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

When you finish defining each resource, you can build it individually or build several resources at
the same time.

Use the Terrain Resource Editor to define the following properties:

Acquisition Date
The acquisition date appears in year-month-day format.

Note: You can decide whether to use the date you acquire the data, the date you import it
into Google Earth Enterprise Fusion, or the actual date of the source image. Regardless
of which method you use, it is best to adopt a consistent policy for all your resources to
avoid confusion.

Click each section of the date and enter the values. Alternatively, you can use the right and
left arrow keys to move among the three parts of the date.

Mask Options
When terrain data is captured, certain areas contain unusable data. This unusable data is
called fill, since it exists simply to fill out the rest of the tile or tiles.

Since the fill data contains no useful information, Google Earth Enterprise Fusion needs to
mask the fill areas, allowing the underlying terrain layers (with usable data) to show through.
You can create a mask for a given area yourself, or you can allow Google Earth Enterprise
Fusion to create a mask for the fill area automatically. The Auto Mask feature is sufficient in
most cases.

If you create a mask yourself, it must either be of the same file format as the original image
file, or it must be a TIFF file. See Creating Custom Masks in the chapter titled Creating
Your Own Source Data, Icons, and Masks for more information.

If you select Auto Mask for terrain data, you can set some options to adjust the mask you
create. The values you can adjust are described in the following sections.

Select the mask type from the Mask Type drop-down list.

Auto Mask (the default)

In most situations, particularly when you are creating a mosaic from contiguous terrain
source data, the Auto Mask setting is the best choice. The Auto Mask function
automatically uses a fill value based on the elevation value in the four corners of the
source terrain to create the mask.

If you select Auto Mask, you can set the following options:

Feather
Feathering blends the edges of your terrain tile into adjacent areas for a smoother
transition. The default feather value for Auto Mask is 100 pixels, but you can adjust
it for a wider or narrower margin, if desired. See Defining Imagery Resources for
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more details about feathering.

Hole Size
Use this option if you have masked regions inside the boundaries of your terrain
data. The default setting for hole size is 0, which is off. See Defining Imagery
Resources for more details about hole size.

No Data
Use this option to specify the pixel value for NoData in the terrain data (the pixel
values to include in the mask). Multiple values may be specified in this field,
including ranges (two numbers separated by a colon ":") and individual values. For
example, -99999:0 is the default which will mask any pixel value from -99999
through 0, inclusive. The values -99999 and 0 alone, can be masked by using -
99999, 0 instead of -99999:0. Alternatively, ‘-99999:-32768, 32768:999999’
means mask pixel values -99999 through -32768 and 32768 through 999999.

Have Mask
Select Have Mask if you have a corresponding alpha mask or file for your source.
Google Earth Enterprise Fusion automatically applies the mask file to the source file.
The mask for your input must be located in the same folder as the source file, and the
file name must match the name of the source file with -mask appended. For example, if
your source file is called NewYork.tif, its mask file must be named NewYork-mask.tif.

You might select the Have Mask option in a situation where your terrain data is
bounded by water, and a significant portion of the terrain is water. In that case, you
would likely create a mask by hand in order to avoid processing the water data.

If you are creating a resource from multiple terrain source files, you cannot select Have
Mask as the mask setting value.

No Mask
Select No Mask only for base map terrain that extends to the entire database, such as
the gtopo30_4km terrain data.

Mosaic Options
The simplest way to import source data is to create one resource from each data file. In
some cases, though, it is actually necessary or just more efficient to import multiple source
files into a single resource, called a mosaic. See Mosaic Options in Defining Imagery
Resources for details.

Tile Fill
When there is an overlap between the tiles, the pixels in the top tile obscure the
elevation samples in lower tiles. To expose the elevation samples beneath the top tile,
you specify the elevation value to make transparent.

Note: The Tile Fill setting makes the specified pixels transparent. Masking blocks the
specified pixels. Both methods, however, define the pixels to be maintained and the
pixels that show through.

For example:

If you want to expose the pixels beneath the overlap, select Other. The Custom
Mosaic Fill Color dialog appears, and you can enter the desired elevation to make
transparent.
You can specify negative values so that NoData pixels are excluded from terrain
mosaics. Setting the value to -9999 directs Fusion to exclude pixels with value -
9999 from the merged mosaic during Fusion terrain resource import.
If you select None, Google Earth Enterprise Fusion applies no tile fill to the
adjacent terrain. That is, any overlapping pixels in the top tile obscure the pixels in
the tile beneath it.

Note: 1.Google Earth Enterprise Fusion applies the Tile Fill setting and other
mosaic-related settings to the terrain to create a single larger image before it
applies the mask. Any fill value you set here has no impact on the mask you



use for the entire image.

Fill Tolerance
The tolerance setting functions just as it does for fill values on the Auto Mask. The
default tolerance is 0, which is adequate for most terrain data. However, you can adjust
the tolerance to compensate for any possible loss in precision. Typically, a setting of 1
or 2 is the highest tolerance value required.

Elevation Units
Google Earth Enterprise Fusion interprets elevation in meters, so the default selection for
this option is Meters.

If the unit of measure for elevation in your source data is feet, select either Feet
(International) or Feet (US Survey), whichever applies. Google Earth Enterprise Fusion
converts the feet data to its metric equivalent.
If you select Other, the Custom Unit Conversion Factor dialog appears.

Enter the multiplier for Google Earth Enterprise Fusion to use when it converts the data
to its metric equivalent. When you click OK, the number you enter here appears as the
Elevation Units value.

Set Negative Elevation to 0 (Preview Feature) : Resets all negative elevation values in the
source files to zero during resource import. This option must be unchecked to import and use
negative elevation data. This option can be checked for positive and negative elevation
datasets.  This option is checked by default for any resources that were originally imported
with Fusion 3.0.x or earlier, to preserve the original behavior of those resources.
Source Files
The Source Files list displays the names of the source files selected for this resource. Click
Add to add a source file. See Adding a Source File to a Resource for more information.

Note: You can select one or more source files to create a single resource, such as an
terrain mosaic or a vector composite. If you use more than one source data file for a
single resource, all of the source data must have the same projection and attribute values.

By using negative elevation resources, you can build elevation models for the world sea floors,
lake beds, and below sea surface locations (Death Valley, CA) along with positive value terrain
data for land masses. Properly importing negative elevation terrain requires additional data
preparation, however, the end-to-end data workflow is the same for importing terrain resources
and building terrain projects.

Previous versions of Fusion Pro would impose an artificial elevation floor value of 0 to any data
sets with negative elevation values. This restriction was enforced because the Google Earth
Enterprise Client (EC) could not display negative elevations. The Google Earth Enterprise Client
software can display negative elevation models, as of version 5.0, and the Fusion artificial
elevation ‘floor’ is no longer imposed. Data users can build terrain models with only positive values
only – if no negative elevation terrain is available – or build terrain models with both positive and
negative elevation data.

In the following example, a terrain project is built from the GTOPO world terrain dataset (1-
kilometer resolution). It includes positive elevation values for land, a NoData value of -9999, a
pixel value of 0 for the oceans and lakes, and a world-wide bathymetric terrain dataset with a
NoData value of -9999 for all pixels out of the oceans and on the land. The entire globe has
terrain coverage:

Using Negative Elevation Terrain Resources



Importing Preprocessed Resources

If you purchase preprocessed data from Google or receive preprocessed data from another Google
Earth Enterprise Fusion user, it arrives as a complementary pair of folders. These folders share
the same name but have different extensions. Folders with a .kip extension are imagery data.
Folders with a .ktp extension are terrain data. Folders with a .kmp extension are mask files.

You must use the Google Earth Enterprise Fusion shell commands to add preprocessed data to
your asset root. See Importing Preprocessed Resources in the Command Line Reference
chapter for complete details.

Modifying Resources

After you create any type of resource, you can use the Asset Manager to modify it in any of the
following ways:

Associate a newer version of the original source data file, if it changes.
Add another source file.
Delete a previously associated source file.
Modify the resource’s properties, such as its fill value or mask settings.
Hide the resource so it does not appear in the Asset Manager unless the Show hidden
resources check box is selected. With this feature, you can “turn off” resources you do not
need to display regularly, such as those that are incorrectly named.

Note: When you save a modified resource, Google Earth Enterprise Fusion replaces the old
resource definition with the new one. When you build that new resource, Google Earth
Enterprise Fusion creates a new version. When you select a resource to include in a project, it
is always the latest version of the resource. However, your modifications to a resource have no
effect on earlier versions of that resource that were previously built into a database.

1. Right-click the name of the resource you want to redefine in the Asset Manager, and select
Modify from the context menu (or double-click the name of the resource).

The Resource Editor for that resource type displays all of the current settings.

To modify an existing resource:



2. Make the appropriate modifications.

See the section on defining Vector, Imagery, or Terrain resources for details about each
option.

If one or more source files have changed since you last saved the resource, a message at
the bottom of this dialog informs you that the original source files have changed on disk. You
do not have to change anything to take advantage of the updated source files; Google Earth
Enterprise Fusion automatically includes any updated source files when you save the
resource.

3. When you finish modifying the settings for the resource, select File > Save.

Google Earth Enterprise Fusion saves the resource in the same place with the same name.
If you have already built the resource, you must rebuild it after making changes.

Back to top
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Overview

This chapter describes all of the tasks necessary to define and build projects with Google Earth Enterprise Fusion. It includes
information about vector, terrain, and imagery projects. For information about Google Maps projects, see the chapter titled Defining a
Map Project.

The purpose of creating projects is to specify the resources you want to display, the order in which you want to display them, and, for
vector projects, the display properties for each resource.

Google Earth Enterprise Fusion supports four types of projects:

Vector projects
Imagery projects
Terrain projects
Map vector projects (covered in the Defining a Map Project chapter)

Defining Vector Projects

Within each type of project, you can add multiple resources of the same type. Each resource within a project is identified as a layer.

You can assign related layers to a layer group, which allows Google Earth EC users to turn on and off the entire group at the same
time. See the Working with Vector Layer Groups section of this chapter for more information.

For vector projects, the name of each layer appears in the Layer panel of Google Earth EC (outlined in red in the following graphic).
You can use simple HTML codes in the layer names to display special designations.

The most effective way to create valuable vector data is to apply specific display rules to each layer. A display rule determines exactly
which features of the layer are displayed and how Google Earth displays them. For more information on display rules for vector
resources, refer to the Configuring Display Rules section of this chapter.

Creating a Vector Project

The first step in defining a vector project is to specify which resources to include and give the project a name.

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click  to open the Vector Project Editor.

3. Click . The Open dialog appears.
4. Navigate to the folder that contains your vector resources.

Note: The selection in the Type drop-down list near the bottom of this dialog determines the type of resources that appear on
the list. Vector Resource is automatically selected when you open this dialog from the Vector Project Editor, so only vector
resources appear on the list.

5. Select the resource you want to add to the project, and click Open.
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The selected resource appears in the Vector Project Editor.

6. Check the box next to the resource, if you want to view it in the Preview pane. When a resource’s preview box is checked, you
can right-click the resource and select Zoom to Layer to zoom in on that resource.

7. Repeat the previous steps for each additional resource you want to include in the project.
8. To finish adding resources, select File > Save.

9. Navigate to the folder where you want to save your project, or click  to create a new folder in the desired location.
10. Enter the name of your project, and click Save.

The new project name appears in the Asset Manager’s asset list.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are no longer available to use in
Google Earth Enterprise Fusion; see Cleaning Asset Versions in the Building Assets chapter for more information.

The following sections describe the many ways that you can modify the layers in your project to customize it. When you finish
modifying each project, you can build it individually, build several projects at the same time, or wait until you build your database to
build all of its projects at the same time. See the chapter on Building Assets for complete details.

When you modify and then save a project, Google Earth Enterprise Fusion saves it in the same place with the same name as the
original. If you modify a project that you have already built, you can rebuild it now or include it when you build the associated
database.



Working with Layers in Vector Projects

After you create a vector project, you can add, remove, skip, or change the order of its layers.

Note: You must rebuild the project before the changes appear in the Preview pane.

When you add layers to your project, they appear in the order in which you added them. The order in which they appear in the Vector
Project Editor determines the order in which they appear in the Layers panel of Google Earth EC. You can rearrange them in the
Vector Project Editor, if you want them to appear in a different order in Google Earth EC.

1. In the Asset Manager, double-click the name of the project in which you want to modify layers. The Vector Project Editor
displays the list of layers included in the project.

2. Perform the desired procedure(s) below.
3. Select File > Save. Google Earth Enterprise Fusion saves your changes to the project, using the same project name.

Follow steps 3 through 5 in Creating a Vector Project for each layer you want to add to the project.

In the Vector Project Editor, right-click the layer you want to skip, and select Skip Layer. The selected layer appears with a strike-
through.

Skipping a layer temporarily excludes it from the build. To include the skipped layer in a later build, right-click the layer and select
Don’t Skip Layer.

In the Vector Project Editor, select the layer to remove and click .

Alternatively, right-click the layer and select Remove Layer from the context menu.

1. Select the layer to move.

2. Click  or  to move the selected layer to the desired position on the list.

(Or, right-click the layer and select Move Layer Up or Move Layer Down from the context menu.)

3. Repeat these steps until the layers are in the order in which you want them to appear in the Layers panel of Google Earth EC.

Working with Vector Layer Groups

When creating vector projects, you can group layers together so they appear in a folder in the Layers panel in Google Earth EC. For
example, you might have one vector layer that contains all the commuter rail lines for a given area and another vector layer that
contains all the commuter rail station points for that area. You can place both layers in a folder named Transit - Rail Lines.

When you publish the database, a single folder named Transit - Rail Lines appears in the Layers panel in Google Earth EC. When a
Google Earth EC user expands that folder, both the commuter rail line and the commuter rail station layers appear within it. In Google
Earth EC, users can view the individual layers by turning them on or off individually.

If you would prefer a layer group to behave as a single layer, rather than as individual layers, deselect the Expandable checkbox in
the Layer Group Properties dialog.

Modifying layers in a vector project

Adding layers to a project

Skipping a layer in a project

Removing layers from a project

Reordering layers in a project

Creating a Layer Group



1. In the Vector Project Editor, click . The New Layer Group dialog appears.
2. Enter a unique name for the layer group folder that allows it to be easily identified by users. The name you enter here appears

as the layer group name in Google Earth EC.
3. Click OK. The name of the layer group folder appears in the Vector Project Editor.
4. Drag and drop the layers you want to add over the layer group folder. Once the first layer is added to the group, the layer group

folder expands to display its layers.

Right-click the layer to delete and select Take Layer Out of Group.

Alternatively, drag the layer to be deleted to the white space below the layer group folder. The layer appears below the list.

Configuring Layer Properties

After you add vector-based layers to your project, you can customize the layers to determine how the layer list (or legend) appears in
Google Earth EC. This applies to layer groups as well as to individual layers.

You can view the layer properties for a resource in a project by right-clicking the layer name in the Vector Project Editor and selecting
Layer Properties from the context menu.

The Layer Properties dialog contains four tabs:

Legend
Search
Advanced
Notes

The following sections describe each tab.

The Legend tab displays the selected layer's properties.

When you first open this dialog for a new layer, only the default locale and its values appear, and the box next to Hide unspecialized
locales is checked. Google Earth EC uses the default locale settings when you do not specify different settings here for a user’s
locale (as specified in the user’s operating system). See the section on Locale-specific Values below for information on setting
property values for individual locales.

The property values available for each locale are:

Icon
The icon that appears next to the name of the layer in the Layers panel of Google Earth EC. You can select a different icon for
the layer by clicking the value in the Icon column and then selecting a new icon from the Icons dialog.

Note: You can use the Icon Manager to create more icons. See Managing Icons in the Setting Up Your Workspace chapter
for more information.

Name
The name of the layer displayed in the Layers panel of Google Earth EC. You can change the name of the layer by clicking the
value in the Name column and changing it to a name that makes it easier for users to identify the layer.

Removing a Layer from a Layer Group

Legend Tab



Initial State
Determines whether the layer is turned on or off by default in Google Earth EC. The first time a user connects to the database
containing this layer:

If you select On as the default state here, the check box for the layer is automatically checked.
If you select Off as the default state here, the check box for the layer is automatically unchecked.

Google Earth EC saves the state of the check box when a user disconnects from the database. For example, if you set the initial
default state to Off, and then a user subsequently checks the box for a layer in Google Earth EC and then disconnects from the
database, the next time that user connects to that database, the state of the check box for that layer is the same as when the
user disconnected; that is, the box is checked.

Caution: If you select On as the default state for the layer, be aware of the performance impact on Google Earth EC. If a
user selects too many layers simultaneously in Google Earth EC, it can seriously impact performance. So it is best not to turn
on too many layers at the same time. In most situations, setting the default state to Off is the best choice.

LookAt
Allows you to specify a camera view by selecting a KML/KMZ file that includes a LookAt element. If you specify a KML/KMZ file
in this field, Google Earth EC users can fly directly to the specified camera view by double-clicking the layer.

1. In Google Earth EC, set the desired camera view (tilt, pan, and zoom), create a placemark, and then save the placemark.
(Refer to the Google Earth EC documentation for help with this step, if necessary.)

2. Copy the resulting KML/KMZ file to the workstation where you run Google Earth Enterprise Fusion.
3. Click the LookAt field for the desired locale. The Open dialog appears.
4. Navigate to the folder containing the KML/KMZ file, select it, and click Open. The content of the KML/KMZ file (a series of

numbers) appears in the LookAt field.

When Google Earth EC users double-click the name of this layer, Google Earth EC flies to the camera view of the
placemark defined in that file.

KML URL
Allows you to specify a KML/KMZ file for this layer. (The KML/KMZ file must be hosted on a local or remote server.)

Caution: If you specify a KML/KMZ file in this field, the content of the KML/KMZ file replaces the resource for which it is
defined. So if you intend to specify a KML URL, include the simplest possible “dummy” resource (very small source file) in the
project instead of a resource you actually want to display in Google Earth EC.

Labels
Defines which labels apply to this layer. You can create labels using the Label Manager.

Required Client Version
(Optional) Indicates specific versions of Google Earth that the layer will support. For example:

5.0.11733 indicates that the layer is included if the Google Earth client version is 5.0.11733 or newer.
5.0.11733-4.0.2291 indicates that the layer is included if the Google Earth client version is between versions 4.0.2291 and
5.0.11733.
-4.0.2291 excludes the layer if the Google Earth client version is 4.0.2291 or earlier.

If you uncheck the box next to Hide unspecialized locales, all of the locales that you created with the Locale Manager appear in the
table.

All of the values for non-default locales are set to the default values unless you change them. That means that regardless of which
locale a user selects in Google Earth EC, the default values appear.

To change the value of a field for a specific locale, click the locale in the top row of the table. Click its field, and change the value.
Some fields contain a drop-down menu, and some allow you to enter free-form text. For example, to support the Italian locale, enter
values for the fields under it:

Locale-specific Values



If Italy is the only locale for which you want to specify values other than the defaults, you can unclutter this dialog by checking the box
next to Hide unspecialized locales. This hides the locales where no specialized values are defined and displays only the default and

it columns.

Continuing with this example, when a Google Earth EC user selects Italy as their locale, Google Earth EC displays the values listed
under it.

The Search tab allows you to specify one or more fields in the source data on which users can search. When you select one or more
search fields on this tab of the Layer Properties dialog, a search tab appears in Google Earth EC that allows users to search for data
in the selected field(s).

Search Tab



1. Click . The Add Search Field dialog appears.

2. Select the desired field from the Column Name drop-down list.
3. Select an option from the Use drop-down list:

Search Only - Google Earth EC searches against the selected field but does not display the results.
Display Only - Google Earth EC displays the values of the selected field in the results but does not search against the
selected field.
Search and Display - Google Earth EC searches against the selected field and displays the results.

For example, if you have a database of trees that includes the common names of the trees and their ages, you could set up
a search of all trees with a particular name and display their ages and locations. To do so, you would:

Select the NAME field and select Search Only.
Select the LOCATION field and select Display Only.
Select the AGE field and select Display Only.

In Google Earth EC, users could then enter oak as the search term, and the results would be the names and locations of
all oak trees in the database. If the user enters elm, the results would be the names and locations of all elm trees in the
database.

Note: This is currently an exact search, which means that the Google Earth EC user must enter the value exactly as it
appears in the database. In the example described above, if the user enters oak, the search results would include only
trees listed as “oak”, not trees listed as “California live oak” or “cork oak”.

4. Repeat the steps above for each additional field you want to add to the search.

Your selections appear on the list of search fields on the Search tab in the order in which you added them:

The order in which the fields appear on this list is the order in which they appear in the description balloon in Google Earth EC.
(The fields designated as Search Only do not affect the order in which the fields to be displayed appear.) In this case, the
description balloon for a POI might look like:

Adding Search Fields



Click  or  to move the fields up or down in the list to change the order in which they appear in Google Earth EC.

When you finish defining all of the layer properties, click OK. The Search Tab Properties fields appear at the bottom of the Vector
Project Editor.

You can modify the Tab Label and Search Field Label values to names that suit your search.

Note: Google Earth Enterprise Fusion combines all of the fields you select for all of the layers in a project into one search tab with
one search field label. If you want more flexibility or control over your search tabs, use the Search Framework API to create plug-
ins, and then reference those plug-ins when you create search tabs with the Search tab Manager. 

If you delete all of the search fields from the Layer Properties dialog, the Tab Label and Search Field Label fields disappear from
the Vector Project Editor. If you ever add search fields to this project again, these fields reappear with the most recent values you
provided.

The Advanced tab allows you to specify additional text-related options for the layer.

You can specify the level at which you want to preserve text labels on roads after the vector data for the road itself fades away. This
feature is typically useful when a Google Earth EC user zooms in close enough to see the roads in the image, so it is no longer
necessary to draw the road vector. However, it is still useful to see the name of the street.

To specify the correct value:

1. Create a road layer, set the desired styles and levels of detail, and build it.
2. Open the build log for that layer:

In the Asset Manager, double-click the value in the Current State column for the desired vector project.
Expand the CHILD: VectorLayer subtype for the desired layer. (If you do not know which layer is which, expand all of the
CHILD: VectorLayer subtypes, and look at the INPUT: Resource values.)

Click  next to CHILD: VectorFuse for the desired layer.
3. Locate the last line in the build log that starts with Begin export of level x. The value of x is the last level at which vector

lines are displayed.
4. Go back to the Advanced tab of the Layer Properties dialog.
5. In the Preserve Text field, specify the last display level value indicated in the build log.

Note: This setting affects roads only.

The JavaScript Editor allows you to create JavaScript functions. Click the insertion button (...) to the right of the empty text field to
display the JavaScript Editor.

Advanced Tab

Preserve Text

JavaScript



Note: You need to be somewhat familiar with JavaScript to use the JavaScript Editor. You can use all of the standard JavaScript
functions or objects that you would use in a JavaScript-enabled web page with the exception of window, document, browser, and so
on.

Select a field (or function, if you have created any) on the left, and click Get Values to display the values of that field for the selected
data set in the Field Values list on the right.

Tip: If your data set is very large, it can take a long time to find all of the values. In that case, a progress dialog appears showing
you an ongoing count of how many values it has found. You can click Cancel on that dialog at any time to stop scanning your
source file for unique values and populate the Field Values list with the unique values found so far. Typically, it stops finding
unique values part way through the file. So when the counter virtually stops, that is a good time to click Cancel without concern
that you might be missing some unique values.

Use the buttons in this dialog to help you write your JavaScript functions.



The functions you create here become available in the other JavaScript Editors, where you are defining label strings or filter
expressions for the current layer.

When you finish creating your JavaScript functions, click OK. The functions appear in the JavaScript field on the Advanced tab of
the Layer Properties dialog.

The Notes tab allows you to enter notes about the layer.

Enter the text of your note. To insert the current date and time, click Insert Timestamp.

Note: The notes appear in Google Earth Enterprise Fusion only.

Configuring Display Rules

To specify how you would like to display vector data, you configure display rules for each layer. For example, you might add a vector
resource that includes the boundaries of lakes, but the line color is not different enough from the color of the lake, so the boundaries
of the lakes are not visible at higher altitudes. Using display rules, you can change the color of the border and set the display level of

Notes Tab



the resource to a lower number, so the lake borders are visible at higher altitudes.

To define a display rule, right-click a layer in the Vector Project Editor, and select Configure Display Rules from the context menu.

The Display Rules dialog appears with the Feature tab selected.

The default rule, default select all, appears automatically in the Rules list and is selected. Below the list of rules are five small
buttons. Their functions are:

Create a new rule.

Delete selected rule.

Make a copy of the selected rule.

Move the selected rule up.

Move the selected rule down.

When you click Thematic Filters, the Thematic Filtering Editor appears. This editor allows you to easily create a series of filters to
show data with a particular theme. For example, to show the population of counties in California, you could create a series of filters
that show counties with the highest population in a dark shade of green, the lowest population in a light shade of green, and mid-level
population in a medium green. (See “Creating Thematic Filters” on page 5-23 for more details.)

When you check the box next to Allow Feature Duplication, Google Earth Enterprise Fusion allows data to be matched by more than
one filter and, therefore, apply more than one rule to it. For example, if you want to apply one type of formatting to counties and
another kind of formatting to zip code areas, you can check this box to apply both types of formatting to the same data.

When you check the box next to Allow Empty Layer, Google Earth Enterprise Fusion allows empty layers. This works well if you are
using a dynamic data set you want to display.

The Feature tab displays the current settings for the selected rule. If you add rules, you can select any rule on the Rules list to display
its settings on the Feature tab. See Adding a rule for more information.

The Filter tab lists any filters for the rule selected in the Rules list. See Filtering Vector Data in this chapter for more information
about the Filter tab.

When you click the color button  anywhere it appears (regardless of what color it is), the Select Color dialog appears.

The Display Rules Window

Selecting Colors

Thematic Filters

Allow Feature Duplication

Allow Empty Layer

Feature Tab

Filter Tab



Click to select the desired color from the color grid on the left or the color spectrum on the right. To change the transparency of the
lines, specify the desired Alpha channel value.

The Alpha channel value can range from 0 to 255, where 0 is transparent and 255 is solid. If you specify a slight transparency,
underlying geographic imagery is not obscured by the feature when viewed in Google Earth EC. To determine the correct
transparency setting, first select a mid-range number, such as 127, and view the results in Google Earth EC. Adjust from there as
needed.

Thematic filters allow you to create a series of filters to show data with a particular theme. The following procedure guides you through
creating thematic filters that show counties in California with the highest population in a dark shade of green, the lowest population in
a light shade of green, and three mid-levels of population in a medium green.

Note: The Thematic Filter Editor replaces any rules you might have defined previously.

1. Click Thematic Filters on the Display Rules dialog.

The Thematic Filtering Editor appears. The Thematic Filters Editor automates the creation of a series of filters.

Notice that under Color Ramp, Start Color is set to white, End Color is set to red, and Classes is set to 3. These are the
default settings, which result in dividing the values of the selected attribute (or column) into three equal-size classes (or as close
as possible) and assigning the colors white, pink, and red to those classes. In the table in the lower half of the dialog, the Color
column lists three classes--white, pink, and red. Listed next to each color is its RGB value.

2. Select the field from the Attribute list that contains the data you want to filter.

Google Earth Enterprise Fusion divides the number of data values for the selected field by 3 (the default number of classes) and
fills in the Break Value and Class Count columns.

Note: You do not need to (nor should you) change the Break Value and Class Count values.

3. Select the number of filters you want to create from the Classes drop-down list.

Google Earth Enterprise Fusion divides the number of data values for the selected field by the selected Classes value and
recalculates the Break Value and Class Count fields.

4. Click the Start Color button and select a color.
5. Click the End Color button and select a color.

Creating Thematic Filters

To create thematic filters:



The Color column lists the shades of color to be used and the RGB value of each color.

6. When you finish defining the thematic filters, click OK.

The thematic filters appear in the Rules list in the Display Rules dialog, replacing any rules you might have defined previously.

7. Click each rule on the list to see that rule’s display attributes on the Feature tab and its filters on the Filter tab.

When you publish a database that contains the layer associated with these display rules, it looks something like this:

The following procedures describe how to add, copy, reorder, and rename rules and allow feature duplication for multiple filters.

1. Click . The New Rule dialog appears.
2. Enter a name for the rule, and click OK. The new rule appears on the list, and the default settings appear on the Feature and

Filter tabs.

1. Select the rule to copy.

2. Click . Google Earth Enterprise Fusion makes a copy of the selected rule and appends (copy) to its name.

You can use this feature when you want to use the properties from an existing rule to build a new one.

1. Select the rule to move.

Additional Rule Configuration Options

To add a rule:

To copy an existing rule:

To reorder a rule in the list:



2. Click  or  to move the rule up or down in the list.

The rules are executed in sequence, so it is typical to list the most exclusive rules before the least exclusive.

1. Double-click the desired rule. The Rename Rule dialog appears.
2. Enter a new name for the rule, and click OK. The new name appears on the list of rules.

Check the box next to Allow Feature Duplication below the list of rules.

The first option in the Display Rules dialog is Draw Features As, and you can select Points, Lines, or Polygons. The default setting
reflects the type of data you are configuring. For example, if you are configuring point data, Points is the default selection. If you are
configuring line data, Lines is the default selection.

The options that appear in this dialog are based on the option selected for Draw Features As. This section describes the display rule
options for point features.

If you have a large number of point features in your data, you can simplify the data set by displaying a subset of points instead of the
entire data set. Select the simplification method you prefer from these options:

Maximum Fit per Tile - This is the default simplification method, which displays the maximum number of point features possible
per tile without sacrificing good visibility. (See The Toolbar in the Fundamentals chapter for more information about turning the
grid on and off.)
Representative Subset per Tile - You can control the number of point features displayed by specifying the decimation ratio. If
you select this option, you can specify any of the following:

Choose % points - The percentage of point features that appear at certain levels to represent the whole set of available
points.
Min Points - Set the minimum number of point features to display per tile.
Max Points - Set the maximum number of point features to display per tile.

Note: The minimum and maximum points impose limits on the percentage you set. For example, if you specify 50% with a
minimum of 20 points and a maximum of 500 points:

If your data set includes 100 points, Google Earth EC displays 50 data points.
If your data set includes only 10 points, Google Earth EC displays all 10 points, because the full data set is less than the
minimum you specified.
If your data set includes 100,000 points, Google Earth EC displays only 500 points, the maximum you specified.

Point primitives that have exactly the same coordinates and exactly the same label attributes qualify as duplicates. Check this box to
automatically suppress duplicate point features.

The Elevation/Height option allows you to specify whether your data is displayed at ground level or is elevated. If it is elevated, you
can specify either a relative position above ground level or an absolute elevation above sea level.

You can specify custom Elevation/Height values for geometry of any feature that uses points, lines, or polygons. The height value can
either be a constant offset or derived from source attribute data. You can use this feature to create powerful theme maps, such as
neighborhoods in a city raised in height based on crime statistics.

The Mode options are:

Clamp to Ground - Select this option if you want your data to appear to be on the ground, regardless of the elevation of the
ground.
Relative - Select this option if you want your data to appear to be hovering a particular height above ground level.
Absolute - Select this option if you want your data to appear to be hovering at a certain elevation above sea level.

If you select Relative or Absolute, the following options become available:

Extrude - Check the box for this option if you want a drop line for points. This results in your point features appearing to be
attached to the ground and projecting up to the specified height.
User-Defined Height - Check the box for this option if you want to display the features in your source data with elevation that
reflects the values of particular type of data. For example, if you have source data that includes population by county in a
particular state, you can display the counties at different heights based on population. A county with a dense population can be
displayed higher than a county with a sparse population. When you select this option, you must specify:

Height Variable (m) - Click the insertion button (...), and select a field from the Insert Field drop-down list. Using the
same example, you would select the Population field.

Configuring Display Rules for Points

To rename a rule:

To allow feature duplication for multiple filters:

Simplification Method

Suppress Duplicate Points

Elevation/Height



Then determine your input ranges from the data and calculate the values for Offset and Scale. For example, if:

    Population = 20,000 - 150,000

    Target Height = 10 - 200 meters

use the following linear transformations:

    target height = 10 + ( (population - 20,000) / (150,000 - 20, 000) ) * (200 - 10)

    offset = ( ( 20,000 * (200 - 10) / (150,000 - 20,000) ) + 10

    scale = (200 - 10) / (150,000 - 20,000)

Offset (m) - Enter the result of the offset calculation. (For this example, it is 39.2307692.)
Scale - Enter the result of the scale calculation. (For this example, it is 0.00146153.)

When you select the Draw Label checkbox, the label options become available.

The Draw Label section appears on the right side of the Display Rules dialog when you are defining display rules for points or
polygons, or if you do not click Draw As Roads when you are defining lines.

The label options are:

Visibility
The Visibility option allows you to specify the display level range at which your data is visible in Google Earth EC. The default
values for the range are 5 and 24. To determine your visibility setting, preview the layer in the Preview pane.

Note: For geographically dense data, the data should only be visible when the user has sufficiently zoomed in to the area.
Otherwise, the data clutters the view of the Earth from a high perspective. In addition, drawing dense vector data at a high
level unnecessarily increases data processing time.

If you change the lower end of the range, Google recommends that you set it to no less than 4.

Label Properties
The Text/JS Text option allows you to specify the text that appears on the label. Select the option you prefer from the drop-
down list, and then click the empty text field to open an editor.

Text - The Label Format dialog appears. The Insert Field drop-down list contains the names of all of the fields in your
source data. Select a field name from the list, and click OK. For example, if you select NAME, the names of the roads
appear in Google Earth EC.
JS Text - The JavaScript Editor appears, and you can compose a JavaScript expression, which returns the string to use
as the label.

Select a field (or function, if you have created any) on the left, and click Get Values to display the values of that field for
the selected data set in the Field Values list on the right.

Tip: If your data set is very large, it can take a long time to find all of the values. In that case, a progress dialog appears
showing you an ongoing count of how many values it has found. You can click Cancel on that dialog at any time to stop
scanning your source file for unique values and populate the Field Values list with the unique values found so far.
Typically, it stops finding unique values part way through the file. So when the counter virtually stops, that is a good time
to click Cancel without concern that you might be missing some unique values.

You can use the buttons in this dialog to help you write your JavaScript expression.

Draw Label



When you finish creating your JavaScript expression, click OK. The expression appears in the JavaScript field on the
Display Rules dialog.

Color and Scale - Select the color and enter the scale for the label when it is highlighted (selected) and normal (not
selected).

Color - Click the Color button and select a color.
Scale - Enter the magnification factor of the text label. The default value is 1, which is equivalent to the value the user sets
in Google Earth EC preferences. Greater than 1 makes the text size larger than the user’s preferred size. Less than 1
(such as 0.9) makes the text smaller than the user’s preferred size.

Note: Setting the scale to less than 1 could potentially yield invisible text labels, depending on the label size preference
users set in Google Earth EC.

Center Label - If you check the Center Label box, the label appears centered over the point in Google Earth EC. If you do
not check this box, the label appears to the right of the point.

When you select the Draw Icon checkbox, the icon options become available.

You can select the icon you want to use when it is highlighted (selected) and normal (not selected) and the background color and
scale of each.

Color - Click the button next to Color, and select a color.
Scale - Determines the relative size of the icon. The default value is 1, which displays the icon in Google Earth EC at its original
size. To make the icon smaller, enter a value less than 1 in decimal. This option is useful when you want the highlighted
(selected) icon to appear larger than the normal icon (not selected). For example, you could enter 0.8 for the normal icon and 1
for the highlighted icon.
The Balloon options allow you to define the text and images that appear in the description balloon, as well as certain display
properties.

The Text/JS Text option allows you to specify the text that appears in the description balloon. Select the option you prefer
from the drop-down list, and then click the empty text field to open an editor.

Tip: You can include HTML to point to an image, if desired. To do so, use standard HTML code, such as <img
src=”http://www.example.com/image.jsp?newImages=true&imageId=1191”>. If you do so, you must ensure that the
image you reference actually appears in the location you specify.

Text - The Label Format dialog appears.

The Insert Field drop-down list contains the names of all of the fields in your source data. Select a field name from
the list, and click OK. For example, if you select NAME, the names of your features appear in Google Earth EC.

Alternatively, you can click Auto Populate to automatically insert the name of every field in the source data and its
value.

When you use the Auto Populate feature and a user clicks the icon for a point in Google Earth EC, all of the data
associated with the point appears in the description balloon. For example, if the data set includes state, county, zip
code, and sales tax percentage for each data point, the description balloon might look like this:

Draw Icon



JS Text - The JavaScript Editor appears, and you can compose a JavaScript expression, which returns the string to
use as the label. See Label Properties for more information about this editor.

Style - The Style option allows you to define certain properties of the description balloon. Select an option from the drop-
down list.

Default - Select Default to make any of the following changes to the balloon properties:
Select Use Label as Title if you want to use the text you defined in Label Properties as the title of the description
balloon. If you do not check this box, the description balloon has no title.
Select Directions if you want to include To here and From here links in your description balloon. By default,
these links are not included.
Select Text Color to choose a color.
Choose a Background Color.

Advanced - Select Advanced to enter your own JavaScript for the description balloon display properties.
Click the empty text field. The Balloon Style Text dialog appears. Click Insert Default Text to insert the
JavaScript for the default text in the text editing field. Now you can edit the JavaScript to change the appearance
of the description balloon. When you are done editing, click OK.

The first option in the Display Rules dialog is Draw Features As, and you can select Points, Lines, or Polygons. The default setting
reflects the type of data you are configuring. For example, if you are configuring points data, Points is the default selection. If you are
configuring line data, Lines is the default selection.

The options that appear in this dialog are based on the option selected for Draw Features As. This section describes the display rule
options for Lines.

The Visibility option allows you to specify the display level range at which your data is visible in Google Earth EC. The default values
for the range are 4 and 24. To determine your visibility setting, preview the layer in the Preview pane.

Note: For geographically dense data, the data should only be visible when the user has sufficiently zoomed in to the area.
Otherwise, the data clutters the view of the Earth from a high perspective. In addition, drawing dense vector data at a high level
unnecessarily increases data processing time.

Note: If you change the lower end of the range, Google recommends that you set it to no less than 4.

The value you specify is used in Google Earth Enterprise Fusion’s simplification algorithm to determine the maximum pixel error
tolerated when displaying line vector data. The default is 0.5 pixels, which is appropriate in most cases.

Note: This functionality is intended for expert users.

Caps the level at which vector packets are built for a particular display rule. For example, if you want to see roads to level 24, set the
Visibility through level to 24 and Max Resolution Level to 18. This builds the roads at level 18, but those roads are visible down to
level 24 (the maximum level displayed in the Google Earth Client). Max Resolution Level defaults to 18 because beyond level 18, the
number of packets and subsequent build time and database size quickly become unwieldy. If you set the Max Resolution Level
beyond 18, monitor the vector fuse build to determine how many packets will be built and how long this will take. A warning message
is displayed if you try to set both Max Resolution Level and the Visibility through level to greater than 18.

Select this option if your line data represents roads. When you do so, the Road Label option becomes active, and the right side of the
dialog changes to road-related options. For Road Label Type, if you select Label, only the Road Label section on the right becomes
available. If you select Shield, both the Road Label and Road Shield sections become available. See Road Labels and Shields
below for details.

Do not select this box if your line data represents something other than roads (such as rivers or streams), do not check this box. See
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Drawing Labels for more information.

The draw style options allow you to specify the color, transparency, and width of the lines used to represent your line data.

Line Color - To set the color and transparency, click the button next to Line Color, and select a color.
Line Width - The default line width is 1. To change the line width, enter the desired value. The larger the number, the thicker
the line. For example, if you would like to overlay a subway map, you might want to set the scale to 4 or 5 so that the drawing
resembles a real-world subway map.

Note: Setting the line width to less than 1 could potentially yield invisible text labels, depending on the label size preference
users set in Google Earth EC.

The Elevation/Height option allows you to specify whether your data is displayed at ground level or is elevated. If it is elevated, you
can specify either a relative position above ground level or an absolute elevation above sea level.

You can specify custom Elevation/Height values for geometry of any feature that uses points, lines, or polygons. The height value can
either be a constant offset or derived from source attribute data. You can use this feature to create powerful theme maps, such as
neighborhoods in a city raised in height based on crime statistics.

The Elevation/Height options are:

Clamp to Ground - Your data appears to be on the ground, regardless of the elevation of the ground.
Relative - Your data appears to be hovering a particular height above ground level.
Absolute - Your data appears to be hovering at a certain elevation above sea level.

If you select Relative or Absolute, the following addition options become available:

Extrude - Draw side walls for lines that are elevated. Your line features appear to be attached to the ground and project up to
the specified height.
User-Defined Height - See the description of User-Defined Height earlier in this chapter.

When you select Draw As Roads on the left side of the Display Rules dialog and select Label for the Road Label Type, the Road
Label section appears on the right. If you select Shield for the Road Label Type, both the Road Label and Road Shield sections
appear on the right.

Road Label

These options allow you to define the text that appears on the road label.

The Text/JS Text option allows you to specify the text that appears on the label. Select the option you prefer, and then click the
empty text field.

Text - The Label Format dialog appears.

The Insert Field drop-down list contains the names of all of the fields in your source data. Select a field name from the list,
and click OK. For example, if you select NAME, the names of the roads appear in Google Earth EC.

JS Text - The JavaScript Editor appears, and you can compose a JavaScript expression, which returns the string to use as
the label. See Label Properties for more information about this editor.

Select the Apply standard formatting box to apply the standard Google Earth Enterprise Fusion text formatting to road data
labels. With this formatting:

Street and road names are displayed with initial upper case letters.
Directional modifiers, such as N, E, S, W, appear in upper case.
Some words (such as “Ramp” and “Intersection”) are removed.
Extra white space between the fields is removed.

Color - Select a color and transparency value to use for road labels.
Scale - Determines the magnification factor of the text label. The default value is 1, which is equivalent to the value the user
sets in Google Earth EC preferences. Greater than 1 makes the text size larger than the user’s preferred size. Less than 1
(such as 0.9) makes the text smaller than the user’s preferred size.

Note: Setting the scale to less than 1 could potentially yield invisible text labels, depending on the label size preference users
set in Google Earth EC.

Road Shield

These options allows you to define the shield that appears on the road. The options are:

Icon - Determines the actual road shield icon that appears on the roads. To change the icon, click it. The Icons dialog appears.
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The Standard tab displays all of the standard icons that Google Earth Enterprise Fusion provides. The Custom tab displays any
custom icons you have created and imported using the Icon Manager.

Select the icon of your choice, and click OK. The new icon appears next to Icon under Road Shield.

Scale - Determines the relative size of the icon. The default value is 1, which displays the icon in Google Earth EC at its original
size. To make the icon larger, enter a value greater than 1. For example, to render the icon twice as large as the original
graphic, enter 2.

The first option in the Display Rules dialog is Draw Features As, and you can select Points, Lines, or Polygons. The default setting
reflects the type of data you are configuring. For example, if you are configuring points data, Points is the default selection. If you are
configuring line data, Lines is the default selection.

The options that appear in this dialog are based on the option selected for Draw Features As. This section describes the display rule
options for Polygons.

The Visibility option allows you to specify the display level range at which your data is visible in Google Earth EC. The default values
for the range are 4 and 24. To determine your visibility setting, preview the layer in the Preview pane.

Note: For geographically dense data, the data should only be visible when the user has sufficiently zoomed in to the area.
Otherwise, the data clutters the view of the Earth from a high perspective. In addition, drawing dense vector data at a high level
unnecessarily increases data processing time. 

If you change the lower end of the range, Google recommends that you set it to no less than 4.

The value you specify is used in Google Earth Enterprise Fusion’s simplification algorithm to determine the maximum pixel error
tolerated when displaying polygon data. The default is 0.5 pixels, which is appropriate in most cases.

Note: This functionality is intended for expert users.

Caps the level at which vector packets are built for a particular display rule. For example, if you want to see polygons to level 24, set
the Visibility through level to 24 and Max Resolution Level to 18. This builds the polygons at level 18, but those polygons are
visible down to level 24 (the maximum level displayed in the Google Earth Client). Max Resolution Level defaults to 18 because
beyond level 18, the number of packets and subsequent build time and database size quickly become unwieldy. If you set the Max
Resolution Level beyond 18, monitor the vector fuse build to determine how many packets will be built and how long this will take. A
warning message is displayed if you try to set both Max Resolution Level and the Visibility through level to greater than 18.

Note: Fusion does an analysis of size of features during the import of vector resources and based on this analysis states in
resource import log the Recommended Min/Max and Efficient Resolution Levels.

The Recommended Min Resolution Level corresponds to the LOD at which the largest feature of the vector resource has a
diameter equal to 1/8 of the tile size.
The Recommended Max Resolution Level corresponds to the LOD at which the smallest feature of the vector resource has a
diameter equal to 1/8 of the tile size.
The Efficient Resolution Level corresponds to the LOD at which the average feature of the vector resource has a diameter
equal to 1/8 of the tile size.

These values can be helpful in setting the Visibility levels and the Max Resolution Level. So based on the Recommended Min
Resolution Level you can set the Visibility min level. And based on the Recommended Max Resolution Level you can set the
Visibility max level and the Max Resolution Level. 
For example, if you want to see the maximal feature of the data set with visible size not less than 1/8 of the tile size at the
corresponding LOD you need to set the Visibility min level equal to the Recommended Min Resolution Level. Each level doubles
the resolution, so if you want to see the maximal feature of the data set with visible size not less than 1/4 of the tile size you need
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to set the Visibility min level equal to the Recommended Min Resolution Level + 1 and vice versa, if you want to see the maximal
feature of the data set with visible size not less than 1/16 of the tile size you need to set the Visibility min level equal to the
Recommended Min Resolution Level - 1. 
The same logic is applied to the minimal feature of the data set and setting the Visibility max level and the Max Resolution
Level. For example, if you want to see the minimal feature of the data set with visible size not more than 1/8 of the tile size at the
corresponding LOD you need to set the Visibility max level equal to the Recommended Max Resolution Level. Each level doubles
the resolution, so if you want to see the minimal feature of data set with visible size not more than 1/4 of the tile size at the
corresponding LOD you need to set the Visibility max level equal to the Recommended Max Resolution Level + 1 and vice versa,
if you want to see the minimal feature of the data set with visible size not more than 1/16 of the tile size you need to set the
Visibility max level equal to the Recommended Max Resolution Level - 1. 
For setting the Max Resolution Level the rule sounds like if you want to build the data set with resolution until minimal feature of
the data set has visible size not more than 1/8 of the tile size at the corresponding LOD you need to set the Max Resolution
Level equal to the Recommended Max Resolution Level and so on. 
The Efficient Resolution Level in pair with range of the Recommended Min/Max Resolution Levels can be useful in case you have
a large variance in your feature size distribution (it can be estimated based on the range of the Recommended Min/Max Resolution
Level). For such data sets if the Efficient Resolution Level is closer to the Recommended Max Resolution Level then you have a
data set which contains primarily small features and so you can increase the Visibility min level up to Efficient Resolution Level.
And vice versa, if the Efficient Resolution Level is closer to the Recommended Min Resolution Level then you have a data set
which contains primarily large features that may be properly represented at the lower LOD and so you can decrease the Max
Resolution Level down to the Efficient Resolution Level.

You can use the Draw Style options to render filled 2D and 2.5D (extruded) polygon primitives.

You can render polygons in filled, outlined, or both modes. You can also render polyline data sets as filled polygons.

Mode - The Mode option indicates whether the polygons appears as outlined, filled, or both in Google Earth EC.
Fill Color - Select a fill color and transparency value for the polygon.
Outline Color - Select an outline color and transparency value.
Outline Width - The default outline width is 1.0. To change the outline width, enter the desired value. The larger the number,
the thicker the outline.

Note: Setting the outline width to less than 1 could potentially make it invisible.

The Elevation/Height option allows you to specify whether your data is displayed at ground level or is elevated. If it is elevated, you
can specify either a relative position above ground level or an absolute elevation above sea level.

You can specify custom Elevation/Height values for geometry of any feature that uses points, lines, or polygons. The height value can
either be a constant offset or derived from source attribute data. You can use this feature to create powerful theme maps, such as
neighborhoods in a city raised in height based on crime statistics.

The Elevation/Height options are:

Clamp to Ground - Your data appears to be on the ground, regardless of the elevation of the ground.
Relative - Your data appears to be hovering a particular height above ground level.
Absolute - Your data appears to be hovering at a certain elevation above sea level.

If you select Relative or Absolute, the following addition options become available:

Extrude - Draw side walls for lines that are elevated. Your line features appear to be attached to the ground and project up to
the specified height.
User-Defined Height - See the description of User-Defined Height earlier in this chapter.

When you select Draw Label, the label options become available. See Drawing Labels for details.

Filtering Vector Data

From the Display Rules window, click the Filter tab to access filter-related features.

A filter is a pattern expression that is applied to a specific field of a vector resource. When the pattern expression matches the
specified field in the associated vector data, Google Earth Enterprise Fusion selects the matching records and applies the feature
settings for the rule to those records. Filters are inclusive.

Note: Filters match string and numeric data only, not dates and other complex patterns.

To create an expression, select a field to match from your resource, select an operator, and enter a value to match. Alternatively, you
can write a JavaScript expression (see To add an expression for details).

For example, if you have census data by county in California, you can use filters to graphically represent counties with:

Population under 500,000.
Population between 500,000 and 2,500,000 inclusive.
Population over 2,500,000 (the remaining counties - no need for a filter).

The following graphics show these three filters:

Draw Style

Elevation/Height

Draw Label



 

In Google Earth EC, these filters and display rules result in the colors you assigned for each rule distinguishing the counties with the
population ranges you specified in the filters:

1. From the Filter tab of the Display Rules window, click More. A new undefined expression appears on the list with the first field
in the resource selected by default.

2. If you will be defining more than one expression for your filter, use the drop-down list above the filter list to define how restrictive
you want the filter to be. If you will be using one expression, accept the default value, Match all of the following.

If you select:

Match all of the following expressions, the data must match all expressions in the filter, or the associated rule is not
applied.
Match any of the following expressions, the data can match any one or more of the expressions for the associated rule
to be applied.
JavaScript Expression, click the insertion button (...) to the right of the empty text field to display the JavaScript Editor.
The results of the expression are interpreted as Boolean. If the Boolean is true, the feature matches. If the Boolean is false,
the feature does not match.

3. Select the field that you want to match from the first drop-down list in the filter window.
4. Select an operator from the second drop-down list. Filter operators are described in the next section.

To add an expression:



5. Enter the value to match in the text field.
6. Click More to add another expression to the filter, if desired. Click OK to save the filter.

Example

Operator Value in the text field: Matches:

equals1 2000 Only 2000

is less than or equal to 2000 2000 or any number less than 2000

is greater than or equal to 2000 2000 or any number greater than 2000

is less than 2000 Any number less than 2000

is greater than 2000 Any number greater than 2000

is not equal to 2000 Any number other than 2000

matches [hc]?at Only hat, cat, and at

does not match [hc]?at Anything other than hat, cat, and at

If you select equals or is not equal to, you can use wildcard characters when matching against a string in the vector data. The
supported wildcard characters are:

Wildcard Description Example

* Matches zero or more characters. To display all states that end in the
letter a:

? Matches exactly one character (any
character).

To display all states whose second
letter is “o”:

[] Matches the specific character(s) or range of
characters listed in the brackets.

To display all states whose second
letter is either “a,” “o,” or “n.”

To display all states that begin with
letters “A” through “M.”

Note: The full set of wildcard characters is not currently available in Google Earth Enterprise Fusion, so forward and back slashes
are not treated as special. For character negation, select is not equal to expression from the expression operator drop-down list.

If you select matches or does not match, you must enter a regular expression pattern in the text field instead of a text value. Regular
expressions are much more powerful than wildcard characters. Google Earth Enterprise Fusion does not support full Perl regular
expression functionality, but it does support most standard regular expressions.

For example:

^M -- Matches all values that begin with “M”

a$ -- Matches all values that end with “a”

(North|South) -- Matches all values that have “North” or “South” anywhere in the text

1. Click Fewer. The last expression on the list disappears.

*a

?o*

?[aon]*

[A-M]*

Filter Operators
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2. Repeat until you have removed all of the expressions desired.
3. Click OK to save the filter.

If you have only a single rule defined for your vector data and you want to display all of the data available, simply leave the filter
undefined.

If you have one or more filter-rule combinations defined but want to display all of the data available, you can add a final rule with no
filter definition to match all elements not matched by previous rules. This results in the application of the final rule to all elements not
matched by previous rules.

Keep in mind the following conventions when using multiple rules and filters for your vector data.

Rules and filters are meant to operate together.
A rule is the collection of settings on the Feature and Filter tabs, but you must provide a distinct filter for each rule in the list in
order to have distinct features or labels for different data.

The order of your rules determines which filter is applied to the data.
For example, you might specify the following rule-filter combinations:

Filter 1: All parcels with IDs over 30.

Rule 1: Display boundaries in red.

Filter 2: All parcels with IDs between 30 and 40.

Rule 2: Display boundaries in blue.

In this case, all boundaries shown are red, because filter 1 includes all of the data that would be covered by filter 2. Rule 2
never gets applied.

To achieve the desired effect, you must reverse the order of these filter-rule combinations:

Filter 1: All parcels with IDs between 30 and 40.

Rule 1: Display boundaries in blue.

Filter 2: All parcels with IDs over 30.

Rule 2: Display boundaries in red.

Then rule 1 is applied to the parcels with IDs between 30 and 40, so those boundaries are blue, and rule 2 is applied to parcels
with IDs over 40, so those boundaries are red.

For adjoining boundary data, most recent matches overlay prior matches.
When you are matching line data that is adjoining, such as boundary data, the last items matched are displayed on top.
Consequently, if two parcels share a boundary and the last display rule sets boundary color to red, the boundary between the
two parcels is red.

Using the example above, if parcel 40 is surrounded by parcels with IDs greater than 40, the boundaries around parcel 40 are
red, not blue, even though the filter accurately applies blue boundaries to parcel 40. This is because all the parcels surrounding
40 are configured with the last filter, which, in effect, “covers” their boundaries with the surrounding red boundaries.

Character matches are case sensitive.
You can use square brackets to provide both upper and lower case characters to allow for case-insensitive matching. For
example, if you want to match both ID and id, you can enter [Ii][Dd] to be sure both versions are considered a match.

Exporting and Importing Display Rule Templates

You can export a set of display rules as a template, and then later import the template to apply the same display rules to other vector
layers. The template contains all of the filters and formatting information that you specified for the associated layer.

When you export display rules, Google Earth Enterprise Fusion saves the information in a file with a name and in a location of your
choice. You can save it on your local workstation, or you can save it in a shared folder on a network drive, so that other users in your

To select all, defining no specific filter:

To select all remaining elements after other filter-rule combinations are applied:

Filtering Conventions



organization can access it.

You can use the template file:

To ensure that multiple layers in the same project or in different projects have identical configuration.
To create display rules for multiple layers that you want to look the same except for minor changes.
As a backup. For example, you can save the template file, along with the vector resource’s KVP file, on a separate computer.
Then, if your asset root gets damaged by disk failure and you do not have a more integrated backup solution, you can create a
new resource from the KVP file and quickly reconfigure the layer in a new project by importing the template.
To use with projects you create using shell commands. See Creating a Vector Project for more information.

The following sections describe how to export and import display rule templates.

When you finish configuring the filters and display rules for a vector layer, you can export the settings as a template file. You can also
use the template at the command line when adding to a vector project in batch mode. See Project Commands in the Command Line
Reference chapter for details about using display templates from the command line.

1. In the Vector Project Editor, right-click the vector layer whose display settings you want to export.
2. Select Export Configuration as Template from the context menu. The Export Template dialog appears.

3. Navigate to the folder where you want to save the template, or click  to create a new folder in the desired location.
4. Click Save. Google Earth Enterprise Fusion saves the file with a .khdsp extension.

After you export display rules as a template file, you can import the template and apply those display rules to other vector layers.

1. In the Vector Project Editor, right-click the vector layer to which you want to apply the saved settings.

2. Select Import Configuration from Template from the context menu. The Import Template dialog appears.
3. Navigate to the template file that contains the settings you want to apply, and select it.
4. Check one or both of the boxes at the bottom of the dialog as follows:

Check Apply display rules to apply only the display rules from the template to the layer.
Check Apply legend settings to apply only the legend settings from the template to the layer.
Check both boxes to apply both the display rules and legend settings from the template to the layer.

5. Click Open. Google Earth Enterprise Fusion applies the settings contained in that template to the selected vector layer.

After you apply the template, be sure to confirm that the results are as you intended. If you apply a template to data that does not
contain the exact same attributes as the original data for which that template was created, you might need to modify the display rules
for the current data. To view the settings or make modifications to them, perform the steps described in the section titled Configuring
Display Rules.

Defining Imagery and Terrain Projects

Within each type of project, you can add multiple resources of the same type. However, unlike vector projects, the entire imagery
project appears as a single layer in Google Earth EC, regardless of how many source files it includes. See Display Order of Imagery
and Terrain Resources for details.

The first step in defining an imagery or terrain project is to specify which resources to include and give the project a name.

Exporting Display Rules

Importing Display Rules

Creating an Imagery or Terrain Project

To export a display template:

To import a display template:



The following instructions describe how to create an imagery project, but the steps are the same for a terrain project as well.

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Imagery Project editor appears.

3. If you are creating a historical imagery project, select the Support Historical Imagery option. An acquisition date must be
defined for this imagery.

4. Specify values in the Legend area for the entire imagery project by clicking the following fields under default:
Icon: The icon that appears in the legend in Google Earth EC.
Name: The text label that appears in the legend in Google Earth EC.
Initial State: Determines whether the imagery is turned on or off by default in Google Earth EC. The first time a user
connects to the database containing this imagery:

If you select On (the default) as the initial state here, the check box for the imagery is automatically checked.
If you select Off as the initial state here, the check box for the imagery is automatically unchecked.

Google Earth EC saves the state of the check box when a user disconnects from the database. For example, if you set the
initial state to Off, and then a user subsequently checks the box for an imagery project in Google Earth EC and then
disconnects from the database, the next time that user connects to that database, the state of the check box for that
imagery is the same as when the user disconnected; that is, the box is checked.

LookAt: If you specify a KMZ file in this field, Google Earth EC users can fly directly to a particular camera view by double-
clicking the layer. See LookAt.

5. If you want to add language support for additional locales, uncheck the box next to Hide unspecialized locales. See the
Legend Tab section for more information about this option.

6. Click . The Open dialog appears.
7. Navigate to the folder that contains your imagery resources.

Note: The selection in the Type drop-down list near the bottom of this dialog determines the type of resources that appear
on the list. Imagery Resource is automatically selected when you open this dialog from the Imagery Project Editor, so only
imagery resources appear on the list.

8. Select the resource you want to add to the project, and click Open. The selected resource appears in the Imagery Project Editor.

9. Repeat steps 6 through 8 for each additional resource you want to include in the project.
10. When you finish adding resources, select File > Save.

11. Navigate to the folder where you want to save your project, or click  to create a new folder in the desired location.
12. Enter the name of your project, and click Save. The new project name appears in the Asset Manager’s asset list.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are no longer available to use in
Google Earth Enterprise Fusion; see Cleaning Asset Versions in the Building Assets chapter for more information.

There are some additional actions you can take with resources after you add them to an imagery and terrain project, including:

Check the box next to Preview to display a preview of the project in the Preview pane. A bounding box appears for each

To create an imagery project:



resource in the project. When Preview is checked, you can right-click a resource and select Zoom to Layer to zoom in on that
resource.
Rearrange the order of the resources. See the next section, Display Order of Imagery and Terrain Resources for restrictions and
To reorder layers in a project for additional information.
Lower the resolution. You might want to take this action if a resource is much higher resolution than you need. You can
artificially lower the resolution for a resource within a project without affecting the original resource or any other projects that use
it.

To lower the resolution of a resource, right-click it and select Adjust Max Level Override. Then drag the slider to the left to
adjust the resolution down. Click outside the slider to apply the new setting to the resource. The override appears in parentheses
after the name of the resource in the Project Editor.

To force a resource with lower resolution to appear above a resource with higher resolution, you can lower the resolution of the
higher resolution resource as described above and then use the arrow keys to move it below the lower-resolution resource.

Note: The number of imagery resources that you can include within a single project is currently over 3000. If you add more that
3000 resources, you could experience a performance degradation when you build the project.

Tip: Every imagery and terrain project should include at least one resource that spans the entire Earth, such as BlueMarble or
gtopo30. Everywhere you have a high-resolution inset, you should include a medium-resolution inset between it and BlueMarble.

As with vector projects, you can build imagery and terrain projects individually, build several projects at the same time, or wait until you
build your database to build all of its projects at the same time. See the Building Assets chapter for complete details.

Although you can change the display order of imagery and terrain resources within a project, the order is ultimately determined by the
resolution of the source files. That is, lower-resolution insets are automatically ordered below higher-resolution insets. So in reality, you
can change the order of resources with the same resolution only.

In addition, the resolution of the imagery inset determines its optimal display level.

The following example shows several imagery resources in a project ordered by resolution. The resolution of each resource appears in
parentheses after the resource name.

The order in which the imagery or terrain resource data appears in the Imagery and Terrain Project Editors is the same as the
stacking order of the insets in Google Earth EC. That is, higher-resolution insets appear above lower-resolution insets, so that viewing
preference is given to the higher-quality imagery. The stacking order of same-resolution insets follows the order you define in the
project. The following graphic illustrates this concept.

Display Order of Imagery and Terrain Resources



Creating a Historical Imagery Project

Creating a historic imagery project is very similar to a standard imagery projects and differs in two key aspects:

1. a user must select the Support Historic Imagery checkbox in the Imagery Project editor, and
2. each image resource added to the project must have an assigned acquisition date. 

1. Create and build a new imagery resource which includes an acquisition date (in the format YYYY, YYYY-MM, or YYYY-MM-DD).
2. Create a new imagery project, select the Support Historic Imagery option, and add imagery resources to the project.
3. Build the imagery project.
4. Build the database and publish.

Note: Imagery will be ordered by resolution first, and then by acquisition date.  If three 1-meter resolution images for 2009, 2006,
and 1999 are added to the imagery project, they will appear in order in Google Earth EC; however, if the 1999 image is 0.3-meter
resolution it will be layered above the lower resolution (1-meter) 2009 and 2006 images and will always be visible despite having
the time slider set to 2009 or 2006.

Modifying Projects

After you create a project, you can modify it in any of the following ways:

Add another resource.
Delete a previously associated resource.
Modify the project’s layer properties.
Configure display rules for layers in a vector project.
Hide the project so it does not appear in the Asset Manager unless the Show hidden resources check box is selected. With
this feature, you can “turn off” projects you do not need to display regularly, such as those that are incorrectly named.

Note: When you save a modified project, Google Earth Enterprise Fusion replaces the old project definition with the new one.
When you build that new project, Google Earth Enterprise Fusion creates a new version. When you select a project to include in a
database, it is always the latest version of the project. However, your modifications to a project have no effect on earlier versions of
that project that were previously built into a database.

1. Right-click the name of the project you want to modify in the Asset Manager, and select Modify (or double-click the name of the
project). The Project Editor for that project type displays all of the resources currently included in that project.

2. Make the desired modifications. See Defining Vector Projects or Defining Imagery and Terrain Projects for details.
3. When you finish modifying the settings for the project, select File > Save.

Google Earth Enterprise Fusion saves the project in the same place with the same name. If you have already built the project,
you can rebuild it now or when you build the associated database.

Back to top

To create a Historical Imagery Project:

To modify an existing project:
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Overview

This chapter provides information on how to define Google Earth databases with Google Earth
Enterprise Fusion. For information about defining Google Maps databases, see the chapter titled
Defining a Map Database.

Defining a Database

When you finish defining your projects, you define your database. To define a database, you
specify one or more projects whose data functions together on the Google Earth Enterprise Server.
You can select up to three projects for a database--one of each type:

Vector
Imagery
Terrain

Because the majority of your efforts go into defining and configuring projects, it is relatively simple
to define a database. You simply select the projects that comprise the database and give it a
name.

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Database Editor appears with no projects selected.

3. Click  next to Vector Project. The Open dialog appears.
4. Navigate to the folder that contains the vector project you want to include.

Reference Guide
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Note: The selection in the Type drop-down list near the bottom of this dialog determines
the type of projects that appear on the list. Vector Project is automatically selected, so
only vector projects appear on the list.

5. Select the vector project you want to add to the database, and click Open. The selected
project appears in the Database Editor next to Vector Project.

6. Repeat steps 3 through 5 to add imagery and terrain projects. All three projects appear on
the list.

7. To add search tabs for the database, click the box next to Search Tabs. See Adding Search
Tabs to a Database for details.

8. When you've finished defining your database, select File > Save.

9. Navigate to the folder where you want to save your database, or click  to create a new
folder in the desired location.

10. Enter the name of your database, and click Save.

Now you are ready to build your database. See the Building Assets chapter for complete details.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

1. Select Tools > Asset Manager. The Asset Manager appears.
2. In the asset navigation tree on the left, navigate to the folder that contains the database you

want to change, and select it. The database appears on the right.
3. Double-click the name of the database. The Database Editor displays its contents.

To change one of the selected projects, click  next to the project you want to replace. The
Open dialog appears.

1. Navigate to the folder that contains the project you want to include.
2. Select the project you want to add to the database, and click Open. The selected project

appears in the Database Editor.
3. Select File > Save.

To remove a project from the database and not include any project of that type, click  next to
the project you want to remove, then select File > Save.

In both cases, Google Earth Enterprise Fusion saves the database in the same place with the
same name. If you have already built the database, you must build a new version to make the
changes available for publishing.

Adding Search Tabs to a Database

Search tabs allow Google Earth EC and Google Maps users to search external databases on non-
Google servers. For example, if you have a database of property locations that contains specific
information that your users need, you can add a search tab call “Property Search” and configure it
to search for locations in your property database, even if that database is stored on another
server.

The Search Tab Manager allows you to add and pre-configure the standard search tabs to be
used throughout Google Earth Enterprise Fusion. See Managing Search Tabs for more
information. After you have configured the search tabs in the Search Tab Manager, you can select
the search tabs you want to use for each database you define.

To modify a database:



Note: Regardless of how many search tabs you add, even if you add only one or two, the
custom search tab(s) replace all three default search tabs in Google Earth EC. If you do not
create any tabs, Google Earth EC displays the default search tabs.

1. In the Database Editor, select the Search Tabs checkbox. The Database Editor extends to
include a Search Tabs area.

2. Click  on the right side of the Search Tabs area. A pop-up list displays a list of the
available search tabs.

Note: If you specified search fields for a layer in the selected vector project, the tab label
you provided in the Vector Project Editor for that project appears on this pop-up list. See
Search Tab for details. You can select that search tab or not.

3. Click the name of the first search tab you want to add. The selected tab appears in the
Search Tabs area.

4. You can add up to three search tabs (including the layer-specific search fields, if you
specified them for the selected vector project) by repeating the above steps.

After you add three tabs, the  button is disabled.

5. If you want to delete one of the tabs, select it and click , then OK to confirm.

The tab disappears from the Search Tabs dialog, and the  button is enabled again.

6. To change the order of the search tabs, select the tab you want to move, and then click 

 or  to move it.
7. When you finish defining the search tabs, save the database, as described in Defining a

Database.

Publishing a Database

After you successfully build a database, you are ready to publish it to a Google Earth Enterprise
Server. Publishing a database is fairly straightforward after you set up your server associations.
Consult your administrator or refer to the Administration Guide for complete details about setting
up server associations.

1. Select Tools > Asset Manager. The Asset Manager appears.
2. Navigate to the folder where the database you want to publish is located.
3. Right-click the database name, and select Publish. The Publish Database dialog appears. 

The first server association on the list in the Server Associations Manager is the default

To add search tabs to your database:

To publish a database:



selection on the Server Association drop-down list. The most recently built version of the
database is the default selection on the Version drop-down list.

4. If you want to publish the database to a different server association, select it from the Server
Associations drop-down list; otherwise, leave the default selected.

5. If you want to publish a different version of the database, select it from the Version drop-
down list; otherwise, leave the default selected.

6. Click Publish.
7. If the server is configured for publishing authentication, the Authentication Required dialog

appears.

Enter your user name and password, and click OK.

Contact your system administrator if you do not know your user name and password.

A progress dialog shows you the progress of the publishing operation. When the publishing
operation is complete, a message confirms that the database was successfully published. If the
publishing operation is unsuccessful, see the Common Error Messages chapter for more
information.

Viewing Your Database

After you publish your database, you can view it in Google Earth EC.

1. Launch Google Earth EC. The Select Server dialog appears.
2. Enter or select the URL or IP address of your server in the Server field, and accept the

default setting, 80, in the Port field (unless you know that your server uses a different port).
3. Click Login.

Caution: If you have logged in to this server with Google Earth EC previously, log out, clear
your cache, and log back in. For help with clearing your cache, refer to the Google Earth User
Guide.

Google Earth EC displays your database. The Layers panel shows the terrain, imagery, and vector
layers in the published database.

Back to top

To view your database:

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/errors.html#61436


4.4.1 Documentation

Reference Guide

Home

Introduction

Fundamentals

Setting Up Your
Workspace

Defining Resources

Defining Projects

Defining and Publishing
Databases

Building Assets

Preparing Data for Google
Maps

Command Line Reference

Creating Your Own Source
Data, Icons, and Masks

HTML Tags Allowed

Google Earth Plugin

Common Error Messages

Glossary

Legal Notices

Overview
Building an Asset
Debugging Asset Builds
Resuming Failed Asset Builds
Marking Asset Versions as Bad
Cleaning Asset Versions
Monitoring Current and Recent Activity

Overview

Building assets is the process of preparing each asset for inclusion in another asset--for example,
building resources before you include them in a project.

Google Earth Enterprise Fusion allows you to build each project separately or together with its
associated database. You can also build imagery and terrain resources and map layers with their
associated projects or databases. You must build vector resources separately, however, before you
can add them to a project. In fact, most of the work is done at the database level, so building
projects is unnecessary.

You can sometimes optimize your work, however, by building one asset while working on another.

Tip: Since builds occur in the background and Google Earth Enterprise Fusion is always
running, you can close the Google Earth Enterprise Fusion GUI after you start a build, if you do
not need to use it for anything else. In fact, this is a good practice, because it frees up RAM
and CPU cycles on the workstation, which can improve build performance.

Building an Asset

The building process is the same for all assets--resources, map layers, projects, and databases.
This section describes how to build assets, as well as how to debug and resume failed builds, and
clean or mark asset versions as bad.

1. In the Asset Manager, right-click the asset you want to build.
2. Select Build from the context menu.

The status of the asset immediately changes to Queued. If no other jobs are waiting, the
status changes to In Progress.

Note: Sometimes the status changes so fast that it appears to change directly to In
Progress. For very large projects (such as an imagery project with thousands of
resources), however, it can take several minutes before the state changes to Queued or
In Progress. In extreme cases, it can take 30 minutes or longer. During this time, the
Google Earth Enterprise Fusion GUI is unresponsive. Please wait for the GUI to respond.

You can view the progress of the build by double-clicking the Current Version or Current State
column for the asset. The Version Properties dialog displays the most recent version of that
asset. You can expand the version tree to view the status of the build in real time by clicking the +
signs.

Reference Guide
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Note: You can use the shell commands to set up automatic, successive builds for the same
database to ensure that you always have the most up-to-date work for a particular data set.
See the Command Line Reference chapter for more information.

After you build an asset, it is ready to be included in the next step.

Debugging Asset Builds

When you build a new or modified asset, Google Earth Enterprise Fusion assigns it a version
number. Using the Asset Manager, you can determine the status of each version, as well as the
availability of older versions of assets.The table below lists the possible states for each asset.

Status Description

Waiting The asset is waiting for its included assets to finish building.

Blocked The asset build cannot proceed. One or more of its data sources or
subcomponents has failed, is marked bad, or is otherwise unavailable. The
responsible component is listed.

Queued The asset (or its subcomponents) is queued and waiting to be built.

In
Progress

The asset (or subcomponents) is actively being built.

Failed
The asset build failed. Click  next to the failed build in the Version
Properties dialog to see the Asset Log. See Common Error Messages for
more information about each error message that might appear in the log.

Succeeded The asset build (and subcomponents) succeeded.

Canceled The asset build was canceled by a user.

Cleaned The asset version is unavailable, because it has been cleaned.

Bad The asset version is unavailable, because it has been marked as bad.

1. In the Asset Manager, right-click the asset whose version history you want to see, and select
Asset Versions from the context menu.

The Properties dialog displays a list of all of the build versions for that asset, including the
state of each build. The most recent build appears at the bottom of the list.

2. Double-click the build version you want to investigate.

Asset States

To view an asset’s build versions:
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The Version Properties dialog displays the hierarchical relationship of the asset and its
subcomponents.

Note: You can go directly to the Version Properties dialog for the latest asset version
simply by double-clicking its Current Version or Current State field in the Asset Manager.

3. Expand the tree by clicking the + next to each version until you display the element that
caused the build failure.

4. Click  next to the failed build to view the details about a particular failed process.

The log file provides one or more error messages that describe the problem--typically at or near
the end of the command output. With long logs, scroll to the end and then look back for the error
messages. See the Common Error Messages chapter of this guide for more information about the
error messages in the log.

Resuming Failed Asset Builds

If an asset build fails for an external reason (such as running out of disk space or incorrect file
permission settings), you can resume the build after correcting the cause of the failure. When you
resume the build, it starts from the point at which failure occurred, rather than repeating the entire
build process from the start.

In the example shown in the previous section, the error message is Fusion Warning: Failed to
open source and the path and file name that could not open. In that case, the permissions were
set wrong on the source file. After you change permission on that file, so that Google Earth
Enterprise Fusion can open it, your build should be successful.

Note: The Resume command is available for assets with a status of Failed or Canceled only.
Its purpose is to continue a build on an asset where there has been no change to the data itself
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or to the configuration of the asset. If you change the source data or any configuration detail for
the asset, you must start the build from the beginning using the Build command instead of the
Resume command. 

When Google Earth Enterprise Fusion successfully completes a build that failed in the past, it
uses the same version number for that build as for the previously failed build.

1. In the Version Properties window, right-click the line that shows the failed build.
2. Select Resume.

The asset build continues from that point forward.

For more details on resuming asset builds, see Handling Asset Build Failures in the Command
Line Reference chapter.

Marking Asset Versions as Bad

You can mark a successfully built asset version as Bad to prevent it from being used by any
project or database. For example, you might successfully build an asset, but when you preview it,
you realize that it does not look the way you intended.

1. In the Asset Manager, right-click the desired asset, and select Current Version Properties
from the context menu. The Version Properties dialog appears.

2. Right-click the version you want to mark as Bad, and select Mark as bad from the context
menu.

Google Earth Enterprise Fusion immediately changes the state of the asset to Bad.

Cleaning Asset Versions

Each asset you build in Google Earth Enterprise Fusion has a version number, so you can easily
track successive updates to a particular asset. Each version of an asset is saved as a separate
group of data files. Since assets with many versions can take up a significant amount of disk
space, you can use the Asset Manager to clean unused asset versions.

The clean-up process:

Removes the data files for all asset versions associated with the selected version that are
not used by other assets.
Cleans downward.

That is, if you clean a database version, it cleans the associated projects and resources as
well. If you clean a project version, however, it cleans only the associates resources, not any
databases with which the project might be associated. If you clean a resource version, it
cleans that resource version only.

Changes the state of the asset version to Cleaned, which makes that version of the asset
unavailable for use by any other asset.

Cleaning an asset version DOES NOT remove:

To resume a failed build after correcting the cause of the failure:

To mark an asset as Bad:



Any raw source files associated with the selected asset.
Any other versions of the selected asset.
The metadata associated with the asset (such as the version’s build history and the names
of the assets associated with it).
Any asset version that is currently being used in a project or a database.

If you attempt to clean an asset version that is used in another asset, the operation fails, and
Google Earth Enterprise Fusion displays a list of related assets.

Any asset version with an active status (such as In Progress or Queued).

If you attempt to clean an asset version that is in the process of being built, Google Earth
Enterprise Fusion prompts you to cancel the build before cleaning it.

The last good version of resources or projects.

1. In the Asset Manager, right-click the asset you want to clean, and select Current Version
Properties from the context menu. The Version Properties dialog appears.

2. Right-click the version that you want to clean, and select Clean from the context menu.

A message prompts you to confirm that you want to clean the asset.

3. Click Clean.

Google Earth Enterprise Fusion cleans the selected asset version and changes its state to
Cleaned.

Tip: When you want to clean asset versions, start by cleaning databases, working from the
oldest to the most current. In most cases, this process cleans old versions of all of the projects
and resources related to that database.

Monitoring Current and Recent Activity

The System Manager allows you to view the recent activity log and monitor the progress of
background tasks, such as building a database.

1. Select Tools > System Manager. The System Manager appears.

Note: No user operations are allowed in the System Manager. It is for monitoring purposes
only. See getop in the Command Line Reference chapter for the command line equivalent of
this information.

Back to top

To clean an asset version:

To monitor current or recent activity:
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Overview

In addition to using Google Earth Enterprise Fusion to prepare and publish data in Google Earth,
you can use it to prepare and publish 2D map data in Google Maps. This chapter describes all of
the steps to prepare your data for Google Maps. It also describes the Google Fusion Maps API.

The first step in preparing any data for publication is to import the source data as Google Earth
Enterprise Fusion resources. You can use the same vector resources you defined in the Defining
Resources chapter for Google Maps.

Note: For Google Maps, you define vector data only. You can use the same imagery project for
both Google Maps and Google Earth EC databases

After you define and build your vector resources, Google Maps requires an additional step. You
must define and build at least one map layer for each map project. The Defining a Map
Layersection describes how to do so.

The remaining steps are similar for Google Maps data as for Google Earth EC data.

1. Define and build a project.
2. Define and build a database.
3. Publish the map database.

Google Maps Browser Support and Incompatibilities

Google Maps is supported by the following browsers:

Microsoft Internet Explorer (IE) 7.0 and later (for Windows)
Firefox 3.6 and later (for Windows, Mac, and Linux)
Safari 3.1 and later (for Mac and Windows)
Google Chrome (for Windows and Mac)

Even if you are using a supported browser, there are some features in Google Earth Enterprise
Fusion that are not supported by some browsers on certain operating systems. As long as you are
connected to the Internet and have a license key for the Google Maps API, there is no problem
(regardless of your platform), since your server contacts Google’s servers for functions that are not
supported in the browser.

If you do not have a license key or access to the Internet, however, the following features will not
work, since these features require that you connect to a Google server:

Reference Guide
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Directions
Traffic
KML overlays
Geocoding
LocalSearch

In addition, drawing polylines on maps requires the vector drawing facilities of the browser. If a
browser does not support drawing polylines, Google Maps gets the support it requires from the
Google servers via the Internet. If your server does not have access to the Internet and the
browser does not have the required vector drawing facilities, polylines will not appear in Google
Maps. See http://www.google.com/apis/maps/documentation/reference.html#GPolyline for more
information.

Google provides a sample application with Google Earth Enterprise Fusion to support drawing
polylines, if you are not connected to the Internet or do not have a license key for the Google
Maps API. The sample application is in:

The sample application files are:

To create your own application, make a back-up copy of these files, and then edit them for the
desired results.

Caution: Neither this document nor the sample application is intended to teach you how to write
JavaScript. You must test your application during run-time to ensure that it works correctly on
all browsers you intend to support.

Defining a Map Layer

Google Earth Enterprise supports the following types of imagery for a map layer:

Mercator Map. The Mercator Map includes the Google Maps layer and uses the Google
Maps API from google.com. It also uses a local copy of the Google Maps API and has no
communication with google.com.

Flat Projection Map. The Flat Projection Map uses the local copy of the Google Maps API
and has no communication with google.com. The Flat Projection map is useful because the
imagery layers for Google Earth and Maps can share the same database.

Note: The Flat Projection Map us not compatible with the maps.google.com layers that are in
the Mercator Map projection. A Mercator Map and Google Google Earth database require
separate copies of the imagery to work together.

Defining a map layer consists of adding resources to the layer and defining the display rules and
filters for the layer. This section describes how to do so.

1. Select Tools > Asset Manager. The Asset Manager appears.
2. From the drop-down menu, select Mercator Maps Tools (2D) or Flat Projection Map Tools

(2D).

3. Click . The Map Layer Editor appears.
4. Specify values in the Legend area for the entire map layer by clicking the following fields

/opt/google/gehttpd/htdocs/maps

example_google.html
example_local.html
maps_google.html
maps_local.html

To define a map layer:
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under default:
Icon: The icon that appears in the legend in Google Maps.
Name: The text label that appears in the legend in Google Maps.
Initial State: Determines whether the map layer is turned on or off by default in Google
Maps. The first time a user connects to the database containing this map layer:

If you select On as the initial state here, the check box for the map layer is
automatically checked.
If you select Off as the initial state here, the check box for the map layer is
automatically unchecked.

Google Maps saves the state of the check box when a user disconnects from the
database. For example, if you set the initial state to Off, and then a user subsequently
checks the box for a map layer in Google Maps and then disconnects from the
database, the next time that user connects to that database, the state of the check box
for that map layer is the same as when the user disconnected; that is, the box is
checked.

Caution: If you select On as the initial state for the map layer, be aware of the
performance impact on Google Maps. If a user selects too many map layers
simultaneously in Google Maps, it can seriously impact performance. So it is best not
to turn on too many map layers at the same time. In most situations, setting the initial
state to Off is the best choice.

Thematic Filters
Determines which type of thematic information you want displayed in your map layer.
Thematic filters are used to show variations of colors for different values of vector
features.

For example, you can use color polygons to show population differences for different
counties in a state. You can set the filter to analyze the distribution of populations for
the set and then apply a gradient of color to each polygon that represents a county.

Allow Feature Duplication
Determines if the same map feature is displayed.

Allow Empty Layer
Determines if an empty layer in the map is allowed.

5. If you want to add language support for additional locales, uncheck the box next to Hide
unspecialized locales. See the Legend Tab section of the Defining Projects for more
information about this option.

6. Click Add Resource. The Open dialog appears.

7. Navigate to and select the vector resource you want to add to the map layer, and click Open.
The selected resource appears on the list on the left of the Map Layer Editor.

8. Repeat steps 6 and 7 to add more resources to the map layer.



9. If you want to change the order of the resources on the list, use the  or  to move
them up or down.

Note: The order in which the resources are listed in this dialog reflects the order in which
they are rendered in Google Maps, which affects visibility and label placement. The
resource at the bottom of the list is rendered first and the resource at the top of the list is
rendered last. So the resource at the top of the list is always visible.

For complete details about the buttons below the list of rules, see Additional Rule
Configuration Options in the Defining Projects chapter.

10. Select a display rule for a resource on the list. The Feature and Filter tabs appear on the
right.

The first option on the Feature tab is Draw Features As. Your selection determines the
options available for you to specify:

Label Only
Lines
Polygons
Points

11. When you finish specifying all of the feature options for the selected display rule, you can
specify one or more filters for each rule. See Specifying Filters for a Map Layer.

12. When you finish defining display rules and filters for the resources, select File > Save.

13. Navigate to the folder where you want to save your map layer, or click  to create a new
folder in the desired location.

14. Enter the name of your map layer, and click Save. The new map layer name appears in the
Asset Manager’s asset list.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

This section describes your options when you select Label Only for Draw Features As in the Map
Layer Editor.

1. Select Text or JS Text.
2. Either enter the text you want to appear for all features or click the text insertion button (...)

to the right of the empty text field. If you click the text insertion button:
Text - The Label Format dialog appears.

The Insert Field drop-down list contains the names of all of the fields in your source
data. Select a field name from the list, and click OK. For example, if you select NAME,
the names of the roads appear in Google Earth EC.

JS Text - The JavaScript Editor appears, and you can compose a JavaScript
expression, which returns the string to use as the label. See Label Properties in the
Defining Projects chapter for more information about this editor.)

3. Specify the visibility range for the layer.

The visibility range refers to the zoom level at which your labels are visible in Google Maps.
The default values for the range are 8 and 14. That means that when a Google Maps user
has a zoom level setting below 8 and above 14, the labels are not visible.

Caution: The default visibility range is much smaller that the default visibility range for
vector layers destined for Google Earth EC. The reason is that building Google Maps
databases can take significantly longer than building the same data for Google Earth EC.

Label Only

To define a display rule for a label:



Even small increases to the end level of the range can add significant time to the build
time.

4. The default text style is black on white in the Sans 12 font. Click the text style button to
specify a different text style for the labels.

The Text Style dialog appears.

5. Select a different option, if desired, for the Size or Color of the text.

Note: The only font that Fusion provides by default is Sans regular. To add fonts,
including international fonts such as Chinese, Japanese, or Hebrew, you can create a
configuration file called a "font list" file. See Configuring Fonts For the Text Style Dialog in
the Administration Guide.

6. Select Draw Background if you want to highlight your labels with a background color.

If you select Draw Background, you can specify the size and color of the background. The
Preview area provides a preview of a sample label as you make changes.

The default background size is 4. To change the background size, enter the desired
value. The larger the number, the larger the background.

Note: Setting the background size to less than 4 could potentially crop the edges of
the text. Specifying too large a number can result in overlapping labels.

Click the Color button and select a color for the background.
7. To save the text style settings, drag the preview over any button on the left.

The new style is stored on that button, replacing any style previously assigned to that button.
Each button name reflects the font face and size of the style, and it appears with the
selected color and outline attributes.

After you save a style to a button, you can simply click that button to automatically select its
text style settings for another label in the future.

8. Click OK.

This section describes your options when you select Lines for Draw Features As in the Map
Layer Editor.

Lines

To define a display rule for lines:



1. Specify the visibility range for the lines.

The visibility range refers to the zoom level at which your labels are visible in Google Maps.
The default values for the range are 8 and 14. That means that when a Google Maps user
has a zoom level setting below 8 and above 14, the labels are not visible.

Caution: The default visibility range is much smaller that the default visibility range for
vector layers destined for Google Earth EC. The reason is that building Google Maps
databases can take significantly longer than building the same data for Google Earth EC.
Even small increases to the end level of the range can add significant time to the build
time.

2. Specify the color of the lines by clicking the button next to Color and selecting a color.
3. Specify the width of the lines.

The default line width is 2. To change the line width, enter the desired value next to Line
Width. The larger the number, the thicker the line.

Note: Setting the outline width to less than 1 could potentially make it invisible.

4. Select Label if you want to include a text label, and specify the options for the label. The
label generally appears along the line, such as a street name. See Label Only for more
information.

5. Select Shield if you want to include a shield for road data, and specify the Shield options.

The Shield options are the same as the Label options, except that you can also specify the
Outline Color for the shield. To do so, click the button next to Outline Color, and select a
color.

This section describes your options when you select Polygons for Draw Features As in the Map
Layer Editor.

1. Specify the visibility range for the polygons.

The visibility range refers to the zoom level at which your labels are visible in Google Maps.
The default values for the range are 8 and 14. That means that when a Google Maps user
has a zoom level setting below 8 and above 14, the labels are not visible.

Caution: The default visibility range is much smaller that the default visibility range for
vector layers destined for Google Earth EC. The reason is that building Google Maps
databases can take significantly longer than building the same data for Google Earth EC.
Even small increases to the end level of the range can add significant time to the build
time.

2. Select a mode from the drop-down list.

The mode indicates whether the polygons appears as outlined, filled, or both in Google
Maps. If you select:

Fill Only - You can set the fill color by clicking the color button.
Outline Only - You can set the outline width and outline color.

The default outline width is 2. To change the outline width, edit the value in the text
field. The larger the number, the thicker the outline.

Note: Setting the outline width to less than 1 could potentially make it invisible.

Outline and Fill - You can set the fill color, outline width, and outline color.
3. Select Center Label if you want to include a text label in the center of the polygon, and

specify the options for the label. See Label Only for more information.)
4. If you selected Outline and Fill or Outline Only, select Outline Label if you want to include

an outline label, and specify the options for the label. See Label Only for more information.

Polygons

To define a display rule for polygons:



This section describes your options when you select Points for Draw Features As in the Map
Layer Editor.

1. Specify the visibility range for the points.

The visibility range refers to the zoom level at which your labels are visible in Google Maps.
The default values for the range are 8 and 14. That means that when a Google Maps user
has a zoom level setting below 8 and above 14, the labels are not visible.

Caution: The default visibility range is much smaller that the default visibility range for
vector layers destined for Google Earth EC. The reason is that building Google Maps
databases can take significantly longer than building the same data for Google Earth EC.
Even small increases to the end level of the range can add significant time to the build
time.

2. Specify the Marker Type from the drop-down menu.

If you select:

Circle - You can set width.
Oval - You can set width and height.
Square - You can set the width.
Rectangle - You can set the width and height.
Equilateral Triangle - You can set the width.
Triangle - You can set the width and height.
Icon - You cannot set width or height.
The default outline width is 2. To change the outline width, edit the value in the text
field. The larger the number, the thicker the outline.

Note: Setting the outline width to less than 1 could potentially make it invisible.

Outline and Fill - You can set the fill color, outline width, and outline color.
3. Specify the Center Label type from the drop-down menu. You can choose Text to

JavaScript text.
4. Specify the Style and Margins for the text within the point.
5. Specify the Outer Label text, style, and label position relative to the point.

Points

To define a display rule for points:



The following is an example of points that use a center label:

This example shows points with an icon marker type and an outer label:

This example shows a square marker type with a border:



A filter is a pattern expression that is applied to a specific field of a map layer. When the pattern
expression matches the specified field in the associated vector data, Google Earth Enterprise
Fusion selects the matching records and applies the feature settings for the rule to those records.
Filters are inclusive. Specifying filters for map layers is identical to specifying filters for vector
projects.

Note: Filters match string and numeric data only, not dates and other complex patterns.

Defining a Map Project

This section describes defining map projects for Google Maps only. For information about defining
vector projects for Google Earth EC, see the chapter titled Defining Projects.

The first step in defining a map project is to specify which map layers to include and give the
project a name.

1. Select Tools > Asset Manager. The Asset Manager appears.

2. Click . The Map Project Editor appears.

3. Click . The Open dialog appears.
4. Navigate to the folder that contains your map layers.

Note: The selection in the Type drop-down list near the bottom of this dialog determines
the type of assets that appear on the list. Map Layer is automatically selected when you
open this dialog from the Map Project Editor, so only map layers appear on the list.

5. Select the map layer you want to add to the project, and click Open.

The selected map layer appears in the Map Project Editor.

The value defined in the layer's Name field (at the top of the Map Layer Editor) appears
under Legend Name, and the path and layer name appears under Layer.

6. If you want to override the default icon, legend name, or initial state setting, double-click the
value under Legend Name.

The Layer Legend dialog appears.

Specifying Filters for a Map Layer

Creating a Map Project

To create a map project:



7. Change the desired value(s), and click OK.

The new legend name appears in the Map Project Editor.

Tip: If you ever want to return to the default label and initial state settings, right-click the
layer and select Use Layer Defaults from the context menu.

8. Repeat steps 3 through 7 for each additional map layer you want to include in the project.

9. To remove a layer from a project, select the layer you want to remove, and click .

Alternatively, you can right-click the layer, and select Remove Layer from the context menu.

10. To reorder layers in a project:
a. Select the layer you want to move.

b. Click  or  to move the selected layer until it appears where you want it on the
list.

Alternatively, you can right-click the layer, and select Move Layer Up or Move Layer
Down from the context menu.

c. Repeat the steps until the layers are in the order in which you want them to appear in
the Layers panel of Google Earth EC.

11. When you finish adding/modifying map layers, select Save from the File menu.

12. Navigate to the folder where you want to save your project, or click  to create a new
folder in the desired location.

13. Enter the name of your project, and click Save.

The new map project name appears in the Asset Manager’s asset list.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

When you finish defining your map project, you can build it individually, build several projects at the
same time, or wait until you build your database to build all of its projects at the same time.



When you modify and then save a map project, Google Earth Enterprise Fusion saves it in the
same place with the same name as the original. If you modify a map project that you have already
built, you must build a new version to make the changes available for use in a database.

After you create a map project, you can use the Asset Manager to modify it. Modifying a map
project is exactly the same as modifying any vector project.

See Modifying Projects in the Defining Projects chapter for complete information.

Defining a Map Database

This section provides information on defining map databases for Google Maps only. For
information about defining databases for Google Earth EC, refer to the chapter titled Defining and
Publishing Databases.

1. Select Asset Manager from the Tools menu. The Asset Manager appears.
2. From the selection box, select Mercator Map Tools (2D) and click the New Mercator Map

Database icon.

The Map Database Editor appears with no projects selected.

3. Click  next to Map Project.
4. Navigate to the folder that contains your Map projects.

Note: The selection in the Type drop-down list near the bottom of this dialog determines
the type of projects that appear on the list. Map Project is automatically selected, so only
map projects appear on the list.

5. Select the Map project you want to add to the database, and click Open.

The selected project appears in the Map Database Editor next to Map Project.

6. Mercator Map Databases only: If you have a license for the Google Geo Database and
would like to use it as the imagery for this database, select the Use Google Geo Database
checkbox. This option will not be available when creating Flat Projection Map Databases.

If you check this box, you cannot select an imagery project. In those cases, the imagery is
supplied by Google, and you can skip step 7.

Note: Any server that hosts a Google Geo Database must have access to the Internet. If
you are not licensed to use the Google Geo Database and would like to know more about
it, please contact Google Enterprise Support at enterprise-support@google.com.

7. Repeat steps 3 through 5 to add an imagery project, if you did not check the box next to
Google Geo Database.

Both projects appear on the list.

Note: This imagery project can be the same as one you use in a database that you

Modifying Map Projects

To define a map database:

mailto:enterprise-support@google.com


publish to Google Earth EC.

8. If you want to configure search tabs for the database, click Search Tabs. See Adding
Search Tabs to a Database in the Defining and Publishing Databases chapter for details.

9. When you finish defining your database, select Save from the File menu.

10. Navigate to the folder where you want to save your database, or click  to create a new
folder in the desired location.

11. Enter the name of your database, and click Save.

Now you are ready to build your database. See the Building Assets chapter for complete details.

Caution: Assets can not be deleted once they are saved. They can be cleaned, so that they are
no longer available to use in Google Earth Enterprise Fusion; see Cleaning Asset Versions in
the Building Assets chapter for more information.

Publishing a Map Database

Publishing a database for Google Maps is exactly the same as publishing a database for Google
Earth EC, although the list of server associations is different.

See Publishing a Database for complete details. You can publish a map database only to the
server associations designated as MAP type.

Viewing a Map Database

After you publish your database, you can view it in a browser.

1. Launch any web browser.
2. Point your browser to:

where serverURL is the full URL of the stream server to which you published the map
database, including the protocol, the server location, and the port (if the port is other than
the default, port 80). For example:

If you are not sure which server you published to, contact your Google Earth Enterprise
Server administrator for help.

Google Maps displays your database.

Using the Fusion Maps API

The Fusion Maps API is used to create and interact with map layers created in Google Earth
Enterprise. The API is based on the Google Maps API but includes an additional GFusionMap class
that will make it easier to interact with map layers generated by Google Earth Enterprise. The
documentation for the Google Maps API is available at: http://code.google.com/apis/maps.

Note that the Fusion Maps API does not currently support objects that require calling URLs hosted
at Google to operate. Objects that are not supported in the Fusion Maps API include: GGeoXML,
GClientGeocoder, GDirections, GAdsManager, GGoogleBarOptions, GDirections, GTrafficOverlay,
GStreetViewPanorama, GStreetviewOverlay

Instantiate class GFusionMap in order to create a Fusion map. This is an extension of the GMap2

serverURL/default_map

http://my_host_name/default_map

class GFusionMap

To view your map database:

http://code.google.com/apis/maps/
http://code.google.com/apis/maps/
http://code.google.com/apis/maps/


class, and the GFusionMap class should be used instead of GMap2 to create applications will use
layers from Google Earth Enterprise.

Constructor Description

GFusionMap(container,
opts?) Creates a new Fusion map inside of the given HTML

container, which is typically a DIV element. The options
are the same as the options for GMap2. However, if a
map type is passed in to the options, the Fusion maps
server will override these if an imagery layer is included
in the Fusion Maps Database. After this constructor is
invoked, the setCenter() method should be called
before any methods that display Fusion layers on top of
the map.

Methods Return
Value

Description

showInitialFusionLayers() none Show all layers that are enabled by
default. This method should only be
invoked after the setCenter()
method has been called to initially
draw the map.

getFusionLayerCount() Number Returns the number of Fusion map
layers. This does not include the
base imagery layer, which is built as
a custom map type and serves as
the background of the map.

isFusionLayerVisible(index) Boolean Returns true if the layer is currently
shown on the map and false if it is
hidden.

showFusionLayer(index) none Shows a previously hidden Fusion
map layer. This method should only
be invoked after the setCenter()
method has been called to initially
draw the map.

hideFusionLayer(index) none Hides the specified Fusion map
layer.

getFusionLayerName(index) String Returns the name of the specified
layer.

getFusionLayerIcon(index) String Returns the URL of the icon
associated with the specified layer.

Several examples are installed by default illustrate how to use the Fusion Maps API. You can find
these examples in:

See the following files:

/opt/google/gehttpd/htdocs/maps

Constructor

Methods

Examples



maps_local.html
maps_google.html
example_google.html
example_local.html

Back to top
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Overview

This chapter describes the shell commands for Google Earth Enterprise Fusion. You can use the
shell commands to set up an automated environment to build and deliver databases from
frequently updated or new source data.

In addition, if you have a large number of sources to process, you can build a command line script
to add them rather than adding them individually using the Google Earth Enterprise Fusion GUI.

Note: The commands included in previous releases that began with kh have all been changed
to begin with ge since version 3.0. They are documented by their new names in this guide.

A feature of an automated system is the ability to optimize your work at all phases of data
collection--resource, project, and database definition. You can:

Build a database to process all of the resource and project data that comprise the database.
Build a project to process all of the resource data that comprise a project.
Build an individual resource as new source data becomes available.

Reference Guide

Command Line Reference

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/errors.html


You can use the Google Earth Enterprise Fusion shell commands to access all components in
each building phase of a servable set of GIS data. This appendix provides a list of commands
grouped by component--resource, project, or database--and then describes each command in an
alphabetical listing. In addition to the information in this appendix, you can determine each
command’s usage by simply entering the command with the --help option, for example

This appendix uses the following typographic conventions:

Italic Information that the user must supply

Bold Text that the user must type exactly as
shown

Ellipsis ... Parameter that can be repeated several
times in a command line

Square brackets [ ] Optional items

Curly braces { } with options separated by pipes
|; for example: {even | odd}

Set of choices from which the user can
select only one

Parentheses ( ) Grouped items that function together.

genewimageryresource --help



Courier font Code or program output

Commands Listed by Functional Area

This section describes the commands you can use to define and modify terrain, imagery, and
vector resources from the command line:

genewimageryresource
genewmaplayer
genewterrainresource
genewvectorresource
gemodifyimageryresource
gemodifyterrainresource
gemodifyvectorresource

You can use these commands for bulk processing when you have large quantities of data to
process. See the Defining Resources chapter for more information.

When defining and modifying resources, keep these points in mind:

You define a single resource at a time by importing a single source file or multiple source
files.
When you import multiple source files for a single resource, all of the source data must have
the same projection, and the header attributes must have the same structure. The source
files, however, can be in different formats, such as TIFF or IMG (although this is unlikely).
You can import the same source file into different resources.
If you use one of the modify commands (gemodifyimageryresource,
gemodifyterrainresource, or gemodifyvectorresource) and specify a resource that does not
exist, Google Earth Enterprise Fusion creates a new resource with the name you specify.
When you import multiple source files for a single imagery or terrain resource, the pixel
resolution of all files must be the same.
When you import multiple source files for a single vector resource, the geometry type must
be the same.
You must use a modify command to change properties for an existing resource. If you use
the one of the new (genewimageryresource, genewterrainresource, or genewvectorresource)
commands and a resource with the name and type you specify already exists, the command
fails.

When you define an imagery or terrain resource, the source file must include geo-reference
information. Typically the coordinate and projection information is part of the imagery file itself (as
with a GeoTIFF file, for example). However, if your imagery source file does not contain geo-
coordinate information, you must provide it in a separate external file. (See Special Cases in the
Defining Resources chapter for details about external files.)

If you purchase preprocessed imagery or terrain data from Google or receive preprocessed data
from another Google Earth Enterprise Fusion user, it arrives as a complementary pair of folders.
These folders share the same name but have different extensions. Folders with a .kip extension
are imagery data. Folders with a .ktp extension are terrain data. Folders with a .kmp extension are
mask files. Folders with a .kvp extension are vector data.

You must use the Google Earth Enterprise Fusion command line tools to add preprocessed data to
your asset root. The command line tools for importing preprocessed data are:

genewimageryresource
genewterrainresource

Resource Commands

Defining and Modifying Resources

Importing Preprocessed Resources



These commands have similar options and parameters.

You must specify the --havemask option to correctly import the preprocessed mask files with the
imagery. You can associate provider copyright information with the resource by specifying the --
provider option and the appropriate provider key. You specify the resource name and target
location in the asset tree with the -o option (for example: -o
assets/imagery/north_america/usa/ca/usgsLandSat), followed by the full path to the source data.

1. Change to the asset root folder, for example:

Tip: Although this step is not necessary, it allows you to use auto-completion (pressing
TAB after typing the first few letters of a file name) on the command line, which helps you
avoid typographical errors.

2. Add the imagery data with the genewimageryresource command, for example:

3. Press Enter.

Google Earth Enterprise Fusion defines the resource.

1. Change to the asset root folder, for example:

2. Add the terrain data with the genewimageryresource command, for example:

3. Press Enter.

Google Earth Enterprise Fusion defines the resource.

After defining resources, the next phase in producing a Google Earth database involves defining
projects and adding resources to them. For your database, you can define up to three different
projects--imagery, terrain, and/or vector.

This section describes the commands you can use to define and modify terrain, imagery, and
vector projects from the command line:

genewimageryproject
genewterrainproject
genewvectorproject
gemodifyimageryproject
gemodifyterrainproject
gemodifyvectorproject
geaddtoimageryproject
geaddtoterrainproject
geaddtovectorproject
gedropfromimageryproject
gedropfromterrainproject
gedropfromvectorproject

cd /gevol/assets

genewimageryresource --provider <PROVIDER_KEY> --havemask 
-o path/to/resource/directory/resourcename /path/to/imagery.kip

cd /gevol/assets

genewterrainresource --provider <PROVIDER_KEY> --havemask 
-o path/to/resource/directory/resourcename /path/to/terrain.kip

Project Commands

To import preprocessed imagery data:

To import preprocessed terrain data:



As with resource commands, you can use these commands for bulk processing when you have
large quantities of data to process. See Defining Projects for more information.

When defining and modifying resources, keep these points in mind:

You use the project modification commands to redefine an existing project with a known set
of resources. You can use one of the modify commands as a single command to achieve this
operation, rather than having to use the addto or dropfrom commands to change the
resources in an existing project. That is, when you use the project modification command,
the resources you specify replace the previous set of resources for that project.
When you add terrain and imagery resources to a project, Google Earth Enterprise Fusion
automatically orders them according to their resolution. That is, a 1-meter imagery resource
is stacked on top of a 3-meter imagery resource. Beyond that, the imagery resources are
ordered according to the order in which you list them in the command.
You can use the addto command to add resources to an existing project. To add resources
to a project that has not yet been defined, use the new command.

This section describes the commands you can use to define and modify terrain, imagery, and
vector databases from the command line:

genewdatabase
gemodifydatabase

As with resource and project commands, you can use these commands for bulk processing when
you have large quantities of data to process. See Defining a Database for more information.

Before publishing your project and resource data to a Google Earth Enterprise Server, you must
define a database. A database typically contains at least a single project--imagery, terrain, or
vector. It can contain one project of each type for a total of three projects.

When you define a database without one of the three project types, that project type is supplied by
the default project data specified in your Google Earth Enterprise Fusion system configuration. For
example, if you define a database using your own imagery and terrain projects, but you supply no
vector project, the default vector project is used. (See the Google Earth Enterprise Administration
Guide for a description of the default project settings.)

Tip: The gemodifydatabase command exists as a convenience when you must redefine the
projects for a given database. However, it is not recommended that you use this command to
repeatedly redefine the projects for a single database. For example, if you want to view different
vector data projects in relationship to the same imagery and terrain projects, you should define
two separate databases with different vector projects rather than repeatedly redefining the same
database in order to switch vector data.

This section describes the commands you can use to build any type of asset--resource, map layer,
project, or database--from the command line:

gebuild
gecancel
geclean
gequery
geresume
gesetbad
geclearbad

Google Earth Enterprise Fusion allows you the flexibility of building the entire database and its

Database Commands

Building Commands

Defining and Modifying Projects

Defining a Database



components at the same time or building the individual components one at a time. This flexibility is
particularly useful when source data updates become available at varying times, and you want to
build some components before other components are updated.

When you define or modify a resource, you are defining the source file and configuration settings
for the resource. When you build the resource, you are using those settings to actually produce the
resource itself, which is a group of related files that are the result of this processing.

You can use the gecancel command to cancel a build that is in progress. If, for example, you
realize that you’ve specified an incorrect value for the configuration of a resource that is already
building, you can use this command to stop the build.

Sometimes a build fails for external reasons, such as lack of disk space or file permissions set
incorrectly. When that happens, after you resolve the disk space problem, you can use the
geresume command to continue building the asset from the point at which the build failed. The
purpose of the geresume command is to continue a build on a version where there has been no
change to the data itself--only changes to external factors.

On the other hand, if the build failed because of a configuration or inherent data problem, you can
change the configuration of the asset (such as removing a resource from a project or changing the
visibility range for a display rule). Then you must use gebuild to rebuild the resource, since the
underlying data actually changed.

Unlike the gebuild command, geresume does not define a new version of the resource; it rebuilds
a previously failed or canceled version.

You can use the gequery command to debug the process of building an asset when it fails to build
or to find a specific version of an asset. Typically, you use the --status parameter to determine
the initial status of a particular asset.

If for some reason the asset build fails, you can use the other available querying parameters to
further expose the details of the build for that asset in order to identify the specific point at which
the build failed. A typical debug process involves the following steps:

1. Find the dependency list for a resource.

2. Determine the first failed element in the dependency list.
3. View the dependency list and note the dependency with a failed status.
4. Use the gequery command on the failed element to view its log file.

Note: You can use the gequery command for an asset or for source data.

5. View the log file to check for relevant error messages.

Each time you build an asset, Google Earth Enterprise Fusion creates a new version for that asset.
As a consequence, many updates to an asset can take up significant disk space. You can use the
geclean command to clean out assets whose prior versions are no longer needed and are not
being referenced by other projects or databases.

For details on cleaning assets and the requirements for this process, see Cleaning Asset Versions
in the Building Assets chapter.

Using the gesetbad command, you can change the status of a resource, project, or database to
Bad after it has been successfully built. This command is useful if, for example, you incorrectly

gequery --dependencies imagery/Mississippi/RiverDelta

gequery --showlog imagery/Mississippi/RiverDelta/RiverDelta?version=3

Handling Asset Build Failures

Querying Asset Properties

Cleaning Assets

Marking an Asset as Bad



configure an asset but do not realize it until after the build is complete. By marking the asset as
Bad, you can prevent other users (or yourself) from building on that asset in the future.

For example, you can create two versions of an imagery resource, build them both, and preview
them, and then decide which one you want to keep. You can use the gesetbad command to
prevent the rejected resource from being used to build projects and databases.

To revert the Bad status to the prior status, use the --off parameter.

After you define a database with its project components, you must build it before publishing it to
the server. If you have already built some components of your database, Google Earth Enterprise
Fusion does not repeat that work when it builds the database. It only builds the components that
have not yet been built. However, even if all of your database components have been built prior to
being added to the database, you must still build the database before publishing it.

This section describes the command you use when you are publishing a database:

gepublishdatabase

After you successfully build a database, you can publish it to a stream and search server
association and then view the data with Google Earth EC. See Publishing a Database for more
information about publishing.

There are several commands you can use to perform various miscellaneous Google Earth
Enterprise Fusion tasks from the command line, including:

geinfo
gemaskgen
gepolymaskgen
geraster2kml
gereproject
gesplitkhvr
getop
getranslate
gevirtualraster

geaddtoimageryproject 
geaddtoterrainproject

To add one or more resources to an existing imagery or terrain project. Use spaces between
resources.

This example adds two resources to the project nySectorB.

geaddtoimageryproject
geaddtoterrainproject --o projectname resourcename...

geaddtoimageryproject --o projects/imagery/ImageryProjectA
   imagery/nySector2imagery/nySector3

Publishing Command

Miscellaneous Commands

Commands Listed Alphabetically

Building a Database

Purpose

Example



Required. Specify the name of the project relative to the asset root, for example,
vector/VectorProjectA.

Required. Specify at least one resource to add to the project, for example,
vector/VectorResourceA.

geaddtomapproject

To add map layers to an existing map project.

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Map/MapProjectA.

Required. Specify the location(s) and name(s) of one or more map layers to add to the project.

geaddtovectorproject

To add one or more resources to an existing vector project.

This example adds one resource to vector project vectorTemplateB.

Required. Specify the name of the project relative to the asset root, for example,
vector/VectorProjectA.

Required. Specify the template file that contains the display rules you want to apply to your vector

--o projectname

resourcename

geaddtomapproject -o projectname layername...

geaddtomapproject -o Projects/map/MapProjectA MapLayers/SFneighborhoods

-o projectname

layername

geaddtovectorproject --o projectname ([--template filename] [vectorresource...])

geaddtovectorproject --o vector/VectorProjectA
   --template templates/vectorTemplateB NewYorkCityStreets

--o projectname

--template filename

Parameters

Purpose

Example

Parameters

Purpose

Example

Parameters



layer. To create a template file, see Exporting Display Rules in the Defining Projects chapter.

Required. Specify one or more vector resources to add to the project relative to the asset root, for
example, vector/VectorResourceA. Google Earth Enterprise Fusion applies the specified template
to each resource.

geapplylayertemplate

To apply a display rules template to a project layer. Use single quotes for names with spaces and
when listing more than one layer.

Optional. Include if you want to apply the display rules from the template.

Optional. Include if you want to apply the legend specifications from the template.

Required. Specify the name of the project that contains the layers to which you want to apply the
template.

Optional. Specify the name of the layer(s) or channel(s) to which you want to apply the template. If
omitted, Google Earth Enterprise Fusion applies the template to all layers in the specified project.

Required. Specify the file name of the template you want to apply.

gebuild

To build any type of asset (resource, map layer, project, or database).

vectorresource

geapplylayertemplate [--displayrules] [--legend]
   --project projectname{--layer layername | --layerid channelid} 
   --template filename

geapplylayertemplate --displayrules --legend --project ‘CA Roads’
   --layer CAHighways
geapplylayertemplate --displayrules --project ‘CA POIs’
   --layer ‘LayerA|LayerB|LayerC’

--displayrules

--legend

--project projectname

--layer layername | --layerid channelid

--template filename

gebuild assetname

gebuild imagery/SourceInc/MississippiDeltaRegion

Purpose
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Required. Specify the location and name of the asset (resource, map layer, project, or database)
that you want to build relative to the asset root, for example, Projects/Vector/VectorProjectA.

gecancel

To cancel a build in progress on the specified asset.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose build you want to cancel relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset you want to cancel, or enter current or
lastgood. If you omit the version specification, Google Earth Enterprise Fusion cancels the current
version of the specified asset.

geclean

To clean a particular version of the specified asset.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose version you want to clean relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset you want to clean, or enter current or lastgood.
If you omit the version specification, Google Earth Enterprise Fusion cleans the current version of
the specified asset.

assetname

gecancel assetname [version]

gecancel projects/TransitData/BostonTransitLines 2

assetname

version

geclean assetname [version]

geclean imagery/SourceInc/MississippiDeltaRegion

assetname

version
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geclearbad

To revert a version of an asset that has been marked as Bad to its prior status.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose version you want to revert relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset you want to revert, or enter current or lastgood.
If you omit the version specification, Google Earth Enterprise Fusion reverts the current version of
the specified asset to its previous status.

gedropfromimageryproject 
gedropfromterrainproject 
gedropfromvectorproject

To remove one or more resources from the specified project.

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Required. Specify the location and name of at least one resource that you want to drop from the
project relative to the asset root, for example, Resources/Vector/VectorResourceA.

gedropfrommapproject

geclearbad assetname [version]

geclearbad projects/TransitLines/BostonTransitLines 2

assetname

version

gedropfromimageryproject
gedropfromterrainproject
gedropfromvectorproject --o projectname resourcename...

gedropfromimageryproject --o projects/imagery/ImageryProjectA
   imagery/nySector2 imagery/nySector3

--o projectname

resourcename

gedropfrommapproject -o projectname layername...
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To drop map layers from an existing map project.

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Map/MapProjectA.

Required. Specify the name(s) of one or more map layers to drop from the project.

geexportlayertemplate

or

To export a template from the display rules defined for one or more layers in a specific project.

Required. Specify the name of the project that contains the layers for which the display rules you
want to export have been defined.

Required. Specify the name(s) of the layer(s) for which the display rules you want to export have
been defined. You can specify more than one layer within single quotes, separated by pipes, for
example:

where folder1 and folder1 are folders that contain a group of layers.

Required. Specify this option with the --layer option. Enter the location and name of the directory
where you want to store the template. This location can be anywhere on your network where
Google Earth Enterprise Fusion has write permission.

Required. Specify this option if you want to export templates for all layers in separate files within

gedropfrommapproject -o Projects/map/MapProjectA SFneighborhoods

-o projectname

layername

geexportlayertemplate --project projectname --layer layername -o templatefile

geexportlayertemplate --project projectname --alllayers -o outdir

geexportlayertemplate --alllayers -o fusion/templates

--project

--layer

--layer ‘folder1|folder2|layerA’

-o templatefile

--alllayers

Example
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the specified output folder.

Required. Specify this option with the --alllayers option. Enter the location and name of the
directory where you want to store the templates. This location can be anywhere on your network
where Google Earth Enterprise Fusion has write permission.

geinfo

To provide information about the specified raster file.

Optional. Specify the SRS to override.

Optional. Dump the contents of the raster file.

Optional. Display all supported formats in the raster file.

Optional. Compute and display the minimum and maximum pixel values in the raster file.

Optional. Do not display ground control points in the raster file.

Optional. Do not display metadata in the raster file.

Optional. Sample the pixel data in (but not print) the raster file.

Optional. Specify the SRS to override.

-o outdir

geinfo [--a_srs override_srs] [--dump] [--formats] [--minmax] 
   [--nogcp][--nometa] [--sample] [--srs override_srs]
   [--writeprj prjfile] [--writetfw tfwfile] input

geinfo --writeprj projectionfile.prj myimage.tif

--a_srs override_srs

--dump

--formats

--minmax

--nogcp

--nometa

--sample

--srs override_srs

--writeprj prjfile

Purpose

Example

Parameters



Optional. Write a PRJ file with the raster file’s projection.

Optional. Write a TFW file with the raster file’s extents.

Required. Specify the name of the raster file on which to take the specified action(s).

gemaskgen

To create a mask file for a raster (imagery or terrain) file.

Modes:

Optional. Specify this mode to extract the image from the specified raster file. No mask is created.
The output data type matches the original image file type.

Optional. Specify this mode to generate an 8-bit mask file (the default) from the specified raster
file.

Optional. Specify this mode to generate an 8-bit mask prep file from the specified raster file.

Optional. Specify this mode to generate an RGBA preview file from the specified raster file.

Options:

Optional. Specify the band number (0-based) to use for the mask and prep files. The defaults are
1 for imagery and 0 for terrain.

Optional. Read the input and compute the size of the specified raster file but not to write it to the
output file.

--writetfw tfwfile

input

gemaskgen { [--extract] [--mask] [--prep] [--preview] }
   { [--band num] [--debug] [--feather num] [--fill 0-255]
   [--formats][--holesize num] [--maxsize num] [--oformat]
   [--tolerance num] [--whitefill] }rasterproduct output

gemaskgen --mask --feather 200 raster.kip file-maskold.tif

--extract

--mask

--prep

--preview

--band num

--debug

--feather num

Purpose
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Optional. Specify the number of pixels to feather. The default is no feather, 0.

Optional. Specify the pixel value to treat as fill. The default is the corner colors.

Optional. Display the supported output formats.

Optional. Specify the minimum size of the interior holes of the fill color to be masked. The default
is not to look for holes.

Optional. Specify the maximum mask size. The default is 16000.

Optional. Specify the output file format. The default is GTiff. (Use the --format option to determine
the supported formats.)

Optional. Specify the deviation from the value specified for --fill that should also be considered
as fill.

Optional. Specify white as an additional fill color.

Required. Specify the name and location of the raster file for which you want to create a mask file.

Required. Specify the name and location of the output file containing the mask. This location can
be anywhere on your network where Google Earth Enterprise Fusion has write permission.

genewdatabase 
gemodifydatabase

To define or modify a database.

--fill 0-255

--formats

--holesize num

--maxsize num

--oformat

--tolerance num

--whitefill

rasterproduct

output

genewdatabase
gemodifydatabase -o dbname [--imagery imgproject[?version=x]] 
   [--terrain terrainproject[?version=x]] [--vector vectorproject[?version=x]]

genewdatabase -o msDelta --imagery imagery/MississippiDelta?version=21
   --terrain terrain/msDeltaTerrain?version=20 --vector vector/msDeltaCities

Purpose
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Required. Specify the location and name of the database relative to the asset root, for example,
databaseA.

Optional. Specify the location and name of the imagery project relative to the asset root, for
example, Projects/Imagery/ImageryProjectA.

Optional. Specify the location and name of the terrain project relative to the asset root, for
example, Projects/Terrain/TerrainProjectA.

Optional. Specify the location and name of the vector project relative to the asset root, for
example, Projects/Vector/VectorProjectA.

Optional. The version parameter can be applied to any, none, or all of the imagery, terrain, or
vector project values. x must be a valid project version to be used with the database.

genewmapdatabase 
gemodifymapdatabase

To define or modify a map database.

A Flat Projection map database:

A Mercator Projection map database:

Optional. This option supports any number of optional name/value pairs that you want to store for
the data. For example, you might want to provide additional information about the data provider,
such as the specific airplane that took the photo, or you might want to assign your confidence level
with the data. If the name or value string contains white space, it should be enclosed in quotation
marks.

-o dbname

--imagery imgproject

--terrain terrainproject

--vector vectorproject

version=x

genewmapdatabase
gemodifymapdatabase [--meta key=value] -o dbname [--imagery imgproject]
   [--map mapproject] [--mercator | --flat]

genewmapdatabase -o Databases/msDelta --imagery Projects/Imagery/MissDelta
--map Projects/Map/MissWaterways

genewmapdatabase -o Databases/msDeltaMercator --imagery 
   Projects/Imagery/MissDeltaMercator
   --map Projects/Map/MissWaterways --mercator

--meta key=value

Parameters
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Required. Specify the location and name of the map database relative to the asset root, for
example, Databases/databaseA.

Optional. Specify the location and name of the imagery project relative to the asset root, for
example, Projects/Imagery/ImageryProjectA.

Optional. Specify the location and name of the map project relative to the asset root, for example,
Projects/Map/MapProjectA.

Optional. Default value is --flat. Specifies the projection of the map database. Only applies to
new imagery resources. Glossary: Flat Projection, Mercator Projection.

 

genewimageryproject 
gemodifyimageryproject 
genewterrainproject 
gemodifyterrainproject

To define or modify an imagery or terrain project.

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Imagery/ImageryProjectA.

Optional. Specify the maximum number of levels in the project.

Optional. Specify the location(s) and name(s) of one or more imagery or terrain resources to add to
the project.

genewmaplayer

-o dbname

--imagery imgproject

--map mapproject

--mercator | --flat

genewimageryproject
gemodifyimageryproject
genewterrainproject
gemodifyterrainproject -o projectname {[--maxlevel=num] insetresource ...}

genewimageryproject -o 
   projects/imagery/ImageryProjectAimagery/MississippiDeltaRegion

-o projectname

--maxlevel=num

insetresource
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Creates a new map layer.

Required. Name of the layer as it appears in a web browser.

Required. Name of the map layer asset as it appears in the Asset Manager. This value is relative
to the asset root and should not include an extension (eg. Resources/Vector/counties).

Optional. Basename of the icon png file as it appears in the icon browser (eg. cars).

Optional. Sets this layer's default state to 'on' in the web browser.

Optional. A KMDSP filename (absolute) and a corresponding vector resource (relative to
asset_root and without extension). Specifies the display rules and the vector resource for a
sublayer; KMDSP files can be exported from the Map Layer widget of the Fusion GUI. More than
one template and vector resource pair can be specified.

genewmapproject 
gemodifymapproject

To define or modify a map project.

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Map/MapProjectA.

genewmaplayer --legend=legend_name --output=map_layer_name [options]
   {[--template=filename] vectorresource}...

genewmaplayer --legend=cars --output=ca-car_map-layer --layericon=car
   --template=/home/doe/template_1.kmdsp Resources/Vector/cities
   Resources/Vector/villages --template=/home/doe/template_2.kmdsp
   Resources/Vector/counties

--legend=legend_name

--output=map_layer_name

layericon=icon_name

--default_state_on

--template=filename

genewmapproject
gemodifymapproject -o projectname layername...

genewmapproject -o Projects/map/MapProjectA MapLayers/SFneighborhoods

-o projectname

layername
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Required. Specify the location(s) and name(s) of one or more map layers to add to the project.

genewvectorproject 
gemodifyvectorproject

To define or replace a vector project.

This example updates the PhoenixRoads project with three resources and applies an existing
template to the data:

Required. Specify the location and name of the project relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Required. Specify the template file that contains the display rules that you want to apply to the
specified resources for this project. To create a template file, see Exporting Display Rules in the
Defining Projects chapter.

You can apply different templates to different resources as follows:

Optional. Specify one or more vector resources to add to the project.

genewimageryresource 
gemodifyimageryresource 
genewterrainresource 
gemodifyterrainresource

To define or modify an imagery or terrain resource.

genewvectorproject
gemodifyvectorproject -o projectname {[--template filename] vectorresource...}

genewvectorproject --template templates/cityRoadData
   resources/vector/RoadData/PhoenixRoad1resources/vector/RoadData/PhoenixRoad2
   resources/vector/RoadData/PhoenixRoad3

-o projectname

--template filename

gemodifyvectorproject -o projects/vector/PhoenixRoads --
templatetemplates/cityRoadData resources/vector/RoadData/PhoenixRoad1 
resources/vector/RoadData/PhoenixRoad2 --template templates/countyRoadData 
resources/vector/RoadData/PhoenixRoad3
vectorresource

genewimageryresource
gemodifyimageryresource
genewterrainresource
gemodifyterrainresource [--havemask] [--nomask] [--mosaicfill nn,nn,nn] 
   [--mosaictolerance n] [--band n] [--feather radius] [--feet | --scale num]
   [--holesize n] [--masktolerance n] [--meta name=value] [--provider key]
   [--sourcedate string] [--whitefill] [--srs srs_def]
   -o [path] resourcename 
   {sourcefile ... | --filelist file} [--mercator | --flat]
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This example defines a single mosaic imagery resource from three source files, specifying white
as the fill value and setting the feather to 80 pixels for automask generation.

Optional. Use this option if you have an alpha mask or file that you want to use. The mask for your
input must be located in the same folder as the source file, and the file name must match the
name of the source file with -mask appended. For example, if your source file is called
NewYork.tif, its mask file must be named NewYork-mask.tif.

Note: You can use the --havemask option only when you include a single source file in the
resource. The mask file must be either of the same file format as the original image file, or it
must be a TIFF file.

Optional. Use this option if you do not want Google Earth Enterprise Fusion to generate an alpha
mask for the resource.

Optional. Typically, you specify a fill value if you are importing several imagery files whose borders
overlap in the resultant mosaic. Specify the fill value in decimal format. Height map imagery needs
a signed 16-bit value (a numeric range between -32,767 and 32,767), whereas color map imagery
needs a 24-bit value or a 3x8 bit color. In general, the fill color depth should match that of your
source data.

Optional. Tolerance specifies the color range for mask selection. The default tolerance is zero,
which is adequate for many fill colors that are typically pure black or pure white. However, because
imagery compression and decompression can affect fill values by 1 or 2 color values, you can
adjust the tolerance to compensate for any loss in precision. Typically, a setting of 1 or 2 is
adequate in those situations.

If you do not specify --nomask or --havemask, Google Earth Enterprise Fusion automatically
generates a mask. In that case, the following options are also available:

Optional. Specify the band to use when generating the auto mask. If this option is unspecified,
Google Earth Enterprise Fusion uses the green channel. The legitimate values for this option are
0, 1, 2, corresponding to red, green, and blue, respectively.

Optional. Specify the feather value in pixels. If you omit this option, the default value is 100.

--feet | --scale num (terrain only)

Optional. This option sets the elevation scale for your height map imagery. Google Earth
Enterprise Fusion interprets height map values as meters. If the elevation unit for your data is not
meters, you must use this option to provide the correct conversion number from your data’s unit to

genewimageryresource --feather 80 --fill 255,255,255 --provider SourceInc 
   --sourcedate 2003-05-10 -o imagery/MississippiDeltaRegion 
   /vol/machine2/SourceInc/msRiver1.tif /vol/machine2/SourceInc/msRiver2.tif 
   /vol/machine2/SourceInc/msRiver3.tif

--havemask

--nomask

--mosaicfill nn,nn,nn

--mosaictolerance n

--band n

--feather radius

Parameters



meters. For example, if your source height map file has decimeters for its height unit, you would
specify .1 for the scale value in order to have the elevation represented in meters.

Alternatively, you can use the --feet parameter as a shorthand mechanism for --scale .3048,
which represents feet units in their metric equivalent.

Note: Meters is the default scale elevation. If you do not specify this option when defining
terrain resources, the elevation units are treated as meters.

Optional. Use this option if you have masked regions inside the boundaries of your imagery data.
The default setting for hole size is 0, which is OFF.

The hole size indicates the number of contiguous pixels Google Earth Enterprise Fusion uses
when matching any color region inside your imagery with the same value specified as your fill. For
example, if you set the value to 100 and the imagery has 100+ contiguous pixels with the same
color as one of the corners (fill value), it treats that area as a “hole” in the data and applies the
mask to it. The end result is that whatever data is under the masked data shows through.

Optional. Specify the tolerance to be used when comparing pixels against mask fill value.
Tolerance specifies the color range for mask selection. The default tolerance is 0, which is
adequate for many fill colors that are typically pure black or pure white. However, because imagery
compression and decompression can affect fill values by 1 or 2 color values, you can adjust the
tolerance to compensate for any loss in precision. Typically, a setting of 1 or 2 is adequate in
those situations.

Optional. This option supports any number of optional name/value pairs that you want to store for
the source data. For example, you might want to provide additional information about the data
provider, such as the specific airplane that took the photo, or you might want to assign your
confidence level with the data. If the name or value string contains white space, it should be
enclosed in quotation marks.

Optional. Specify a string that identifies the provider of the source data you are importing. This
provider key must match the provider key in your database that corresponds to the source data.
The provider name and copyright fields associated with this key are displayed for this resource in
Google Earth EC. If the key contains white space, you must use quotation marks around the
string.

Note: If you are importing several source files to define a single resource, Google Earth
Enterprise Fusion assumes that they have a common provider.

Optional. This option is a string that represents the date of acquisition for your source file. It must
in the ISO 8601 format (yyyy-mm-dd).

Optional. Use this option if imagery holes in your source data are filled with white. In some cases,
source providers fill missing data inside the imagery with white and use a different color for the
boundary mask.

--holesize n

--masktolerance n

--meta name=value

--provider key

--sourcedate string

--whitefill



Optional. Specify the spatial reference set to use instead of the embedded SRS. The coordinate
systems that can be passed are anything supported by the
OGRSpatialReference.SetFromUserInput() call, which includes EPSG PCS and GCSes (for
example, EPSG:4296), PROJ.4 declarations, or the name of a .prf file containing well known text.

Required. Specify the path and name of the resource relative to the asset root, for example,
Resources/Imagery/ImageryResourceA. If you indicate a subfolder that does not yet exist, Google
Earth Enterprise Fusion creates it for you.

Required. Specify the path and file name of the source file for the resource. You can reference any
network-available source file as this value. (Optional if you specify --filelist file.)

Optional. Specify the path and file name of a file that contains a list of source files that you want to
include in the resource. You can use this option, list files individually, or use a combination of the
two.

Optional. Default value is --flat. Specifies the projection of the map database. Only applies to
new imagery resources. Glossary: Flat Projection, Mercator Projection.

genewvectorresource 
gemodifyvectorresource

To define or modify a vector resource.

Optional. If the field data in your vector resource has a particular encoding for characters, such as
ISO8859-1, set this parameter to correctly display your data in Google Earth EC. If you omit this
option, the character encoding defaults to ASCII (plain text). The table below lists the supported
encoding formats.

Note: If the encoding strings contain white space, you must use quotation marks around the
string.

--srs srs_def

-o path resourcename

sourcefile

--filelist file

--mercator | --flat

genewvectorresource [--encoding type] [--layer num] [--meta name=value]
   [--provider key] [--sourcedate string] -o [path] resourcename sourcefile ...
gemodifyvectorresource [--encoding type] [--layer num] [--meta name=value]
   [--provider key] [--sourcedate string] -o [path] resourcename sourcefile ...

genewvectorresource --layer 2 --encoding ISO8859-1 --sourcedate 2003-05-15 -o
   
vector/MyVectorProvider/ResourceAssetA/vol/machine2/source/vector/ResourceSourceA.shp

--encoding type
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Apple Roman CP 1258 ISO 8859-15 ISO-10646-UCS-2

Big5 CP 874 ISO 8859-2 JIS7

CP 1250 GB18030 ISO 8859-3 KOI8-R

CP 1251 GBK ISO 8859-4 KOI8-U

CP 1252 IBM 850 ISO 8859-5 SJIS

CP 1253 ISO 8859-1 ISO 8859-6 TSCII

CP 1254 ISO 8859-10 ISO 8859-7 UTF-8

CP 1255 ISO 8859-11 ISO 8859-8 eucJP

CP 1256 ISO 8859-13 ISO 8859-8-I eucKR

CP 1257 ISO 8859-14 ISO 8859-9 eucKR

Optional. Use this option if your source data contains multiple layers and you want to extract a
specific layer for your resource. The first layer of your data is 0. If you omit this option, Google
Earth Enterprise Fusion uses the first layer of the source file to define the resource.

In most circumstances, source vector data has only one layer; however, Tiger vector data can
contain multiple layers. Because there is a one-to-one correspondence between a vector resource
and a single vector layer, resource creation from multi-layer data must specify a layer. If you are
unsure which layer to indicate in defining a resource from multi-layer source data, you can open
the vector source file in the Preview pane. The Preview List pane lists all of the layers in the
source data, and you can examine each layer in order to select the appropriate one to import.

Optional. Specify any number of name/value pairs that you want to include about the source data.
For example, you might want to provide additional information about the data provider. If the name
or value string contains white space, you must use quotation marks around the string.

Optional. Specify a string that identifies the provider of the source data you are importing. This
provider key must match the provider key in your database that corresponds to the source data.
The provider name and copyright fields associated with this key are displayed for this resource in
Google Earth EC.

Note: If you are importing several source files to define a single resource, Google Earth
Enterprise Fusion assumes that they have a common provider.

Optional. Specify a string to represent the date of acquisition for your source file. It must in the
ISO 8601 format (yyyy-mm-dd).

Required. Specify the path and name of the resource relative to the asset root, for example,
Resources/Vector/VectorResourceA. If you indicate a subfolder that does not yet exist, Google
Earth Enterprise Fusion creates it for you.

--layer num

--meta name=value

--provider key

--sourcedate string 

-o path resourcename



Required. Specify the path and file name of the source file for the resource. You can reference any
network-available source file as this value.

gepolymaskgen

Creates a mask file in .tiff format. Accepts geotiff image or mask files, KML polygons, or .shp files
as input.

Simple polygon mask with no feathering:

Negative polygon mask with some feathering:

OR and AND polygon and tiff masks with different feathers:

Options are applied in the order given.

Feather to apply to all subsequent masks until a different feather is given. Feather can be 0,
positive, or negative. Default is 0.

If flag is non-zero, border is feathered. Otherwise, border is left in tact. Flag remains in effect until
it is modified. Default is border is feathered.

sourcefile

gepolymaskgen [--feather <int_feather>] --base_mask <geotiff_mask_file>
  [options] --output_mask <geotiff_mask_file>
gepolymaskgen [--feather <int_feather>] --base_image <geotiff_image_file>
  [options] --output_mask <geotiff_mask_file>

gepolymaskgen --base_image /path/input_image.tif \
  --or_mask /path/polygon.kml \
  --output_mask /path/result_mask.tif

gepolymaskgen --base_image /path/input_image.tif \
  --feather 30 \
  --feather_border 0 \
  --and_neg_mask /path/polygon.kml \
  --invert \
  --output_mask /path/result_mask.tif

gepolymaskgen --feather 30 \
  --base_mask /path/base_mask.tif \
  --feather 20 \
  --feather_border 0 \
  --or_mask /path/SF.kml \
  --or_mask /path/daly_city.kml \
  --feather 15 \
  --feather_border 1 \
  --or_mask /path/circle_mask.tif \
  --feather 5 \
  --and_neg_mask /path/gg_park.kml \
  --and_neg_mask /path/northbeach.kml \
  --feather 40 \
  --and_neg_mask /path/circle_mask2.tif \
  --output_mask /path/mask.tif 

--feather int

--feather_border int

--and_neg_mask <mask_file>
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Bitwise AND of negative image of polygon or raster mask with the current mask. Polygons can be
given in .kml or .shp files and are assumed to be filled with 0x00. Raster masks should be .tif files
with the same pixel dimensions as the base mask. Care should be taken not to overlap feathered
regions.

Bitwise OR of polygon or raster mask to the current mask. Polygons can be given in .kml or .shp
files and are assumed to be filled with 0xff. Raster masks should be .tif files with the same pixel
dimensions as the base mask. Care should be taken not to overlap feathered regions.

All pixels at or below the threshold byte are set to 0x00; all other pixels are set to 0xff.

gepublishdatabase

To publish a database (locally or remotely).

Delete a registered database from the server.

Optional. Use a specific server URL, such as http://private.company.com.

List all databases registered on the server.

Optional. Use a specific server URL, such as http://private.company.com.

Specify the location and name of the database that you want to publish relative to the asset root,
for example, Databases/databaseA.

Optional. Specify the nickname of the server association to which you want to publish. If you omit
the server specification, Google Earth Enterprise Fusion publishes to the default server. (Consult
your administrator or refer to the Google Earth Enterprise Administration Guide for information
about setting up server associations.)

 --or_mask <mask_file>

 --threshold <thresh_byte>

gepublishdatabase [--delete db_name [--serverurl url]][--listdbs [--serverurl 
url]][--publish dbname [--server nickname]][--publisheddbs [--serverurl url]]

gepublishdatabase --publish msDelta
gepublishdatabase --publish msDelta --server mainServer
gepublishdatabase --listdbs --serverurl http://private.company.com

--delete db_name

--serverurl url

--listdbs

--serverurl url

--publish dbname

--server nickname

Purpose
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List all of the published databases on the server.

Optional. Use a specific server URL, such as http://private.company.com.

gequery

To query Google Earth Enterprise Fusion about a particular asset’s build.

Optional. Display sub-versions that block the specified version.

Optional. List the dependencies for the indicated asset and the status of each, such as Succeeded,
Blocked, or Failed. The purpose of being able to view the dependencies of an asset is to allow
easier troubleshooting of failed asset builds. After you view the dependency list for an asset, you
can use additional options to query a failed dependent element in order to find out why it failed.
For example, you might use --logfile to determine the path to the log file for a failed asset.

Optional. Provide the file name and location of the input file for the named asset. You typically use
this command on a dependency for an asset file that is listed as Failed. For example, if you learn
that a project build phase fails, you could use the --infile parameter to determine specific image
source file for that phase of the build.

Optional. List the path to log file for the specified asset.

Note: Not all resources have log files.

Optional. List the files output by the specified dependency. This option allows you to trace forward
in the dependency chain to see the next step in the process.

Optional. Display the contents of the log file for the specified version.

Note: Not all resource versions have log files.

--publisheddbs

--serverurl url

gequery [--blockers] [--dependencies] [--geocode] [--infiles] [--logfile]
[--outfiles] [--showlog] [--taillog] [--status] [--versions] 
assetname [version]

gequery --dependencies imagery/TestProject?version=1

--blockers

--dependencies

--infiles

--logfile 

--outfiles 

--showlog 
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Optional. Display the contents of the log file for the specified version, but in a manner similar to
the UNIX command tail -f.

Note: Not all resource versions have log files.

Optional. List the completion and availability status of assets by version. If no version is specified, it
reports the status of the current version. The table below lists the possible status values for each
asset.

Status Description

Waiting The asset is waiting for its input data to finish.

Blocked The asset version cannot proceed. One or more of its input data or
subcomponents has failed, is marked bad, or is otherwise unavailable. The
responsible component is listed.

Queued The asset version (or its subcomponents) is queued and waiting to be built.

InProgress The asset version (or subcomponents) are actively being built.

Failed The asset version failed.

Succeeded The asset version (and subcomponents) succeeded.

Canceled The asset version was canceled.

Offline The version of this asset is unavailable because it has been cleaned up.

Bad The version of this asset has been marked bad.

Optional. List the version numbers for the indicated asset.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose build you want to query relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset you want to query, or enter current or lastgood.
If you omit the version specification, Google Earth Enterprise Fusion queries the current version of
the specified asset.

geraster2kml

--taillog

--status

--versions

assetname

version

geraster2kml [--url url_root] [--output dirname] [--layer_name name]
   [--tile_size size] [--kml_only] [--no_kmz] [--jpg_quality qual]
   [--debug]--kip raster.kip --kmp mask.kmp

Status Values



To convert a Google Earth Enterprise Fusion resource to the KML Region hierarchy, so you can
access the data in any Google Earth client.

If the imagery resource has a source date, that date will be passed to the rasterized KML as well.

Optional. Specify the URL root for all links.

Optional. Specify the name of the output directory.

Optional. Specify the name of the layer to appear in the Layers panel in Google Earth EC.

Optional. Specify the output tile size (256, 512, or 1024).

Optional. Generate KML files only (no imagery).

Optional. Specify no compression to KMZ files, to output to KML only.

Optional. Specify the quality for the JPG compression.

Optional. Specify adding debug geometry to the output file.

Required. Specify the name of the imagery file.

Required. Specify the name of the mask file.

gereproject

geraster2kml --kip myimage.kip --kmp myimage-mask.kmp

--url url_root

--output dirname

--layer_name name

--tile_size size

--kml_only

--no_kmz

--jpg_quality qual

--debug

--kip raster.kip

--kmp mask.kmp

gereproject [--version] [--formats] [--query] [--snapup] [-co “NAME=VALUE”]*
   [-dstnodata] [-et err_threshold] [-multi] [-of format] [-order n]
   [-ot Byte/Int16/...] [-q] [-rb] [-rc] [-rcs] [-rn] [-s_srs srs_def]
   [-srcnodata value ...] [-t_srs srs_def] [-te xmin ymin xmax ymax]
   [-tr xres yres] [-ts width height] [-wm memory_in_mb] [-wo “NAME=VALUE”]
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A simple utility used for image warping.

Optional. The project version you want to warp.

Optional. Display the supported output formats.

Optional. Provides information about the specified source file.

Optional. Force the imagery to be magnified to a predefined level.

Options:

Optional. Specify construction arguments to pass to the output GDAL dataset. Multiple -co options
are allowed.

Optional. Set nodata values for output bands (different values can be supplied for each band). If
more than one value is supplied, all values should be quoted to keep them together as a single
operating system argument. New files will be initialized to this value and if possible the nodata
value will be recorded in the output file.

Optional. Specify the error threshold for transformation approximation in pixels. The default is
0.125.

Optional. Use multi-threaded warping implementation. Multiple threads will be used to process
chunks of image and perform input/output operation simultaneously.

Optional. Specify the output format. The default is GeoTIFF (GTiff). Use the short format name.

   [-wt Byte/Int16] srcfile dstfile

gereproject -s_srs EPSG:4326 usgsLanSat.tif usgsLanSat_rep.tif
gereproject --query SFNorth.img

--version

--formats

--query

--snapup

-co “NAME=VALUE”

-dstnodata

-et err_threshold

-multi

-of format

-order n
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Optional. Specify the order of polynomial used for warping (1 to 3). The default is to select a
polynomial order based on the number of GCPs.

Optional. Specify the data type of the output bands. The default is to match the input.

Optional. Quiet; do not display the process messages in the terminal window.

Optional. Use bilinear as the resampling method.

Optional. Use cubic as the resampling method.

Optional. Use cubicspline as the resampling method.

Optional. Use near as the resampling method.

Optional. Specify the source spatial reference set. The coordinate systems that can be passed are
anything supported by the OGRSpatialReference.SetFromUserInput() call, which includes EPSG
PCS and GCSes (for example, EPSG:4296), PROJ.4 declarations, or the name of a .prf file containing
well known text.

Optional. Specify no data masking values for input bands. (You can specify different values for
each band.) If you enter more than one value, use single quotes to keep them together as a single
argument. Masked values will not be used in interpolation.

Optional. Specify the target spatial reference set. The coordinate systems that can be passed are
anything supported by the OGRSpatialReference.SetFromUserInput() call, which includes EPSG
PCS and GCSes (for example EPSG:4296), PROJ.4 declarations, or the name of a .prf file containing
well known text.

Optional. Specify the geo-referenced extents of output file to be created.

Optional. Specify the output file resolution in target geo-referenced units.

-ot {Byte|Int16|UInt16|UInt32|Float32|Float64|CInt16|CInt32|CFloat32|CFloat64}

-q

-rb

-rc

-rcs

-rn

-s_srs srs_def

-srcnodata value...

-t_srs srs_def

-te xmin ymin xmax ymax

-tr xres yres

-ts width height



Optional. Specify the output file size in pixels and lines.

Optional. Specify the amount of memory (in megabytes) that the warp API is allowed to use for
caching.

Optional. Specify the warp options. See Warp Options.

Optional. Specify the working pixel data type in the source image and destination image buffers.

Required. Specify the source file name(s).

Required. Specify the destination file name.

The warp options (for -wo) are:

INIT_DEST=value or INIT_DEST=NO_DATA

Forces the destination image to be initialized to the indicated value (for all bands) or
indicates that it should be initialized to the NO_DATA value in
padfDstNoDataReal/padfDstNoDataImag. If this value isn't set the destination image will be
read and overlayed.

WRITE_FLUSH={YES|NO}

Forces a flush to disk of data after each chunk is processed. In some cases this helps
ensure a serial writing of the output data otherwise a block of data may be written to disk
each time a block of data is read for the input buffer resulting in a lot of extra seeking
around the disk, and reduced IO throughput. The default at this time is NO.

SKIP_NOSOURCE={YES|NO}

Skip all processing for chunks for which there is no corresponding input data. This will
disable initializing the destination (INIT_DEST) and all other processing, and so should be
used careful. Mostly useful to short circuit a lot of extra work in mosaic creation situations.

Normally when computing the source raster data to load to generate a particular output area,
the warper samples transforms 21 points along each edge of the destination region back
onto the source file, and uses this to compute a bounding window on the source image that
is sufficient. Depending on the transformation in effect, the source window may be a bit too
small, or even missing large areas. Problem situations are those where the transformation is
very non-linear or “inside out”. Examples are transforming from WGS84 to Polar Steregraphic
for areas around the pole, or transformations where some of the image is untransformable.

The following options provide some additional control to deal with errors in computing the
source window:

SAMPLE_GRID={YES|NO}

Setting this option to YES will force the sampling to include internal points as well as edge
points which can be important if the transformation is esoteric inside out, or if large sections
of the destination image are not transformable into the source coordinate system.

SAMPLE_STEPS

Modifies the density of the sampling grid. The default number of steps is 21. Increasing this

-wm memory_in_mb

-wo “NAME=VALUE”

-wt {Byte|Int16}

srcfile

dstfile

Warp Options



can increase the computational cost, but improves the accuracy with which the source region
is computed.

SOURCE_EXTRA

This is a number of extra pixels added around the source window for a given request, and
by default it is 1 to take care of rounding error. Setting this larger will increase the amount of
data that needs to be read, but can avoid missing source data.

geresume

To resume a build process that was canceled, blocked, or failed, after correcting the problem, if
necessary.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose build you want to resume relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset whose build you want to resume, or enter
current or lastgood. If you omit the version specification, Google Earth Enterprise Fusion resumes
the build of the current version of the specified asset.

gesetbad

To specify a version of an asset as Bad.

Required. Specify the location and name of the asset (resource, map layer, project, or database)
whose version you want to set as Bad relative to the asset root, for example,
Projects/Vector/VectorProjectA.

Optional. Specify the version number of the asset you want to set as Bad, or enter current or
lastgood. If you omit the version specification, Google Earth Enterprise Fusion sets as Bad the

geresume assetname [version]

geresume imagery/SourceInc/MississippiRiverDelta
geresume imagery/TestImage.kiresource/mosaic.kia?version=1

assetname

version

gesetbad assetname [version]

gesetbad projects/TransitLines/BostonTransitLines 2

assetname

version
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current version of the specified asset.

gesplitkhvr

To create two or more source files from a large imagery or terrain source file to reduce the size of
each source file to under 80 GB in raw size. (Raw size = number of pixels width * number of
pixels height * 3.) This tool produces a grid of image files designated as rows and columns.

Required. Specify the number of resulting image files across.

Required. Specify the number of resulting image files high.

Optional. Specify the number of pixels of overlap between the resulting images. The default is 300.

Optional. Do not display the progress messages in the terminal window.

Required. Specify the name of the input file. It must be a .khvr file.

getop

Displays a list of what Google Earth Enterprise Fusion is currently working on and whether
gesystem and gehttpd are currently running.

Required. Specify the number of seconds delay between refreshes. For example, if you specify 30,
getop runs every 30 seconds.

getranslate

gesplitkhvr [--rows num] [--cols num] [--overlap num] [--quiet] input.khvr

gesplitkhvr --rows 4 --cols 4 --overlap 10 image_file.khvr

--rows num

--cols num

--overlap num

--quiet

input.khvr

getop --delay seconds

getop 30

--delay seconds
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A simple utility used for image reprojection. You must use this tool for:

Extracting a piece for preview purposes
Reordering bands

Since Google Earth Enterprise Fusion can perform the following tasks, you do not need this utility
for:

Adding projection data to a source file
Converting data from one format to another

Optional. Specify the projection for the output. Options are:

NAD27|NAD83|WGS84|WGS72

EPSG:num
PROJ.4 definition
OpenGIS Well Known Text
Name of file with OpenGIS Well Known Text
ESRI::ESRI Well Known Text File (.prj)

Optional. Display the supported output formats.

Optional. Specify the band to copy (1-based indexing). You can specify this value multiple times.
For example, the following entry reverses the bands:

Optional. Specify construction arguments to pass to the output GDAL dataset.

Optional. Specify that metadata is to be included in the output.

Optional. Be forgiving of mismatches and lost data when translating to the output format.

getranslate [--formats]
   [-ot Byte|Int16|UInt16|UInt32|Float32|Float64|CInt16|CInt32|CFloat32|CFloat64]
   [-not_strict] [-of format] [-b band] [-outsize xsize[%] ysize[%]]
   [-scale src_min src_max [dst_min dst_max]] [-srcwin xoff yoff xsize ysize]
   [-a_src projection] [-projwin ulx uly lrx lry] [-co “NAME=VALUE”]*
   [-mo “META-TAG=VALUE”]* [-quiet] 

getranslate -of Jpeg -a_srs WGS84 usgsSFHiRes.tif HiRes_translate.jpg

-a_src projection

--formats

-b band

-b 3 -b 2 -b 1 
-co “NAME=VALUE”*

-mo “META-TAG=VALUE”*

-not_strict

-of format
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Optional. Specify the file format of the output. The default is GTiff. Use the short format name.

Optional. Specify the data type of the output bands. The default is to match the input.

Optional. Specify the output image size in pixels or percent of original.

Optional. Specify the extents and size of the output window. (Similar to -srcwin but uses
georeferenced coordinate.)

Optional. Do not display the process messages in the terminal window.

Optional. Specify the scale of the input pixel values.

Optional. Specify the extents and size of the output window.

gevirtualraster

To create a virtual mosaic, which allows you to use a mask created outside of Google Earth
Enterprise Fusion for an imagery mosaic.

Optional. Crop the image to the specified pixel extents.

Optional. Specify band values to use as fill.

Optional. Specify a LUT file for the entire image.

-ot Byte|Int16|UInt16|UInt32|Float32|Float64|CInt16|CInt32|CFloat32|CFloat64

-outsize xsize[%] ysize[%]

-projwin ulx uly lrx lry

-quiet

-scale src_min src_max [dst_min dst_max]

-srcwin xoff yoff xsize ysize

gevirtualraster [--crop pixelx,pixely,pixelx,pixelh] [--fill a,b,...]
   [--lut lutfile] [--src override_srs] [--tolerance num] [--validate]
   -o output.khvr {sourcefile ... | --filelist file}

gevirtualraster --fill 0,0,0 -o 
  /gevol/src/imagery/usa/XX/new_location/all_files.khvr/gevol/src/imagery/usa/
XX/new_location/*.tif

--crop pixelx,pixely,pixelx,pixelh

--fill a,b,...

--lut lutfile

--src override_srs
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Optional. Specify the SRS.

Optional. Specify the tolerance to be applied to the fill. The default is 0.

Optional. Validate the inputs and exit.

Required. Specify the name of the output file, which must have the .khvr extension.

Required. Specify the path and file name of the source file for the resource. You can reference any
network-available source file as this value. (Optional if you specify --filelist file.)

Optional. Specify the path and file name of a file that contains a list of source files that you want to
include in the resource. You can use this option, list files individually, or use a combination of the
two.

--tolerance num

--validate

-o output.khvr

sourcefile

--filelist file

Back to top
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Creating Point Data

In addition to using vector resources in SHP, TAB, and other formats, you can define your own
point data and import it as a resource into Google Earth Enterprise Fusion. To do so, you create
delimited text files, such as CSV or tab-delimited TXT files.

Each text file must be paired with a configuration file in order for Google Earth Enterprise Fusion
to parse the source data. The configuration file defines the source file structure, specifying
field/value pairs and the type of delimiter used in the text file (that is, tabs or commas).

The configuration file must be a KDX file, have the same name as the CSV file, and be located in
the same folder. For example, if you have a text file called fast_food_stores.csv, the
configuration file must be stored in the same folder with the name fast_food_stores.kdx.

Tip: You can create the KDX file with a text editor, if you know the required format, or you can
auto-generate it by importing the CSV file into Google Earth EC. Google Earth EC saves the
KDX file in the same folder and with the same name as the original text file but with the .kdx
extension.

Your installation of Google Earth Enterprise Fusion includes a sample tab-delimited text file with a
corresponding configuration file that you can examine. They are called web_cam.txt and
web_cam.kdx and are located in:

The following sections describe how to create the text and configuration file with Google Earth
Enterprise Fusion.

The key to using your own delimited data with Google Earth Enterprise Fusion is the configuration
file, which defines the structure of the data, the data fields, and the type of data contained in the
fields. The following is an example of a configuration file:

/opt/google/share/tutorials/fusion/Vector

Layout {
  FileType : "delimited"
  Delimiter : ","
  Latitude : "2"
  Longitude : "1"
  SkipRows : "1"
  FieldDefinitions {
    0 {
      Name : "Name"
      Type : "string"
    }
    1 {
      Name : "Longitude"
      Type : "double"
    }
    2 {
      Name : "Latitude"
      Type : "double"
    }
    3 {
      Name : "Comments"
      Type : "string"
    }

Reference Guide

Creating Your Own Source Data, Icons, and Masks

Defining a Configuration File

file:///Users/janetmiller/Documents/GEE%20Docs/4_4_1%20Docs/docs/landing_page/fusion/html/reference/errors.html


Notice that the first line of the file begins with the word Layout and is followed by a curly brace that
has its closing bracket in the last line of the file. This layout block is the basic structure in the
configuration file. Each configuration file must start with a layout block. All settings within the layout
block must appear inside of its curly braces {}.

The FileType value defines the text file type. The options are:

delimited - Data fields are separated by tabs or commas.
fixedwidth - Each data field has a fixed width.

If the file type is delimited, you must indicate the delimiter type in the next line. Enter a comma (,)
or an actual tab between the quotation marks.

The data location is defined by the Latitude and Longitude values.

The Latitude value defines which column contains latitude data. The column count starts with 0. In
the example above, the latitude column count is 2, which is the third column in the file. The
required format for the Latitude data is degrees. If your data uses degrees-minutes-seconds
format, you must convert it to degrees by using the following formula:

Latitude = number of degrees + number of minutes/60 + number of seconds/3600

Record as many numbers after the decimal points as you can to ensure the accuracy of the
latitude value.

The Longitude value defines which column contains longitude data. As with latitude, the column
count starts with 0, and the format of the value is in degrees.

When you want to include a header row in the file for ease of reading but do not want to include it
as part of the data Google Earth Enterprise Fusion reads from the file, you can use the SkipRows
keyword to indicate how many rows should be ignored. For example, the line:

indicates that Google Earth Enterprise Fusion should ignore the top row in the source file. If the
source file contains more than one header row, indicate the number of rows within the quotation
marks.

The Field Definitions block defines the column structure of the source file. The values for each
column are defined in a separate block (indicated by curly braces), and the position of each column
is indicated by its index number, starting with 0 for the first column and incrementing by 1 for each
subsequent column.

The actual field definitions have the following values:

Name - The name of the column.
Type - The column data type, which can be integer, double, or string.
Length - If the file type is fixedwidth, you must use the Length keyword to define each
column’s width, for example:

    4 {
      Name : "URL"
      Type : "string"
    }
  }
}

SkipRows : "1"

Length : "50"

File Structure

File Type

Data Location

Indicating Header Rows

Field Definitions



Notes: Google Earth Enterprise Fusion is case-sensitive when reading the configuration file. In
addition, the space between each line header and the subsequent colon (:) is required. Make
sure that your configuration file has exactly the same syntax as the sample configuration file
shown above. 

If the configuration file for your source data is not set up correctly, or if the structure of your
source file does not match the structure specify in your configuration file, Google Earth
Enterprise Fusion generates an error message when trying to import your source data. 

For your convenience, instead of creating a configuration file from scratch, you can copy the
sample file to the folder where your source data is located, rename it, and then modify the
content.

Creating Custom Icons

You can create your own custom icons in the graphics application of your choice for use on roads,
points of interest, and other features in Google Earth Enterprise Fusion. When you do so, the
following restrictions apply:

The image must be created and saved in RGBA mode (RGB with an alpha channel).
The image file must be saved in PNG format.
Icons must be square. The standard sizes are 32 x 32 pixels up to a maximum of 64 x 64
pixels. However, you can make an icon any size, and when you import it, Google Earth
Enterprise Fusion scales the icon up to as large as 64 x 64 pixels (changing the proportions
to make it square, if it is rectangular). If the original icon image is larger than 64 x 64 pixels,
Google Earth Enterprise Fusion scales it down to 64 x 64 pixels.
Each image file must contain two versions of the icon (one for normal display and one when
it is selected/highlighted). If you do not include two versions, Google Earth Enterprise Fusion
duplicates the single 32 x 32 or 64 x 64 image and uses the same image for both versions.
The red phone image below is an example of how an icon image might look. If the original
icon is 32 x 32 pixels, the total for this stacked image is 32 x 64 pixels.

Icons that are highlighted and part of a legend must contain a version of the icon for the
legend which is 16 x 16, stacked on top and to the left of the top icon. The beach ball image
below is an example of how such an image file might look. If the original icon is 32 x 32
pixels, the total for this stacked image is 32 x 96 pixels.

Note: If you change the image used for a custom icon name, it does not force you to rebuild
projects that reference that icon. If that icon was previously referenced in a project that has
already been built, when you publish a database that includes that project, the old icon appears.
If something else in that project subsequently triggers a build, the new icon will appear in the
resulting version.

Creating Custom Masks

Google Earth Enterprise Fusion’s auto-masking tool provides a very robust and dependable



method of excluding fill data from imagery and terrain resources and requires the least investment
of your time, since Google Earth Enterprise Fusion builds the mask itself. There are cases,
however, where, in addition to fill data, some of the imagery within a resource should be masked
out of view to produce the best quality imagery project.

This section describes how to create a custom mask, including how to create the necessary
supporting files.

1. Change to the folder that contains the version of the imagery resource for which you want to
create a custom mask, such as:

2. Extract a preview of the imagery resource using the gemaskgen command with the --extract
option. For example:

This command creates a preview image file called file-extract.tif.

3. Create a default mask to serve as the base for the custom mask:

This creates a mask file called file-maskold.tif with a feather of 200 pixels.

Note: It could take a few minutes to generate the mask.

4. If necessary, copy the file-extract.tif and file-maskold.tif files created in steps 2 and
3 to another computer that has a graphics editing software application installed, such as
Adobe Photoshop.

5. Open both files in your graphics editing software application, and edit the mask as desired.
6. When you finish editing the mask, save it with the same name as the original source image

file, adding -mask.

For example, if your original file is called trails.tif, name your mask file trails-mask.tif.

7. Copy the mask file to the computer where you use Google Earth Enterprise Fusion.
8. Within Google Earth Enterprise Fusion, open the imagery resource to which you want to

apply the mask, and select Hand Mask for Mast Type in the Imagery Resource Editor.

When you build the resource, Google Earth Enterprise Fusion looks for a file with the same name
as the original source file with the -mask ending, as described in step 6.

/gevol/assets/Resources/Imagery/
  SFBayAreaLanSat.kiasset/product.kia/ver001

gemaskgen --extract raster.kip file-extract.tif

gemaskgen --mask --feather 200 raster.kip file-maskold.tif

Back to top

To create a custom mask:
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When specifying labels, descriptions, and layer names in Google Earth Enterprise Fusion, you can
use limited HTML mark-up tags.

Caution: Although Google Earth Enterprise Fusion allows the mark-up tags listed below, there
is no guarantee that there is enough space for Google Earth EC to display the text you enter.
Be particularly careful about text that consumes vertical space (such as line breaks, horizontal
rules, and so on). Some places in Google Earth EC expand to allow one or two extra lines, but
if you add too many, your text could get truncated. Other places in Google Earth EC handle
additional lines of text without a problem.

HTML Tag Description

<h1>...</h1> Top-level heading.

<h2>...</h2> Second-level heading.

<h3>...</h3> Third-level heading.

<h4>...</h4>
<h5>...</h5> Headings of lesser importance.

<p>...</p> Left-align paragraph. Adjust the alignment with the align attribute.
Possible values are left, right, and center.

<center>...</center> Center paragraph.

<blockquote>...
  </blockquote> Indented paragraph that is useful for quotes.

<ul>...</ul> Unordered list. You can also pass a type argument to define the
bullet style. The default is type=disc; other types are circle and
square.

<ol>...</ol> Ordered list. You can also pass a type argument to define the
enumeration label style. The default is type=”1”; other types are “a”
and “A”.

<li>...</li> List item. This tag can be used only within the context of
<ol>...</ol> or <ul>...</ul>.

<dl>...</dl> List of definitions, consisting of terms and descriptions.

<dt>...</dt> A term in a list of definitions. This tag can be used only in the
context of <dl>...</dl>.

<dd>...</dd> Description in a list of definitions. This tag can be used only in the
context of <dl>...</dl>.

<pre>...</pre> Pre-formatted text. Use for larger chunks of code. White spaces in
the contents are preserved. For small bits of code use the inline-
style code.

<div>...</div>
<span>...</span> Block grouping elements. These are used to structure the

document, and are often used to provide hints about the intended
presentation of the document.

Reference Guide
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<em>...</em> Emphasis. By default this is the same as <i>...</i> (italic).

<strong>...</strong> Strong. By default this is the same as <b>...</b> (bold).

<i>...</i> Italic font style.

<b>...</b> Bold font style.

<u>...</u> Underlined font style.

<s>...</s> Strike-out font style.

<big>...</big> Larger font size.

<small>...</small> Smaller font size.

<sub>...</sub> Subscript text.

<sup>...</sup> Superscript text.

<code>...</code> Fixed-width font, such as Courier. By default this is the same as
<tt>...</tt> (typewriter). For larger chunks of code use the block-
tag <pre>.

<tt>...</tt> Typewriter font style. This is the same as <code>...</code>.

<font>...</font> Customizes the font size, family, and text color. This tag
understands the following attributes:

color - The text color, for example color="red" or
color="#FF0000".
size - The logical size of the font. Logical sizes 1 to 7 are
supported. The value can either be absolute (for example,
size=3) or relative (size=-2). In the latter case, the size is
added to the previous font size.
face - The family of the font, for example face=times.

<img> An image. The image name for the mime source factory is given in
the source attribute, for example <img src="qt.xpm">. The image
tag also understands the attributes width and height, which
determine the size of the image. If the pixmap does not fit the
specified size it will be scaled automatically. The align attribute
determines where the image is placed. By default, an image is
placed inline just like a normal character. Specify left or right to
place the image at the specified side.

<hr> Horizontal line.

<br> Line break.

<nobr>...</nobr> No break. Prevents word wrap.

Back to top
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Google Earth Enterprise supports the Google Earth Plugin and its API. The Google Earth Plugin
supports connections to non-Google databases.

Included with Google Earth Enterprise is an example of how to implement the Google Earth Plugin
in /opt/google/gehttpd/htdocs/earth/earth_local.html. By default, the virtual servers point to
earth_local.html when accessing through a web browser.

The following is the content of the earth_local.html file.

In order for your users to be able to view your content in a browser, they must install the Google
Earth Plugin.

The plugin installer should be placed in the following directory:

Users are automatically directed here from earth_local.html's default error page. There are two
installers, which should be renamed as follows:

/opt/google/gehttpd/htdocs/earth/plugin/GoogleEarth-Mac-Plugin-Latest.dmg

/opt/google/gehttpd/htdocs/earth/plugin/GoogleEarth-Windows-Plugin-Latest.msi

<html>
<head>
  <title>Google Earth Enterprise Earth Plug-in: Local Example</title>
  <link rel='stylesheet' type='text/css' href='/earth/earth.css' />
  
  <script type='text/javascript'>
    // To serve your static content from a different server, simply override
    // GEE_SERVER_URL to the URL of your GEE Server, e.g.:
    // "http://yourhost.com/default_ge/"
    var GEE_SERVER_URL = "";
  </script>
  
  <!-- Load the required Javascript files.
       The loader for the Earth Plug-in API: earth_plugin_loader.js.
       Utilities for this example UI: fusion_utils.js and search_tabs.js
       The main routine: geeInit() is found in fusion_earthplugin.js which
       defines the example UI and behaviors.
    -->
  <script type='text/javascript' src='/js/earth_plugin_loader.js'></script>
  <script type='text/javascript' src='/js/fusion_utils.js'></script>
  <script type='text/javascript' src='/js/search_tabs.js'></script>
  <script type='text/javascript' src='/js/fusion_earthplugin.js'></script>
</head>

<body onload='geeInit()' onresize='geeResizeDivs();'>

  <div id='header'>
    <div id='logo'>
      <img src="/earth/images/gee.gif" align="left" />
      </div>
    <div id='search_tabs'></div>
  </div>
  
  <div style="clear: both;"></div>
  
  <table cellspacing="0" cellpadding="0" width="100%">
    <tr valign="top">
      <td id='left_panel_cell'>
        <div id='left_panel'></div>
      </td>
      <td>
        <div id='map'></div>
      </td>
    </tr>
  </table>

</body>
</html>

/opt/google/gethttpd/htdocs/earth/plugin

Reference Guide
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These installers do not require administrative rights on the end-user's machine. They also do not
auto-update. If users are unable to download the installer from this location, they should contact
their system administrator.

If the user has internet access, they can download an auto-updating installer from
http://code.google.com/apis/earth. This installer requires admin rights when installing to Internet
Explorer on Windows.

Back to top
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A

Any component of a Google Earth Enterprise Fusion data set, including:

Resources
Map Layers
Projects
Databases

A text file that contains information about the build process for a particular asset. Keeps track of
the current and previous builds of this asset. Data logged includes: build host, source data paths,
date, time spent, and errors encountered.

The tool you use in Google Earth Enterprise Fusion to import and build your assets in preparation
for publishing your Google Earth and Google Maps databases.

The root of the directory tree where all Google Earth Enterprise Fusion assets (resources, projects,
and databases) are stored.

The process of verifying the identity of a user, a system, or a process.

The process that determines whether an authenticated user, system, or process has permission to
perform a task.

B

Feature whose geometry is not available in the underlying source file. This could result from a
corrupted source file or, more likely, from a source file that is missing the geometry for some of the
records.

There is a canceled or failed resource that your project or database requires to be completed. You
must resolve the problems with these resources before the project or database can successfully
complete a build.

The process of preparing one or more assets for inclusion in a Google Earth Enterprise Fusion
database.

Reference Guide
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Asset Log

Asset Manager

Asset Root

Authentication

Authorization

Bad Features

Blocked

Build
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C

The process of removing an asset version, making it unavailable for further use in a Google Earth
Enterprise Fusion project or database, even though it still appears on the asset list in the Asset
Manager.

Refers to any content or process that requires successful authentication and authorization.

D

An organized body of related information. The final form of a Google Earth Enterprise Fusion data
set that is ready to be published to a Google Earth server; can be either a map database or a
Google Earth database.

The process of creating an asset and adding source data or other assets to it. For example, when
you define a project, you create it and add resources to it.

Determines the level at which each layer is visible to users in Google Earth EC. The lower the
number, the higher the level at which Google Earth EC users can view the data. Value can range
from 2 to 24. The entire Earth can be viewed at level 5. (Also referred to as LOD.)

Determines exactly which feature(s) of the layer are displayed and how Google Earth displays
them. Display rules consist of several options you can set, including colors, fonts, display levels,
and so on.

E

The outer boundaries of individual resources or source files.

F

A particular location on and orientation to the Earth that you use frequently. You can save a
favorite and then return to that view in the Preview pane next time by simply selecting the favorite.

Extra pixels (often pure black or pure white) that produce a frame around imagery where its
borders are uneven.

A pattern expression that is applied to the data fields of the vector resource.

Also known as plate carrée, equirectangular, or equidistant cylindrical projection, uses the equator

Clean

Controlled Access

Database

Define

Display Level

Display Rule

Extents

Favorite

Fill Pixels

Filter (vector)

Flat Projection



as the standard parallel, and maps meridians and circles of latitude to vertical and horizontal
straight lines, respectively.

In Google Earth Enterprise, Flat Projection is used for Earth databases and (optionally) Maps
databases. Flat projection imagery is not compatible with maps.google.com base imagery. To use
maps.google.com base imagery, you will need to create Mercator projection imagery resources.

G

An organized collection of computer hardware, software, geographic data, and personnel designed
to efficiently capture, store, update, manipulate, analyze, and display all forms of geographically
referenced information.

A configuration of networked workstations, servers, and storage devices that share the work and
data storage in Google Earth Enterprise Fusion.

I

High-resolution overhead photographs captured by satellites or from airplanes.

An individual source image within an imagery or terrain resource.

L

An individual vector resource within a vector project.

Level of Detail. Also referred to as display level. Determines the level at which each layer is visible
to users in Google Earth EC.

M

A special component in the Google Earth Enterprise Fusion data set that you use in map data
sets.

An opaque graphical layer used to conceal part of an image.

A cylindrical map projection, commonly used for nautical purposes. Mercator Projections preserve
shapes and directions, but distort size, especially as latitudes approach the poles.
maps.google.com uses the Mercator projection.

In Google Earth Enterprise, you can create imagery resources in the Mercator Projection to
integrate your data with the maps.google.com base maps. However, if you are creating both
Maps and Earth databases, you will need two copies of the imagery resources: one for Mercator

GIS

Grid

Imagery

Inset

Layer

LOD

Map Layer

Mask

Mercator Projection



and one for Flat projection.

The method used to determine the texture color for a texture mapped pixel, using the colors of
nearby texels (pixels of the texture). In short, it blends the texture pixels together by breaking them
up into tinier pixels. Another term for texture filtering is called texture smoothing.

A single composite image created by assembling multiple images.

P

A self-contained software component that modifies (adds or changes) function in a particular
software system. When you add a plug-in to Google Earth Enterprise Fusion, the foundation of the
original software system remains intact. The development of plug-ins requires well defined
application programming interfaces (APIs).

The level at which you want to preserve text labels on roads after the vector data for the road itself
fades away.

To view source data before you import it as a resource, or to view Google Earth Enterprise Fusion
assets before you publish them to Google Earth EC.

The intermediate component of a Google Earth Enterprise Fusion data set; can be created from
one or more resources; however, the resources must be of the same type as the project (imagery,
terrain, vector, or map layer).

An organization that distributes source imagery, terrain, or vector data.

The process of making a Google Earth Enterprise Fusion database available on a Google Earth
Enterprise Server for viewing with Google Earth EC.

R

A method of storing, representing, or displaying spatial data in digital form. It consists of using cell
data (not necessarily square) arranged in a regular grid pattern in which each unit (pixel or cell)
within the grid is assigned an identifying value based on its characteristics.

The most basic component of a Google Earth Enterprise Fusion data set; can be created from
imagery, terrain, or vector source data.

S

Minification

Mosaic

Plug-in

Preserve Text

Preview

Project

Provider

Publish

Raster Data

Resource
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A computer that delivers information and software to other computers linked by a network.

The raw data used to define a Google Earth Enterprise Fusion imagery, terrain, or vector resource.

The current state of a Google Earth Enterprise Fusion build, such as Queued, InProgress,
Succeeded.

A Google Earth Enterprise Fusion tool that allows you to view the recent activity log and monitor
the progress of background tasks, such as building a database.

T

A file external to Google Earth Enterprise Fusion that contains a set of display rules. You can
import the template and reapply those display rules to layers in any project.

Topographical information about a geographic area.

The equivalent of one grid square. (See The Toolbar in the Fundamentals chapter for more
information about turning the grid on and off.)

V

A method of storing, representing, or displaying spatial data in digital form. It consists of using
coordinate pairs (x,y) to represent locations on the Earth. Features can take the form of single
points, lines, arcs, or closed lines (polygons).

A particular instance of a build of an asset.

Allows you to use a mask created outside of Google Earth Enterprise Fusion for an imagery
mosaic.

Source Data

Status

System Manager

Template

Terrain

Tile

Vector

Version

Virtual Mosaic
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Copyright © 2008, 2009, 2010, 2011, 2012, 2013 Google, Inc. 
All rights reserved.

Google, Google Earth, and Keyhole are trademarks or registered trademarks of Google, Inc. in the
United States and elsewhere. Other trademarks not owned by Google, Inc. are the property of their
respective owners.

All Google and Keyhole logos and graphics are copyrighted. The content of this publication is
furnished for informational use only, is subject to change without notice, and should not be
construed as a commitment by Google, Inc.

This publication is provided pursuant to and subject to the terms of the Google Earth Enterprise
Purchase Agreement and Acceptable Use Policy. This publication and the information herein may
not be reverse engineered, reproduced, duplicated, modified, altered, disclosed, published, printed,
or distributed to any third party whatsoever without the express written permission of Google, Inc.

Google Earth Enterprise may utilize the following products as integrated components, linked
libraries, or optional modules. No usage rights, expressed or implied, are provided for said products
independent of Google Earth Enterprise, unless otherwise stated in the product documentation. All
trademarks are the property of their respective owners.

Apache
eXpat
GDAL
GEOS
Kakadu
libcURL
libgeotiff
libjs
LibTIFF
MrSID
OGDI
OpenLDAP
OpenSSL
PostGIS
PostgreSQL
PROJ
Tomcat
Tornado
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